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First look
Nikon D850

Cover image  

by Borchee

Create adorable baby  
& maternity pictures 

Jimmy McIntyre talks 
travel, light and mood 

Fix colour & exposure 
problems in Photoshop

Plus! Five best ND filters 
for amazing landscapes 

CAMERA 

KNOW-HOW 

SETTINGS 

EXPLAINED 

N E W  S E R I E S !

n Flora & fauna projects  

n Expert advice & insight

n New techniques & ideas  

AUTUMN
Flora & fauna projects
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DSLR CSC COMPACTS & MORE

NOW INCORPORATING

32 PAGES OF THE BEST 
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Welcome

Laurie Campbell
Scotland’s finest 

wildlife ace joins 

Simon Roy, Ross 

Hoddinott, Peter 

Cairns and Danny 

Green in our autumn 

extravaganza 

starting on p36

Amelia Troubridge
The award-winning 

editorial ace’s latest 

personal project 

celebrates female 

innovators. Find out 

how she plans and 

shoots her images 

on p120

Jimmy McIntyre
The brains behind 

shutterevolve.com 

shares his thoughts 

on travel, the power 

of local knowledge, 

and why simple 

workflow is best. 

Starts on p108

Learn from 
the best

Ben Hawkins, Group Editor

H
EDGEHOGS ARE 
seriously cute, right? 
Pointy snouts, furry faces, 
wheezy grunts... well, 
perhaps not the latter, 
but you get the gist. Why 
is this relevant? Because 

hedgehogs are one of the many autumn 
subjects we’ve got lined up for you this 
month. We asked five of the UK’s best natural 

world photographers to choose a specialist subject and share 
the camera skills, settings and fieldcraft needed to boost your 
portfolio. Our seasonal spectacular starts on page 36. Elsewhere 
in the mag, we unveil Camera Know-how, a new series intendedw
as a friendly Haynes Manual-type guide to all those confusing 
buttons, dials and menu settings. We start with shutter-priority 
mode on page 116. Here’s to an inspired month of photography! 

58 Create adorable maternity 

and newborn pictures.

36 Boost your autumn portfolio 

with new skills and fieldcraft.

140 Discover the 12 best 

value cameras under £650.

S
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O

Y

instagram.com/
practicalphotography

facebook.com/
PracticalPhotographyMagazine

twitter.com/practphoto

youtube.com/ppmagazine

Subscribe now  
& save up to 61%
Choose from our exclusive 

print, digital and combo  

deals and get Practical 

Photography for less.

greatmagazines.co.uk/pp

WATCH  

FREE VIDEOS!

Visit our YouTube channel 

at youtube.com/

ppmagazine to enjoy 

more than 60 brilliant 

how-to camera and 

editing videos.
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November
140 Best cameras under £650  

36 New ways to shoot autumn

116 Camera settings explained 

58 Create maternity pictures

108 Jimmy McIntyre interview  

150 Five best ND filters  

On the cover

Skills&Ideas

Regulars
06

Your free gifts 
Free editing software,  

75 minutes of videos and more. 

30
Guy Richardson 
Want to be a successful 

freelancer? Read Guy’s top tips.  

32
Lisa-Marie McGinn
Lisa-Marie discusses style, 

inspiriation and staying fresh. 

116
Camera know-how 
Our new series starts by 

looking at shutter-priority mode.   

08
Beyond the lens
Take a look at the best shortlisted 

Wildlife Photographer of the Year images.

20
10 clicks
Projects include epic light trails, 

waterfalls, autumn portraits and more.

36
Autumn flora & fauna 
In-depth guides to the most 

exciting seasonal subjects to shoot. 

58
Maternity & baby 
Document the journey from 

pregnancy to birth and beyond.

100
Know your stuff 
Sunrays in misty woodlands, true 

macro, blue hour, brighter eyes and more. 

108
Adventure of a lifetime
Jimmy McIntyre travels the world 

in search of ‘dark and moody’ landscapes.

120
Chasing innovation 
Amelia Troubridge focuses on the 

women driving science and technology.

162
Student showcase 
Jasmine Pope captures the beauty 

of nature in her impressive portfolio. 

116

12

108

140



68
Give RAWs the HDR look
Apply a gritty mono effect to your 

portraits with this easy Lightroom technique. 

72
Just add fallen leaves 
Add a sense of movement and 

wonder to your autumn images. 

76
3 ways to reduce blur
Banish camera shake and inject 

sharpness into out-of-focus images. 

80
Fix colour and exposure 
Give your landscapes a more 

professional sheen in three easy steps. 

82
Create surreal composites 
Merge two or more images together 

to make artistic double exposures.

86
Make light orbs shine  
Shoot and edit amazing light paintings 

with a torch, string and long exposures. 

92
Photo fixer
Resident Photoshop genius Dan Mold 

retouches reader images to a pro standard.

98
Photo hacks
Three secret keyboard shortcuts that 

will help you process your images faster.

Photoshop 
Genius

GetIntoGear

FREE EDITING   
SOFTWARE!

OPTICS 11 ESSENTIAL

 WORTH £99

FULL GUIDE ON P96

18
The knowledge
Fujifilm’s double-whammy of 

new camera and lens releases.

136
Nikon D850 
Take a first look at Nikon’s hugely 

anticipated full-frame, pro-spec DSLR. 

138
Canon EOS M100 
Meet the compact mirrorless mode

that’s intended as a smartphone upgrade

140
Best cameras under £65
DSLRs, CSCs, compacts and actio

cams rub shoulders in this budget round

150
5 best ND filters
Change the way you shoot 

landscapes with a 10-stop Big Stopper.

152
Mini tests
Honey Badger flash head, Quicks

photo app, new Billingham bag and more

104 Find out why ‘true macro’ is the 

secret to amazing close-up images 

120 Be inspired by Amelia Troubridge’s 

innovative personal project     

86 Create spectacular light orbs with  

a torch, string and long exposures  

25

NEW!
32-PAGE
EDITING
GUIDE

NEW
SERIES!
CAMERA 

KNOW-HOW 
STARTS  
ON P116

136 Take a first  

look at Nikon’s  

new D850 



DxO OpticsPro 11 
Download the full version of this 

powerful editing software worth £99. 

Photoshop video lessons
Fix colour casts and exposure issues, 

add autumn leaves to portraits, and 

create a gritty HDR effect with three 

complete editing tutorials. 

Camera 
Buying Guide
Unsure about which 

camera is best for your 

needs? Our ebook 

includes reviews, spec 

and prices for every 

camera available right 

now. The latest 

additions include 

Nikon’s D850 and 

Canon’s EOS M100. 

Pro hints & tipsCamera skills

Creative ideas

How-to guides

Expert adviceHints & tips

Inspiration

Plus More free gifts on your CD
THREE
BONUS 
VIDEO 

GUIDES 

Improve your camera and editing skills with over an 
hour of hands-on video lessons for all levels of ability. 

Your FreeGifts

practical.photography@bauermedia.co.uk

Practical Photography, Bauer Media,  

Media House, Lynch Wood,  

Peterborough, PE2 6EA 

Contact us if you have any 
problems with your free gifts 
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75
MINUTES 

OF EXPERT 
ADVICE

DxO OpticsPro 11

FULL 
USER 
GUIDE  
ON P96

T 24-hour photo
challenge special!  
The team have one day to create 24 brilliant 

images, using all their skill and experience to 

complete the ultimate creative challenge...

n Dan visits an owl sanctuary to shoot 

dramatic portraits and birds in flight, while 

sharing tips about choosing the right lens. 

n Kirk takes to the streets and focuses on 

colourful floral abstracts and spontaneous 

portraits of complete strangers. 

n Louise works through the night to create 

incredible light orbs, low light self-portraits 

and fiery light paintings.  

n Tim focuses on innovative time-slice 

landscapes, sun-kissed beach huts and 

flash-inspired alien invasions. 

DOWNLOAD THE DISC CONTENT AT bit.ly/ppdisc1712
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Shortlisted entries from this year’s competition 
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Swim gym

by Laurent Bellesta
l I was diving underwater in east 

Antartica in the early spring, when I heard 

some strange noises. I suspected it was 

Weddell seals, so I approached slowly. 

The pair didn’t take any notice of me as 

they swam around, so I used the light 

coming through the ice to illuminate the 

mother and her pup and capture my shot.

Nikon D4S | 17mm | 1/640sec | f/11 | ISO 200

National Geographic photographer 

and marine biologist Laurent 

Ballesta is a world specialist in 

underwater photography, creating 

incredible Arctic scenes.

facebook.com/pageballesta
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Bold eagle

by Klaus Nigge
l I was at Dutch Harbour on Amaknak 

Island in Alaska, USA, which is known 

for bald eagles gathering to feast 

on the fishing industry’s leftovers. 

They’re used to people, so the birds 

are pretty bold. One ambled close 

to me, picking up scraps as I laid on 

my belly. It then towered over me as 

I captured this intimate portrait.

Nikon D200 | 550mm | 1/80sec | f/10 | ISO 500 

Klaus Nigge is an award-winning 

wildlife photographer. He has 

been published in National 

Geographic, GEO and more. 

nigge.com
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Arctic treasure by Sergey Gorshkov
l I took this shot on Wrangel Island in the Russian Far East. Towards the 

end of May, snow geese come to the island. The foxes try to steal their 

eggs, harassing the geese until they see their chance. They then bury them 

in shallow holes in the tundra to sustain themselves through the winter. 

Nikon D300S | 600mm | 1/1250sec | f/5 | ISO 800 

Sergey Gorshkov is an 

experienced wildlife 

photographer who is 

passionate about showing 

the beauty of nature. 

gorshkov-photo.com
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BeyondTheLens

Saguaro twist

by Jack Dykinga
l These saguaro cacti are up to 200 

years old and can grow over 12 metres. 

The contortions of the plant let me get 

right inside its limbs for my shot. I was 

able to capture its arms framing the 

other cacti with my 14mm focal length. 

Nikon D810 | 14mm | 1/3sec | f/20 | ISO 64 

Jack Dykinga is a Pulitzer 

Prize-winning photographer 

who specialises in large-format 

landscapes and nature.

dykinga.comdykinga.com

Hitching a ride

by Justin Hofman
l Seahorses hitch rides on the currents 

by grabbing floating objects, such as 

seaweed. This one let go of a piece of 

seagrass and jumped to a long, wispy 

piece of clear plastic, and then onto 

this waterlogged plastic cottonbud.

Sony α7R II | 35mm | 1/60sec | f/16 | ISO 320 

Justin Hofman is an underwater 

and nature photographer who is 

passionate about conservation 

and protecting the environment. 

justin-hofman.comjustin-hofman.com
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Snow spat

by Erlend Haarberg
l When spring comes to Norway’s upland 

birch forests the tension begins to grow 

between mountain hares. At dark, they 

start to fight over females and food. I 

spent countless freezing nights in a hide, 

waiting for them to appear. The hares are 

naturally cautious around humans, but 

they soon got used to the sound of the 

shutter. I used food to bait them closer 

and illuminated the area with lamps.  

Nikon D800E | 300mm | 1/1600sec | f/2.8 | ISO 3200 

Erlend Haarberg is a wildlife and 

landscape photographer who 

specialises in the Nordic countries. 

He has contributed images to 

National Geographic magazine. 

haarbergphoto.com
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BeyondTheLens



BeyondTheLens
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The power of the matriarch

by David Lloyd
l I was in Kenya’s Maasai Mara National 

Reserve at dusk, waiting for a herd of elephants 

on their evening trek to a waterhole. As they 

got closer to my vehicle, I could see that the 

golden light from sunset was emphasising the 

texture of their skin. The female leading the 

herd looked straight at me as I took my shot. 

Nikon D800E | 400mm | 1/500sec | f/13 | ISO 1000 

David Lloyd is a 

fine art wildlife 

photographer 

who’s currently 

based in 

London. He loves shooting 

everywhere from Rwanda to 

Richmond Park. 

davidlloyd.net

n The Wildlife Photographer of the Year 

exhibition opens from Friday 20th October 

2017 to spring 2018 at the Natural History 

Museum. Book tickets at nhm.ac.uk/wpy 
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AWARDS 2017

Since 1990 the TIPA Awards logos have shown which are the best photographic, video and imaging products each year. For 
over 25 years the TIPA Awards have been judged on quality, performance and value, making them the independent photo 
and imaging awards you can trust. In cooperation with the Camera Journal Press Club of Japan. www.tipa.com



Fujifilm power-pair

Lastolite background 

After last year’s mass of excellent 

releases, including the X-T2, X-Pro2 and 

GFX 50S, you’d be forgiven for thinking 

Fujifilm would be resting on its laurels. 

However, we have just been treated to  

a couple of exciting new releases. 

First up is the X-E3, a 

rangefinder style CSC, in the 

same mould as the X-Pro2, 

though lacking the hybrid 

EVF. It features the excellent 

24.3MP X-Trans CMOS 

APS-C sensor and 

X-Prosessor Pro engine. It’s 

also the first Fujifilm X Series 

camera to feature always-on 

low energy Bluetooth 

(alongside Wi-Fi), allowing 

you to transfer your shots to 

a smart device as you shoot 

them. It also bears the 

distinction of being the smallest 

and lightest X Series camera with a 

viewfinder, making it a real draw for 

anybody needing excellent performance 

in a small package. Despite this 

accolade, Fujifilm has still managed to 

pack in 4K UHD video at 30fps, as well as 

a tough construction using magnesium 

alloy body plates, and a fully 

interactive 3in touchscreen 

– all for £849, body only. 

In addition, Fujifilm has also 

bolstered its excellent Fujinon 

lens range with the inclusion 

of the XF 80mm LM OIS 

WR macro lens, 

something which will be a real 

draw for nature shooters. It’s 

the first 1:1 mid-telephoto 

macro lens for the X Series 

range, and users will be glad 

for the 122mm (35mm 

equivalent) focal length  

– as well as the image 

stabilisation and fast 

maximum f/2.8 aperture. 

Inside this glass, you’ll 

find 16 elements in 12 

groups, which consist of 

one aspherical lens, one 

super extra-low dispersion lens 

and three additional extra-low 

dispersion lenses, alongside a Floating 

Focus System, a new system which 

drives the front and rear focusing groups 

separately to better control aberration.

fujifilm-x.com

CAMERAS

STUDIO

Left & Above Fujifilm has unveiled a 

lightweight rangefinder style X-E3  

X Series camera, and new XF 80mm 

f/2.8 LM OIS WR 1:1 macro lens.

Studio specialist Lastolite has announced two new panoramic 

backdrops in granite and limestone colours. These seamless 

four-metre-wide units are ultra portable, and can be assembled  

in a matter of minutes. They don’t even require any additional  

stands or cross bars, allowing you the freedom to throw one up  

as and where you need it, perfect if you’re looking to shoot a  

family or group portrait on the fly. Once you’ve finished, these 

portable backdrops collapse down to 100x30x35cm, meaning 

transport is easier than ever. Both options add a feeling of  

texture to the Lastolite range, and provide a pleasing, but  

simple background when you need to isolate your subject, 

but don’t have the perfect location to hand. lastolite.co.uk

Left & Above Fujifilm has unveiled a
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Kn wledge
The latest news from the world of photography

THE



Longsys goes 
Lazarus on Lexar

Persons of 
Interest

Macphun releases 
Aurora HDR 2018

MEMORY

SOFTWARE

Above Macphun has 

released its excellent 

HDR software for both 

Mac and, for the first 

time, Windows 

operating systems, 

making it a great choice 

for HDR photographers 

everywhere.

We reported the sad news of memory 

giant Lexar’s liquidation at the hands 

of its parent company, Micron, only  

a couple of months ago. However, 

Chinese storage specialist Longsys 

appears to have acquired the brand 

name and trademarks, giving us hope 

that the high quality SD cards will 

make a quick recovery and find 

themselves back on the 

shelves before long. A 

Longsys spokesman 

has reportedly 

said that it is 

looking to make 

Lexar ‘the go-to 

brand for high 

performance flash 

storage’.  

lexar.com

Editing software expert Macphun is set to release the latest 

version of Aurora HDR, aimed at simplifying the editing 

process, on both Mac and, for the first time, Windows. 

This new version of the popular (over 100 million photos 

being edited in the last two years) editing suite has been 

co-developed with renowned HDR photographer, Trey 

Ratcliff, who is recognised for his often surreal and epic 

photography. Some of the new inclusions in this version 

are designed to make Aurora even more simple to use, 

allowing you to create stunning shots with ease. These 

include a Lens Correction Tool, perfect to even out any 

distortion when shooting wide-angle, and a new interface, 

freshly designed from the ground up to make your workflow 

smoother. It also gets a seriously impressive speed boost 

over the original version, processing RAW images up 

to 4x quicker and a merging and masking performance 

upgrade of 200%, which is exceptional. aurorahdr.com

Legendary 

Scottish 

photographer 

Harry Benson 

CBE takes a 

look back at a 

lifetime’s worth of 

defining images, 

highlighting 

some of his 

favourite shots. During his illustrious 

career, which saw him contracted to 

LIFE magazine for 30 years, as well asFE

working for TIME, Vanity Fair and manyr

others, his lens has fallen upon such 

cons as The Beatles, Mohammad Ali and 

the last 12 American presidents (the only

person to have managed this feat), all of 

whom have a space in Harry’s amazing 

memoirs. powerhousebooks.com

BOOKS

icons as The Beatles, Mohammad Ali and
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News

Canon  
5DS R MkII

For those still looking 

for more megapixels, 

there’s talk of Canon 

updating its 50MP 5DS R 

model. The new MkII version 

will make a jump to a massive 

60.1MP, made even more 

impressive with the omission 

of an optical low pass filter for 

maximum sharpness. It will also 

include 4K video, though we are 

expecting it to concentrate on 

stills more than movies. It will 

also include Dual Pixel AF and 

focus peaking. canon.co.uk

Nikon full-frame 
mirrorless

News has reached us 

of Nikon filing patents 

for full-frame mirrorless 

lenses, which means it 

must have a body in the 

works – the first since the 16MP 

Nikon DF. We’d expect to see 

a similar BSI 45.7MP sensor 

as the D850, with its incredible 

dynamic range, as well as 

excellent ISO performance up 

to 25,600. It would also include 

an EVF, 4K UHD video and silent 

shooting modes. Though details 

are very scarce, we’d expect to 

see this announced at the 2018 

Photokina event. nikon.co.uk

Canon PowerShot 
G1 X MkIII

Canon’s line of excellent 

1in sensor compacts, 

the Powershot G 

series, is reportedly 

looking to step up and 

use APS-C sensors (like 

those found in many DSLRs). 

This will start with the G1X 

MkIII, rumoured to be coming 

soon. It will include the same 

intuitive control scheme, and 

likely duplicate the 24.2MP 

sensor found in the 80D, though 

we expect Canon to include 4K 

video recording in this flagship 

compact, which is one area 

where it’s falling behind some of 

the competition. canon.co.uk

RumourMill
Hotly-anticipated products 

we can expect in 2018...
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10Clicks
What to shoot with your camera right now
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TIP 

USE 

SHUTTER-PRIORITY

Set your camera’s mode dial 

to ‘S’, for shutter-priority 

mode. Select your shutter 

speed, then the camera 

will choose the other 

settings. 

l As the evenings begin to 

stretch longer, it’s the perfect 

time to dust off your tripod and 

fall in love with the magical 

possibilities of long exposures 

all over again, just like travel 

photographer Christoph 

Schaarschmidt (christoph-

schaarschmidt.de). 

“In 2014 I was driving 

through Norway on a road trip 

when I came to the Trollstigen 

road, a magnificent sight 

surrounded by mountains with 

many hairpin bends and three 

waterfalls. It’s one of many 

tourist spots that shouldn’t 

be missed when travelling 

through the country. I often 

shoot at night and I love 

experimenting with long 

exposures, so I’d planned to 

shoot the light trails of car 

headlights on the single night 

I was spending there. However, 

when I arrived at my viewpoint 

there was 

a thick fog 

covering the 

usually beautiful 

view of the road. At 

midnight it was so bad I could 

barely see my own hands! At 

1am the fog dissipated, giving 

me enough time to capture 

a car crawling up this infamous 

road. Just 20 minutes later, the 

fog crept back up the hill, 

returning with a vengeance!” 

#1 Capture light trails

L A N D S C A P E S

C
a
n
o

n
 7

0
D

 | 1
1
m

m
 | 3

0
s
e
c
 | f/8

 | IS
O

 1
0

0



22 PRACTICAL PHOTOGRAPHY

l We’ve all been there – 

we get up early, excited for 

a dawn shoot, then we’re 

bitterly disappointed when 

we arrive at our location with 

less than ideal conditions. 

However, rather than giving 

up and going home, Jeremy 

Walker (jeremywalker.

co.uk) decided to plough on 

and was well rewarded.

“Autumn is my favourite 

time of year, and I always 

look forward to those crisp, 

chilly mornings. Even after 

many years of working as 

a landscape photographer, 

I still get a buzz from the 

anticipation of a landscape 

cloaked in a fine veil of mist. 

“I always enjoy visiting 

Wareham Forest, in Dorset, 

because of the endless 

shooting possibilities. On 

this particular morning the 

fog wasn’t quite as thick as 

I would’ve liked. Half a mile 

away it was perfect, but 

there wasn’t any defining 

subject matter, just a layer 

of mist across an open field. 

However, there was always the 

possibility that it might drift my 

way if I waited. Unfortunately, 

it didn’t. Disappointed with the 

conditions I went out anyway. 

I carried my kit, too much of 

it in fact, and shot nothing. 

“Frustrated by my bad 

luck, I was heading back to 

the car when I spotted some 

feeble fog. I was in two minds. 

Could I be bothered? Was 

it really worth it? However, 

suddenly the mist crept in 

and the sun flooded through 

the trees. For that moment, 

it was worth it. A few frames 

later it had all dissipated and 

the sun was too high, but 

breakfast was certainly going 

to taste a great deal better!”

#2 Persevere for amazing photos

S U N R I S E 

10Clicks
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Above Use 

a 70-200mm 

telephoto to 

focus on key 

details and 

simplify often 

complex scenes 

like this forest. 

l The rushing roar of a waterfall is 

an instant draw for any landscape 

photographer worth their salt. 

Mark Hamblin (markhamblin.com) 

stumbled across this one when 

shooting on the Isle of Skye.

“Like many, I’m drawn towards 

waterfalls and this one is a beauty. 

Although small, it’s one of my favourites 

and is located right next to the road, so 

it’s very easy to access. The weather 

at the time was dull and overcast, so 

I hadn’t had much success elsewhere 

that day, but the low contrast conditions 

were ideal for shooting waterfalls. 

The amount of water rushing over 

the rocks plays a key part in the look 

of the final image. Too much and the 

moving water becomes totally white 

with very little detail. However, too 

little and it’ll lack drama. Luckily, 

on this occasion the water levels 

were about right, creating attractive 

rivulets that were complemented 

by the vibrant green moss. 

“The challenge with a scene like 

this is retaining detail in both the 

highlights and shadow areas, something 

that’s near impossible in bright light. 

However, with heavy cloud, the light 

was soft. I took a couple of quick test 

shots and the histogram confirmed 

that I was capturing the full range 

of tones. I made sure to shoot the 

waterfall square-on to keep everything 

in roughly the same plane of focus.”

#3 Shoot a waterfall

L O N G  E X P O S U R E S

TIP 

PREPARE 

FOR YOUR SHOOT

Use the app PhotoPills to 

discover which direction the 

sun will be rising. This will 

help you know where you 

need to be standing 

for your shot.
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l Want to turn your fluffy 

best friend into a bone-afide 

model? Get inspired by Elke 

Vogelsang’s whimsical doggy 

portraits (elkevogelsang.com) 

and create a few of your own. 

“My three dogs are 

conditioned to know that 

being photographed means 

fun and rewards. When I get 

my camera out they come 

running! Even my once 

camera-shy rescue Scout 

is the world’s most patient 

and eager poser now. 

The balls in this picture 

were arranged on a large 

piece of cardboard with a 

huge hole in the middle for 

Scout to easily put her head 

through. She would have 

been able to get her head 

out without any hassle. She’d 

immediately stop cooperating 

if she found something even 

slightly scary, which makes 

it even more amazing that 

she always trusts me with my 

sometimes silly photo ideas. 

“If your dog is shy, start 

by rewarding just the sound 

of the shutter. Figure out 

what your dog likes – some 

may do anything for praise 

or treats, while others love 

to release energy by play.”

#4 Have fun with colour4

P E T S

TIP 

SHOOT 

OUTSIDE

Some dogs are better 

photographed outside where 

they have plenty of space, 

as the sounds and lights 

of the studio can be 

intimidating.

Above Using a wide-angle lens, 

such as 35mm, will exaggerate 

the part closest to the camera, 

such as the dog’s nose. 

10Clicks
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l The strikingly rich colours of 

autumn are perfectly suited to 

portraiture. Why not take a leaf 

out of Lisa Holloway’s book 

(ljhollowayphotography.com) 

and go back to nature for some 

stunning, seasonal shots.

“A few years ago, we decided 

to take an October drive to check 

out the autumnal colours in the 

Sedona and Oak Creek areas in 

Arizona. Most people think of barren 

deserts and cacti in relation to 

Arizona, but this particular area is 

vibrant and beautiful in the autumn. 

There are many different types 

of changing leaves enchanting 

the forest with abundant hues 

of golds, reds and greens. 

“Upon arrival we took a little 

hike down a forest path to check 

out the creek with two of our 

younger children, Elliott and Gabriel. 

When we got there, we spotted an 

amazing tree with huge, brilliantly 

coloured leaves. I had Elliott, 

who had just turned three years 

old at the time, sit down next to 

the tree for a few photos. It was 

an overcast day, so the light was 

very soft, filtered and pretty. In 

this image, Elliott was examining 

a golden leaf that he’d found. 

“In some of the other images 

in this series, I had my husband 

throw leaves over Elliott to appear 

as though they were falling 

naturally. In this particular shot, 

I used a leaf overlay in Photoshop 

to give the appearance of falling 

leaves and to add an additional 

layer of interest to the image. 

“I took this shot with my Canon 

5D MkIII and a 200mm f/2 lens. I was 

lying on the ground some distance 

away to take this photo from a low 

vantage point, as I wanted to be 

down at Elliott’s level. I used both 

the trunk of the tree and the 

sloping hill to frame him. I love 

how Elliott appears to be in his 

own little world in this shot, not 

concerned with the camera in 

the slightest. I think it perfectly 

captures a quiet, introspective 

moment of his childhood.”

#5 Capture autumnal kid portraits

P O RT R A I T S

Above Get down 

low to the ground 

so that you’re at 

your model’s level, 

as this’ll be a more 

flattering portrait.

Left Use a 200mm 

lens to include 

lots of foreground. 

C
a
n
o

n
 5

D
 M

k
III | 2

0
0

m
m

 | 1
/4

0
0

s
e
c
 | f/2

 | IS
O

 2
0

0



26 PRACTICAL PHOTOGRAPHY

10Clicks

l Under the cover of night 

there are a multitude of 

exciting projects that 

you can experiment with. 

Nick Francis (500px.com/

nickfrancis) worked with 

a fellow photographer to 

create this dramatic shot.

“I’d been intrigued by 

wire wool photography for 

a while, as I love taking 

images that immediately 

draw people’s attention. 

Wire wool can certainly 

do that, so I convinced 

a colleague to try out some 

shots with me and this 

photo is the result of that.

“It’s a lot of fun, but 

you’re literally playing with 

fire, so precautions must 

be taken. We both wore 

thick clothing, including 

gloves and hats, as we 

knew that we’d be spinning 

in a location that would 

bounce the sparks back 

at us. We also took a fire 

extinguisher with us. 

“Wire wool is simple 

to shoot. For this image, 

all we had was several 

bags of wire wool, a steel 

balloon whisk clipped to 

a rope and a 9V battery. 

We put the wool in the 

whisk, fluffed it up to get 

pockets of air in there (to 

help it burn) and put the 

9V battery on the wool to 

light it. Then we simply 

started spinning the whisk.

“We took this shot under 

a bridge that went over 

a small stream. The close 

quarters meant the sparks 

bounced off the walls, while 

the stream gave us some 

awesome reflections. 

“Editing this was 

simple – I just warmed 

it up a bit, boosted the 

contrast and added 

some lens correction.”

#6 Paint incredible sights

L I G H T  PA I N T I N G

Above See this technique in 

action on this issue’s Learn 

Photography Now show.

TIP 

PRE-FOCUS 

WITH A TORCH

Shine a torch on your subject 

before the wire wool is lit and 

pre-focus your camera. 

Then simply switch it to 

manual focus to stop 

it readjusting.
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l Immediately capture your 

viewers’ attention by shooting a 

mysterious multiple exposure, just 

like photographer Brandon Kidwell 

(500px.com/brandonkidwell).

“I’ve always been a fan of multiple 

exposures, as I believe they give a new

dimension to an image’s story. Fog 

works beautifully in multiple exposures 

with trees or cities, as it gives a greater 

emphasis on the depth of the scene. 

Relatively close structures fade into the 

background in heavy mists, creating 

an enigmatic atmosphere. I’d already 

captured the close-up portrait the day 

before using just natural light, so all I 

needed to do was set up my tripod, 

camera and trigger. Then I walked 

down the path and into the woods.” 

Interested in experimenting with 

multiple exposures? Check out page 

82 for Photoshop genius Dan’s tutorial.

 #7 Create 

a narrative

P H O T O  A RT

Right Use a tripod when 

working with a macro lens 

in order to avoid creating 

camera shake.

l While epic sunrises are one obvious reason to get 

up at the crack of dawn, they’re not the only one. Early 

morning dew can create atmospheric macro shots, as 

Andan Saputra found out (500px.com/andansaputra).

“I was outside one morning, breathing in the crisp dawn 

air, when I stumbled across this spider dwelling on his web. 

I saw that tiny droplets of dew were scattered across him 

and his home, so I immediately rushed to grab my camera. 

At that time I was using a Nikon D7000 with a 90mm 

Tamron lens. I started trying to photograph the spider, but 

as it was only 6.30am it was still pretty dark. As I wasn’t 

using a flashgun, I had to wait until the sun started to rise 

a little more before I could capture my shot. I had to work 

quickly as soon as I had the required light, as I wanted 

to make sure that the spider didn’t crawl away.

“Once I got my desired result, I went back inside 

to start processing it. I love this image, and the 

spider is actually still living in my back garden!”

#8 Find tiny subjects
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l Iconic landscape locations 

can become synonymous 

with a certain way of shooting 

them. However, why not 

break away from the crowd 

like Florian Wenzel (500px.

com/florian-wenzel) and 

find a unique perspective.

“A couple of years ago 

myself and my good friend 

Marina decided to go on 

a trip to Iceland. After a bit of 

research, we decided that we 

wanted to visit the beautiful 

Kirkjufell mountain. This 

location is renowned for the 

waterfalls you can capture 

in the foreground, but when 

we got there we noticed 

some sheep relaxing in the 

cotton grass. We wondered 

whether we could go down 

and get some shots of them. 

Unfortunately, as soon as 

we got there they ran off! 

However, I soon had a new 

idea. I asked Marina to pose 

among the cotton grass, 

then I laid on the ground and 

framed her with the plants.”

#9 Escape to the wilderness9

L A N D S C A P E S

10Clicks

Above Use a wide aperture for 

a shallow depth-of-field. 

l Explore the infinite possibilities of golden hour, like 

photographer Mengyang Liu (500px.com/whalbum).

“When I first took this shot about three years 

ago I was pretty new to photography. I’d bought my 

camera several years back, but had been content 

just using the auto setting. However, when I started 

travelling in Europe more often this no longer 

satisfied me. Finally, I bought my first photography 

book and got to grips with the basics, including what 

golden hour is. I’ve never looked back since!” 

#10 Go for gold10
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I
’M WATCHING THE SUNSET UNVEIL ACROSS THE 
Exe estuary from a beautiful, but empty, new penthouse 
apartment. I’m coming to the end of a 15-hour time-lapse I’ve 
been working on, taking in the views and hive of activity of 

the boats below for the building’s owner. 
Penthouse apartments aren’t my usual stomping ground, but 

jobs like this make up a fair amount of my business. I’ve been a 
full-time freelance photographer and filmmaker for just over 
two years and I have learnt a lot along the 
way. We all have hopes and dreams of 
what a career as a freelance photographer 
will be like – having heaps of time to visit 
bucket list locations, buy those new lenses 
and put together that book you’ve never 
had the time to complete. That’s not to 
mention the constant stream of business, 
working for big clients that cough up your 
professional day rates and pay for your penthouse with sea views.  

I was lucky enough to have built up a portfolio that attracted 
work from those big clients and allowed me the opportunity to 
go full-time. I made a judgment about the security of my income 
based on work that I’d completed and contacts that I had at the 
time. I quickly realised, however, that my stream of work was 
by no means safe. A contact doesn’t always translate into work, 
particularly in the current economic climate, where budgets for 
projects can quickly be cut. 

It’s important not to put all of your eggs into one basket. 
I keep landscape photography as central to my portfolio as I can, 
but I’ve seen the importance of being open to other work. I now 
benefit from the varied work that I’ve taken up over the years, 
from weddings to work on cruise ships. 

Although landscape photography is what I enjoy the most, it 
lacks the client base that you see in other fields. With commercial

work and weddings, there’s a constant demand for 
photographers. The lack of secure work in landscape 
photography makes the leap to freelance more difficult. 

Based on my experience, I’ve compiled a couple of top tips: 
l Have an up-to-date and accomplished website. This is the 
primary means through which your clients will contact you and 
find out about your work. It is, essentially, your shop front and it 
needs to impress, and be easy to navigate. 

l Make business cards and take them 
everywhere. You’ll be surprised how many 
situations you’ll find yourself in when you 
want to hand over your details and you pad 
your pockets with a bewildered look on 
your face because you don’t have any. 
l Make time for networking and 
contacting clients. Get out there and start 
building avenues for future contracts.  

l Keep your doors open and don’t turn down work, no matter 
how small it might be. You can read and watch as many tutorials 
as you want, but putting your skills into practice will make you 
a better photographer. You’ll start to plan better, gain a better 
sense of your time and expenses and develop skills that will help 
with bigger contracts. Small jobs may also lead to bigger jobs, 
a wider network and a more secure income. 
l Protect time for what you love. Make sure you get out and take 
your dream photos. Get them on your website. One day, they may 
become the basis for the contract that pays for that penthouse. 

Guy Richardson is a professional landscape photographer 

and time-lapse filmmaker. His images are used by some of 

the UK’s largest tourism and conservation groups, including 

Visit Britain and The Woodland Trust. guyrichardson.com

I’VE SEEN THE 

IMPORTANCE OF 

BEING OPEN TO 

OTHER WORK...’

GUY RICHARDSON
ADVENTURES OF A WILD LANDSCAPE PHOTOGRAPHER BUSINESS ACUMEN 
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I
NSPIRATION COMES TO ME IN MANY DIFFERENT 
forms. I’m a very visual person; all of my life, I knew I saw 
the world differently, and when I found photography, it all 
made sense. When you find your passion in life and are able 

to pursue it, there’s no greater feeling. As artists, however, I feel 
like we’re sometimes our own worst critics and that can cause 
us to doubt our work and ourselves. There are times when my 
mind overflows with ideas and I want to shoot constantly. And 
there are times when inspiration and motivation fail me and I 
find it hard to get back into a rhythm. 

At the beginning of my career, I 
constantly compared myself to other 
photographers in my city. “You’re not 
as good as them. You can’t photograph 
like them. Your work isn’t as polished 
as theirs.” I remember those voices 
constantly reminding me I wasn’t 
good enough. Then it hit me – I’m not 
them, I’m me! I’m my own photographer, with my own style. 

I never really thought I had my own style until I started 
shooting consistently and started to notice it for myself.
Early on, I would think of concepts late at night. My mind 
would work overtime and I would lie awake in bed trying 
to think of something unique that I could try on my next 
shoot. Some concepts never turned out and you know what? 
That’s ok. Not every shoot is going to be your best. 

When a shoot was over and I’d edited the finished product, 
I would think to myself: “Ok Lisa-Marie, next time maybe 
try doing this rather than that. Edit this way instead of that 
way.” I gave myself notes and tips on how to improve for the 
next shoot. To this day, personal projects are some of my 
favourites because they help enhance your creativity. 

When I’m editing large amounts of photos for clients, it can 

get quite draining and monotonous. I’ll take a break and grab a 
photo from a personal shoot and just start editing. Sometimes 
I don’t have a clue where I’m going with the edit, but it helps 
me fall back in love with my art when I’m feeling stuck.

This also works for me when I’m not feeling motivated. We’ve
all been there at least once in our artistic careers – we fall into a 
rut where we end up doing the same thing over and over. I’m lucky 
to have personal friendships with a lot of the models I started out 
with. I’ll call some of my friends and gather a creative team and 

we’ll just start shooting. A lot of the time, 
there’s no concept, just us, some props and 
our talents combined. Those shoots are 
some of my favourites because there is no 
real plan, only a group of people coming 
together to create something magical. 

Motivation can often decrease when 
we aren’t seeing growth in our work 
or business. When I’d get rejected by 

magazines, it caused me to question my photography and if 
this was the right path for me. My mum would never let me
give up though. When I wanted to quit, she would push me 
to keep going, to keep shooting. If it wasn’t for her, I wouldn’t
be here today, writing this column and living my dream. 

So, don’t ever give up and don’t ever compare yourself 
to others – keep shooting for that dream. This is my 
final Practical Photography column and it’s been anhy
honour. I’m forever grateful. Until next time…

Lisa-Marie is a Scottish-born fashion and beauty 

photographer based in Alberta, Canada. Her work is  

regularly published in glossy magazines, and clients include 

Elinchrom, Canon and Vistek. lisamariemcginn.com

“AS ARTISTS,  
WE’RE SOMETIMES 
OUR OWN WORST 
CRITICS...”

LISA-MARIE MCGINN
ADVENTURES OF A FASHION PHOTOGRAPHER WHEN INSPIRATION STRIKES
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Beyond the season’s magical colour palette and changing 

landscape, there’s a hidden world of mammals, birds, 

insects and fungi waiting to be uncovered. We asked five 

of the UK’s best natural world photographers to choose 

their favourite autumn subjects and reveal the camera 

skills and fieldcraft needed to boost your portfolio.

COM PLETE GU IDE

AUTUMN

PROJECT 1

Get closer to 
hedgehogs 

P38

PROJECT 2

Fill the frame with 
woodland colour 

P40

PROJECT 4

Create a squirrel 
feeding station 

P44

MORE IDEAS!

Mist, leaves, 
fungi & more  

P46

PROJECT 3

Focus on flocks 
of wild geese

P42

  Nine creative autumn projects to try...
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nWhy do hedgehogs make such great 

autumn subjects?

Hedgehogs, especially hoglets, have a very cute 
reputation and are often the subject of myths 
and children’s stories. They are typically 
portrayed in an autumnal setting, which is
largely due to their habit of hibernating in piles 
of fallen leaves and even under bonfires. They 
also tend to be quite active at this time of year 
as they build up fat reserves for their big sleep. 
Seasonal images of popular creatures, like a 
winter robin or Easter bunny, may be a bit of a 
cliché, but they’re very commercial and a 
strong addition to any wildlife portfolio. For 
me, a healthy hedgehog captured among crisp 
golden leaves is the ultimate symbol of autumn 
and the coming winter.

nWhere can hedgehogs be found at this 

time of year? 

They often seek sanctuary in the quiet and 
overgrown parts of gardens, parks, and even 
churchyards. Last autumn I was working on a 
project in a local cemetery and had been talking 
to a groundsman who was burning some
organic waste. As he walked away I noticed 
some movement near a headstone and it was a 

very handsome and 
healthy hedgehog. I 
assume, given its condition, 
that it had been disturbed by the fire and was 
relocating. I managed to get a few shots before 
it slipped away. Hedgehog numbers have 
declined dramatically over the last decade, 
making them an increasingly rare sight in our 
gardens. They are also nocturnal and most 
active after midnight when human disturbance 
is minimal. If a hedgehog is out during the day, 
especially a juvenile, then it might be unwell 
and in need of help.

n How easy are they to photograph?

Hedgehogs aren’t difficult to photograph, 
although they can move faster than you might 
expect. It’s essential to avoid harming or 
distressing them so always try and plan the 
shot and prepare the scene first. Most of my 
hedgehog pictures feature young animals from 
a local rescue centre. The shots were taken at 
release sites or after the hoglets had been fed 
and weighed. There are now many of these 
places throughout the UK and this is a great 
way to see and photograph healthy hedgehogs 
during the day. It can also be mutually 

Simon is an award-

winning photographer 

based in Yorkshire. His 

images have been highly 

commended in both the 

International Garden 

Photographer of the 

Year and British Wildlife 

Photography awards. 

Check out the first 

instalment of his new 

column in next month’s 

issue. simonroy 

photography.co.uk

MEET YOUR GUIDE

SIMON ROY

Subject #1 
Expert 

TIP 

COLLECT A 

FEW PROPS

Rake dry leaves from your 

lawn and pile them in a 

sheltered compost area. 

This gives you a supply  

even during wet 

conditions.
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Capture Autumn

beneficial, especially if the resulting images 
are used to raise awareness.

nWhat kind of fieldcraft is involved when 

working with hedgehogs?

Hedgehogs have poor eyesight but good 
hearing and an excellent sense of smell. A good 
way to attract them into your garden is by 
making it accessible and allowing areas to grow 
wild, especially during autumn when they’ll be 
looking for a safe place to hibernate. Simple 
foods such as cat meat and biscuits or chopped 
boiled eggs can be given, along with a bowl of 
water. Don’t leave milk, as hedgehogs are 
actually lactose intolerant. Their presence can 
be detected by small dark cylindrical droppings 
often containing invertebrate remains. Larger
animals and pets can be a danger to hedgehogs, 
especially dogs, so these should be avoided.

n Are there any non-photographic 

accessories that can make life easier?

The best way to photograph most subjects is at 
eye-level and hedgehogs are no exception. I use 
a tough ground sheet, as this prevents both me 
and my equipment from getting damp and 
dirty. I would also recommend wearing suitable 

clothing for the weather conditions and to keep 
out ants and other small critters, as these can 
be very irritating. A pair of garden gloves can 
also be useful in case you need to handle the 
hedgehog or remove distracting elements from 
the scene.

n Any compositional advice? Your images 

often show subjects in their environment…

There are times when I want to show a subject 
in its environment and others when I want to 
create a more generic image without a defined 
location. A hedgehog in autumn leaves, for 
example, could have been taken anywhere and
therefore has a wider range of uses. However, 
when I photographed the one in the cemetery 
I intentionally included some of the headstone 
because I wanted the viewer to know where it 
was taken. My shot of a little rescue hoglet 
emerging from a plant pot was captured in my 
garden, so I used the patio and fence to 
reinforce the theme. Using props is a great way 
to strengthen the story in a photograph, or 
even change it completely. A robin pictured on 
a fork handle is a classic example of this – it 
could have been shot anywhere, but the prop 
suggests it’s in a garden.

Above 

hoglet explores 

Simon’s garden – 

leaves and pots 

help tell the story.  

Left A weathered 

headstone provides  

the setting for this 

fascinating portrait. 

Far left Use your 

longest focal length 

to help isolate the 

subject and blur the 

background.

 How to Get 
 the shot right 

1 Gear advice
Use the 

longest focal 

length you 

have. If an 

animal is relaxed 

it’s more likely to 

behave naturally. 

Hedgehogs don’t 

react well to 

noise – the 

further away you 

are the better. A 

longer focal 

length, combined 

with a wide 

aperture, will also 

help to isolate the 

subject and create nice 

background blur.

2 Settings
I shoot in aperture-

priority mode and use this 

along with ISO to control 

shutter speed. For portraits 

I tend to use my widest 

aperture and then stop 

down once to increase 

sharpness. I use autofocus 

in combination with 

continuous drive mode and 

typically only select a single 

AF point, as I find this to be 

more accurate.

3
Always try and focus 

on the subject’s eye. This is 

especially important when 

photographing hedgehogs, 

as their eyes are set back 

behind a pointy snout. 

Always use a camera/lens 

support, as this makes a 

huge difference to stability 

and sharpness. A sturdy 

ground-level tripod is a 

great asset to any wildlife 

photographer, while a 

beanbag is ideal  

when a tripod is 

impractical.
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nWhy do trees and woodlands make 

such great autumn subjects?

Trees provide so many ingredients – colour, 
shape, texture, even personality. The forest is 
where we evolved, so for me there’s a spiritual 
connection, which undoubtedly fuels creativity. 
I set out not to simply record the forest, but to 
interpret it; to try and capture its mood and 
character. The light and weather of autumn, 
coupled to the warm colours, makes this much 
easier than at other times of year. I favour 
abstract impressions and regularly use 
techniques such as multi-exposure, de-focusing 
and intentional camera movement – it doesn’t 
always work, but it’s great fun trying!

n Are there particular types of trees 

that we should be focusing on?

I’m lucky in that close to home I have access to 
some of Scotland’s oldest surviving remnants of 
the Great Wood of Caledon – an oceanic boreal 
forest, dominated by Scots pine. Much of my 
work focuses on this native conifer, often 
twisted and gnarled into beguiling shapes. 
Around the edges of the pinewood, species 
such as birch, rowan, aspen and willow provide 
the most spectacular colours to counterbalance 

the bottle greens of 
the pines. Further 
south, beech trees abound 
and on a misty morning offer a seductive 
cocktail of elegant grey boughs laid against 
a carpet of bronze and ochre.

n How easy are trees to photograph?

Forests and woodlands are tricky places. The 
orderly clean lines of a more open landscape 
aren’t available and so you’re forced to make 
visual order from ecological chaos, the very 
symbol of healthy woodland. Sure, you can 
photograph a mature forestry plantation with 
its straight trunks and even spacing, but that is 
to miss out on the challenge of showcasing a 
truly wild wood with all its entanglement. Put 
aside half a day, choose a patch of woodland 
close to home and, if you want to experiment 
with abstract interpretations, visit on an 
overcast day when the light will be soft.

n On the subject of light, what are your 

ideal conditions for woodland?

Most of my woodland photography relies on 
‘bad’ weather. Overcast, dull light, especially 
during or after rainfall, renders soft but 

Based in the heart of 

Scotland’s Cairngorms 

National Park, Peter has 

been using his images to 

inspire and inform for 

over 15 years. He’s 

racked up numerous 

awards, authored six 

books and initiated 

conservation projects 

such as Tooth & Claw, 

Highland Tiger and 

2020VISION. petercairns 

photography.com
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PETER CAIRNS

Subject #2 Woodlands

Expert Peter Cairns

TIP 

PRACTICE 

THE ART OF SEEING

On arrival, leave your camera 

in its bag, get into the forest, 

breathe in the air and  

relax. Images will come 

naturally if you’re 

inspired.
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saturated colour, which can be interpreted in 
many different ways. At the start and end of an 
autumn day, light levels will inevitably be low, 
necessitating a slow shutter speed – perhaps 
5-10 seconds – during which you can fully flex 
your creative muscles by panning, zooming or 
de-focusing the camera to create abstract, 
impressionistic effects. With a little practice, 
your images morph from simple record shots to 
photographic art. 

n Any compositional advice?

I try not to photograph a subject as such, but 
to photograph light. By that I mean that an 
understanding of light and an appreciation of 
its effect on different landscapes dictates where 
I go and what sort of image I set out to create. 
There’s little point in waiting on a hillside for 
the ‘big view’ on a rainy day with a drab white 

sky. These are the times to head for the 
woodland interior with a telephoto zoom lens 
in hand (my weapon of choice is a 70-300mm). 
To deliver an intimate landscape image – one 
that excludes all extraneous detail – you need 
to look, and I mean really look. Compositional 
elements will be basic, but all will be obvious in 
the final picture, so discerning a section of a 
particular tree or area of forest that will 
effectively translate to an image is critical. 
Properly looking, or more accurately seeing, is 
essential with this type of photography. Your 
job is to extract visual order from a scene that 
seemingly offers nothing but disorder.

nWhat’s the best way to enhance 

autumn colours? 

I always shoot RAW and more often than not 
without filters. The exception might be swirling 
water that benefits from a polariser or a windy 
day that requires an ND filter to slow shutter 
speeds to record movement. At the computer 
I might adjust white balance, vibrancy and 
clarity, but beyond that, everything is done 
in-camera and with the help of the weather and 
the light. Of course, this is just my personal 
approach and although I prefer to create my 
images while looking through the viewfinder, 
many software packages are available which 
aid almost any visual effect you can imagine.
Are you a photographer or a digital artist? 

Above 

a sense of depth to this image of Scots pines. 

Left Vertical panning – moving the camera during 

the exposure – is ideal for more abstract results.

Far left A shutter speed of 1.3 seconds has 

blurred the leaves of this lichen-covered silver 

birch to create a suitably impressionistic image.

 How to Get 
 the shot right 

1 Gear advice
For intimate 

woodland landscapes, 

you’ll need a medium 

telephoto lens between 

70mm and 400mm. I always 

use a tripod, as it aids 

composition, slows you 

down and is 

essential for 

working with 

long shutter 

speeds. I 

always use 

the 2-second 

self-timer 

release to 

avoid camera 

shake.

2 Settings
I always shoot in 

manual exposure mode 

and, given that most 

woodland scenes are 

mid-toned, evaluative 

metering mode is reliable. 

Shoot ISO 100 or as close 

as your camera will allow, 

and set an aperture of 

around f/11-f/13, and stop 

down further to f/22 or 

beyond to deliberately slow 

your shutter speed. 

3
For vertical panning,  

I start with a shutter speed 

of 1 second and smoothly 

pan down the scene. I take 

care to ensure the camera 

is moving before the shutter 

opens and continues its 

movement after the shutter 

closes. Multi-exposures are 

achieved simply by laying a 

sharply focused image on 

top of a de-focused image. 

Most modern cameras will 

then combine the two (or 

more) images in-camera.



nWhy do migratory geese make such

great autumn subjects?

The arrival of hundreds of thousands of
migratory wild geese to our shores is a greatly
anticipated event. There are six main species
that arrive from September to October, then

nWhere can migratory geese be found?

Most species tend to stay close to our coasts
and there’s likely to be a wintering population
within reasonable travelling distance. Some
species, such as the barnacle geese, have two
distinct populations that traditionally return to

n

One of Scotland’s best 

known natural history 

photographers, Laurie 

has dedicated over 35 

years to capturing the 

country’s flora and fauna 

and has a picture library 

of over 120,000 images. 

He was honoured with 

the Lifetime 

Achievement Award at 

the RSPB Nature of 

Scotland Awards 2014.  

MEET YOUR GUIDE

LAURIE CAMPBELL

Subject #3 
Expert
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nWhat kind of fieldcraft is involved?

Unlike our resident geese that have become
tolerant of people, migratory wild birds are
naturally wary because they’re hunted more.
There’s also the safety in numbers factor and
even when they’re feeding there are always a

n

just draping it over a long lens attached to a
tripod immediately breaks your outline and
gives you something to hide behind. An LED
headlamp will be required when at roosts
where you need to arrive or leave in darkness
and, if your site is coastal, an app for tide
timetables is essential. Consider your own

n

 How to Get 
 the shot right 

1 Gear advice
If you’ve got two 

camera bodies, fit one with 

a long lens of at least 

300mm on a cropped-

sensor body attached to a 

tripod with a fluid head. 

This is for photographing 

sections of 

flocks. Fit the 

second body 

with a shorter 

lens such as 

24-70mm or 

70-200mm. 

This is for 

individual 

birds within 

large flocks. 

2 Settings
A shutter speed of 

1/1000sec or 1/500sec 

should be sufficient for 

most flight photography, so 

whatever mode you choose, 

keep an eye on what the 

camera is doing and check 

histograms. You could learn 

about correct exposure by 

practising using manual 

mode. That said, just about 

any mode should be fine if 

shooting silhouettes.

3
To have the best 

chance of focusing on birds 

approaching a roost, switch 

to continuous focus/AI 

Servo mode and start by 

acquiring focus on them 

when they’re too far away 

for a decent image, then 

follow them in. And if you’re 

unsure from which direction 

they might approach, don’t 

worry because you’re likely 

to hear them long before 

you can see them!
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nWhere can squirrels be found at 

this time of year?

The UK is home to two species – the native red 
and the introduced grey, which originated from 
the USA and was brought over in the late 19th 
century. Grey squirrels have adapted so 
successfully they’re now widespread 
throughout Wales, England south of Cumbria, 
and in local pockets in Scotland. They’re 
regular visitors to parks and back gardens and 
often take advantage of bird feeding stations, 
which is great for photographers, as autumn is 
when squirrels urgently need to gather food to 
see them through the leaner winter months.

Red squirrels on the other hand have 
suffered a catastrophic decline over the same 
period because the larger and more aggressive 
grey has pushed them out of many of their 
traditional haunts. Greys also carry a pox virus, 
which has no effect on them, but which is 
deadly to reds. As a result, they’re clinging on 
in much of the UK. Of the 160,000 or so 
estimated to remain, around 75% are in 
Scotland, in particular The Highlands, which is 
one of the red’s last strongholds. Only small 
pockets of populations can be found south of 
the border, in areas such as Brownsea Island in 

Poole Harbour, 
Dorset and Formby 
Point in Merseyside. 

n How easy are they to photograph?

In places like Formby Point, where reds have 
become habituated to day-trippers leaving 
food, it’s possible to get surprisingly close. 
Greys have become very tame and easy to 
photograph for the same reasons. Some of the 
tamest grey squirrels I’ve found have been in 
some of the larger parks in the London area. 

The best way to photograph squirrels is to 
set up a small feeding station in your garden 
and add props – colourful leaves on the ground 
or a mossy log will set the scene. The beauty of 
working this way is that you can photograph 
them on a certain perch and, once you’ve 
grabbed your images, change your perches and 
increase the diversity of your portfolio. 

I’m a great believer that good light is the key 
to good photography, and because your feeding 
station is so close you can visit when the light is 
at its best. I shoot early mornings and late 
evenings, which is good practice for working 
with squirrels anyway because they’re more 
active at these times. 

An award-winning pro 

based in Leicestershire, 

Danny is obsessed with 

mammals, birds, insects 

and reptiles. His biggest 

project to date – Atlantic 

puffin colonies in the UK, 

Iceland and Norway – 

was published in National 

Geographic in 2014. 

Danny also runs a tour 

business called Natures 

Images. dannygreen 

photography.com

MEET YOUR GUIDE

DANNY GREEN

Subject #4
Expert 

TIP 

PROVIDE A 

HEALTHY DIET

Squirrels love peanuts, 

sunflower seeds and 

hazelnuts, but also need 

apples and carrots for 

vitamins and 

minerals.
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nWhat kind of fieldcraft is involved when 

working with squirrels?

I have no problem feeding wildlife to attract it 
to certain areas for photography. You’re not 
only benefiting the subject, you’re also helping 
your own portfolio in the process. Squirrels are 
creatures of habit and once they’ve found a 
regular feeding spot they’ll visit every day. 
They’ve got a soft spot for unsalted peanuts, 
though these won’t look particularly natural in 
your final image. Instead, a great tip is to gather 
acorns during the autumn months, freeze them, 
and when it comes time to shoot, mix peanuts 
with your acorns – a portrait of a squirrel with 
an acorn in its mouth is always a winner.

n Are then any non-photographic 

accessories that can make life easier?

Squirrels are best photographed at ground level 
among autumn leaves, using a wide aperture to 
blur foreground and background. This puts all 
the attention on the subject without any 
unwanted distractions and, in my opinion, 
makes the images more intimate. I use a 
Therm-a-Rest mat for low-level photography – 
they’re lightweight, comfortable, and will keep
you warm and dry, which is essential if you’re 

lying down for long periods of time. Plus, the 
less you move, the more at ease the squirrel will 
be. I also use an angle finder, which is a great 
bit of kit when you’re lying prone, as it stops you 
from getting a sore neck. 

If you want to take things one step further, 
a small canvas hide will help you capture more 
natural behaviour, particularly as they come 
into the feeding station. You can buy these
hides ready-made or set yourself another 
project and make your own, which can be made 
out of bits of old wood or tarpaulin.

n Any compositional advice?

The quality of modern zooms means that we 
can be more creative in the way we photograph 
our subjects, and I think the best approach for 
successful wildlife photography is to work with 
one subject over a long period of time. A grey 
squirrel is the perfect subject to start off with. 
How many pictures have you seen of leaping 
grey squirrels? They’re incredible acrobats! 
Once you’ve got squirrels visiting your feeding 
station on a regular basis, try to encourage 
them to recreate this classic shot by positioning 
your feeding station in such a way that the only 
way to get to it is to jump to it. 

Left An aperture of f/4 was 

used to blur the leaves in 

this classic portrait. 

Below Don’t be afraid to 

push ISO beyond 800 to 

maintain a shutter speed  

of 1/250sec or faster. 

1 Gear advice
I used to use a 

massive 500mm f/4,  

but bought Canon’s 

100-400mm last year 

and find that it gives 

greater flexibility and  

is extremely sharp 

throughout its 

range. I also use 

Gitzo’s 

Systematic 

range of 

tripods, as 

these are 

extremely 

sturdy and can also fold out 

to shoot at very low angles. 

2 Settings
I always shoot in 

aperture-priority mode and 

set aperture and ISO to 

dictate the shutter speed I 

can work with. I usually 

want to work above 

1/250sec for portraits, but 

for action I’m trying to shoot 

with much faster shutter 

speeds so shoot wide open 

and choose higher ISOs.  

Modern cameras control 

high ISO and noise so well.

3
Autofocus is 

amazing, but not always 

fast enough, so when 

working with leaping 

squirrels I work out my 

angles, use AF to pre-focus 

on a certain point, then 

switch to manual focus to 

lock it off, and hope the 

squirrel jumps through the 

plane of focus. You have to 

take a lot of pictures just to 

get one or two sharp ones, 

but that’s the beauty of 

digital photography. 

 How to Get 
 the shot right 
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Autumn is the perfect time of year to photograph spider webs 

bejewelled with morning dew. After clear, cool nights, webs 

will be sparkling with tiny water droplets, adding interest and 

scale to your close-ups. Webs are easily wind-blown, so a 

still, windless morning is best. If you want to fill the frame with 

the shape and structure of your web, use a macro lens or 

close-up attachment. Select your viewpoint carefully. If you 

want to record the web sharp throughout, select a parallel 

angle in order to place as much of the subject as possible 

within the plane of focus. For more arty, interesting results, 

place your camera at an angle to the web and select a wide 

aperture such as f/4 to highlight just a few strands and throw 

the rest out of focus. 

Autumn colour is one of nature’s 

great spectacles. Now is the time  

to visit local woodland, or an 

arboretum, to photograph close-

ups of foliage. Simple compositions 

typically work best and 

background choice is 

important. Look 

for colourful 

leaves that you 

can easily isolate 

against a clean, uncluttered 

background. Doing so will really 

help them stand out boldly. Try 

using autumnal foliage to create 

compelling, colourful backgrounds, 

selecting a wide aperture and 

shallow depth-of-field to throw 

leaves attractively out of focus. 

Focus carefully on your subject, 

using a tripod if possible. Bright, 

overcast weather is ideally suited  

to taking photos within woodland, 

as light will be evenly diffused.

2
ISOLATE LEAVES 

FOR COLOUR 

AND SIMPLICITY 

Wildlife expert Ross Hoddinott 
presents a further selection of 
accessible autumn subjects.  

1INTRICATE STRUCTURES

moremoremoremore

eative creativecreative

eas...ideas...ideas...

Since winning the Young 

Wildlife Photographer of 

the Year award aged 17, 

Ross’ career has gone 

from strength to 

strength. He’s travelled 

the world, written a 

number of best-selling 

books, runs Dawn 2 

Dusk Photography with 

Mark Bauer and Adam 

Burton, is a Manfrotto 

ambassador, and 

recently completed  

a year-long stint as a 

Practical Photography

columnist.  

rosshoddinott.co.uk

MEET YOUR GUIDE

ROSS HODDINOTT
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Backlighting suits translucent subjects like leaves, highlighting 

their shape, colour and intricate veining. You don’t necessarily 

need natural sunlight – you could use an LED device to create 

artificial backlighting, or collect fallen leaves and arrange 

them on a lightbox. If you have one, dust it off and carefully 

arrange your leaves to create repetitive, overlapping patterns.

Fungi like moist environments and ancient woodland. Many

species are small, so a dedicated macro lens is a great choice. 

Shutter speeds will be slow, so a tripod is essential. Low 

viewpoints often provide the most interesting images. Use a 

reflector to relieve dark shadows on stems and beneath caps.

Check the weather forecast regularly. Clear, still nights – when 

the temperature drops steeply – offer the best chances of mist 

forming. Mist will simplify scenery. Elevated viewpoints and 

woodland interiors suit misty conditions best. Longer focal 

lengths will help foreshorten perspective and emphasise 

foggy weather – a 70-200mm is a great lens choice. 

3USE ARTIFICIAL LIGHT TO 
CREATE BOLD PATTERNS

4 FORAGE FOR FUNGI IN 
DARK, DAMP PLACES

5CAPTURE THE WORLD 
SHROUDED IN MIST

Capture Autumn
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£��.99
WORKS  

WITH YOUR   

A4 AND A3 

PRINTER

www.fotospeed.com

Fotospeed Panoramic InkJet Paper

Many landscape photographers struggle to realise  their panoramic images  as prints 

on paper without the highly sought after 3:2 ratio. 

The unique 210mm x 594mm format of Fotospeed Panoramic InkJet Paper gives 

you a full A2 width and can be used with an A4 or A3 printer.

The panoramic format gives you the opportunity to use scale and composition that 

regular A sized papers cannot give you. With 6 paper finishes available, there is 

something for every landscape.

For more information about Fotospeed Panoramic InkJet Paper,  

call us on 01249 714 555 or email us at sales@fotospeed.com.

WHEN YOUR LANDCAPES  

NEED MORE THAN A4AVAILABLE  

IN 6 PAPER 

FINISHES
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Competition

WIN!
A G
TR

WORTH £1250

G
ITZO IS CELEBRATING 
its 100th birthday this year
and to mark the occasion the
luxury brand has announced the
100 Year Anniversary Edition Tripod. 
A limited edition of just 1917 pieces 

(a reference to the year of Gitzo’s foundation), with the 
number of each piece laser-engraved on one leg, this 
exclusive travel tripod has an RRP of £1249.95 – and 
you can win one! 

The 100 Year Anniversary Edition Tripod features YY
Gitzo’s latest Traveler Series 1 technology, including 
Carbon eXact tubing and 180º leg folding mechanism, 
together with a brand-new Center Ball Head for 
superior smoothness and precision. Included is an 
ergonomic strap made of genuine Italian leather. 
Presented in a black branded chest with leather 
detailing, the 100 Year Anniversary Edition Tripod also 
features a certificate of authenticity, signed by Gitzo’s 
CEO and including the name of the craftsman who 
created each specific piece. 

There are also two runners-up prizes to be won – 
Gitzo Century Traveler Messenger bags worth £179 95
each. Part of Gitzo’s new selection of premium bags
Century Traveler is made with genuine Italian lea
crafted to resemble carbon fibre, and water-resistant
nylon. Equipped with a G-lock flap closing system, 
can be opened and closed with a simple gesture, and 
comfortably house a DSLR or CSC with standard 
attached, plus two more mid-range lenses. 
n Visit manfrotto.co.uk/gitzo for further product 

How to enter
We want to see your best travel photos! 
Simply visit practicalphotography.com/
gitzocomp and upload one travel-
themed image. The closing date for 
entries is 22 November 2017 and the 
winners will be announced within 14 
days. See practicalphotography.com for 
full terms and conditions. 

Enter now! Visit practicalphotography.com/gitzocomp

Upload your best travel  
photo and you could  
win a limited edition 100 
Year Gitzo Anniversary 
Edition Tripod. 

EXCEPTIONA
BUILD QUALI
Smoother spider, new 

leg angle selectors 

and locking collars

LIMITED 
EDITION
The number of each 

piece is laser-engraved 

on one leg

EXQUISITE 
DESIGN
New black and 

titanium colour 

combo adds a 

touch of elegance 

PREMIUM BAG
Made with 

genuine Italian 

leather & water- 

resistant nylon, 

and fitted with  

a G-lock flap 

2ND PRIZE

TWO GITZO  
CENTURY  
TRAVELER  

MESSENGER BAGS

VALUE

£179 EACH

1ST PRIZE

100 YEAR 
ANNIVERSARY  

EDITION TRIPOD

VALUE

£1250 
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FIVE GREAT EXAMPLES OF

FUJINON’S FINE 
FAMILY OF LENSES

A
camera is a wonderful tool, and we’ve 

seen just how impressive the Fujifilm 

X Series is over the last three months, 

exploring their many strengths and plus 

points. However, a camera is nothing 

without a good lens, and Fujifilm is well 

known for producing the highest quality glass. Since 

1962, Fujifilm has been creating lenses under the

Fujinon brand. Some of these lenses played a major 

part in the finest moments ever committed to screen, 

praised for their calibre and constant innovation. 

Fujinon is still producing some of the most well 

regarded cine lenses to this day, although we are 

more interested in its excellent range of 25 lenses 

that fit each X Series camera to deliver pin-sharp 

results. Whether it’s the XF 18-55mm f/2.8-4 R LM 

OIS, a humble kit lens with a wide variable aperture 

and sharp results, all the way to the stunning XF 

50-140mm f/2.8 R LM OIS WR, which adds a telephoto 

to the line-up, Fujifilm has a great range of glass. 

One of the greatest strengths of the X Series 

cameras, beyond having such amazing glass to 

work with, is definitely the ability to use any lens 

in the range. This means you aren’t penalised as 

you are in the DSLR world where you have APS-C 

and full-frame lenses, each producing drastically 

different results and others outright refusing to 

work. It is this innovation at the heart of Fujifilm 

that makes the company and its products so 

appealing to many of us. So, without further ado, 

we will now take a look at five of our favourite lenses 

and talk about what makes them so desirable.

1
Fujinon XF 18-55mm f/2.8-4 R LM OIS

Although this walkabout lens is often seen 

as a kit lens, it has huge potential, and is very 

sharp, meaning you can easily manage 

top-quality images without ever taking this one 

off. It has a deceptively compact size due to using 

a variety of advanced optical and mechanical 

designs, which also allow it to retain a variable 

Fujinon is the name emblazoned on every 
Fujifilm lens, harking back to a heritage 
which has been producing some of the 
finest lenses of the last half decade.

“THE XF18-55MM F/2.8-4 IS ONE  

OF THE BEST AND SHARPEST  

KIT LENSES WE’VE EVER SEEN”
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aperture of f/2.8-4, which is a step beyond many of 

its competitors’ offerings. It also includes 14 elements 

in 10 groups, 3 of which are aspheric and a further 

1 which is an extra-low dispersion, all of which help

to combat flare, ghosting and chromatic aberrations. 

The image stabilisation is effective at 4 stops, 

meaning this lens is ideal to use in low light situations, 

even when you’re shooting handheld. Add this to the 

lightning-fast 0.1sec possible focusing time and this 

is, in our opinion, one of the best kit lenses currently 

on the market.

Discover Fujifilm X Series

XF MOUNT
The XF mount means that  

any lens in the range will 

fit any camera in the X 

Series line-up, so you 

don’t need to buy multiple 

lenses for each camera.

GLASS OF THE 
FINEST QUALITY
Each and every Fujinon 

lens is handcrafted by 

expert technicians, 

who pay meticulous 

attention to detail. The 

XF range also benefits 

from a deeper mount 

inside the camera 

body, offering an 

increased resolution 

and more responsive 

handling, as well as 

a compact design. 

FILTER FRIENDLY
Great news for landscape 

photographers and filmmakers 

alike, these Fujinon lenses 

come with a threaded filter 

ring – great for anybody who 

regularly uses ND filters.

KEEPING IT CLASSIC
As you’d expect from 

a company who lives and 

breathes aesthetic quality, 

these lenses have a simplistic, 

yet iconic appeal to them, 

meaning they’ll never 

look out of place on the 

front of your X Series.

SMOOTH OPERATOR
From a functionality 

standpoint, the XF 

lens series has been 

thoughtfully designed. 

The aperture and focus 

rings move freely and 

smoothly, with just 

enough resistance 

to allow pin-point 

precision on every use.

Many of the Fujinon lenses 

keep true to the classic Fujifilm 

aesthetic, bearing a manual 

aperture ring. This pays 

homage to a time before digital 

cameras and electronic lenses 

when everything was manual,  

including focusing and 

aperture control. By adding this 

feature in, the X Series gives 

you a glimpse into the past, 

feeling like you have ultimate 

control, by using the lens to 

switch your f/stops as you 

need them. Of course, there 

are people who prefer to let the 

camera make the decision – 

twisting the aperture ring to the 

‘A’ position puts it in automatic 

mode – based on the needs of  

the subject, which is perfect for 

covering all eventualities.

TECH SPEC THE APERTURE RING 
CAPTURES THE CLASSIC FEEL 

Above The aperture ring echos 

the classic aesthetic of film 

photography, while also allowing 

automatic operation.

A DV E R T I S I N G F E AT U R E

SUPERIOR QUALITY 
OF BUILD
Fujinon lenses have 

long been known 

for their superb 

build quality and 

the XF lenses are 

no exception. Each 

XF lens includes a 

robust metal mount 

and tough plastic 

control rings, so you 

can always feel secure 

in the knowledge 

that each lens will 

stand up to an insane 

amount of hard use.

GREAT  

FOR 

EVERYDAY  

USE
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3

to back sharpness, as well as an enhanced inner focusing 

system, meaning autofocus is quick, quiet and accurate. 

Perhaps the biggest advantage of this lens is the near 

total lack of distortion at the widest 10mm focal length, as 

well as a lack of fringing or chromatic aberration, meaning 

it produces a clean image thanks to 4 aspherical and 3

extra-low dispersion elements. At 410g, it may not be the 

lightest glass on the roster, but this is due to the typical 

premium construction that makes Fujinon lenses stand out.

4
Fujinon XF 16mm f/1.4 R WR

A lot of people complain about mirrorless cameras not having a varied 

enough focal range in their lenses, but this isn’t something X Series 

users need to worry about. The XF 16mm F/1.4 R WR is a wide-angle 

lens, which sits between the 14mm f/2.8 and the 18mm f/2. 

oasts 13 elements in 11 groups, 2 of which are aspherical and 2 are 

ow dispersion, as well as having a weather-sealed construction so it’s 

e for any all-weather landscape shooters. The incredibly wide f/1.4 aperture

s this lens ideal for astrophotography or architectural interiors, too, especially

ght conditions. The chromatic aberrations and flare are all handled

ough it’s the perspective control where this lens shines, where it keeps

s straight and gives an excellent field-of-view. Of course, with a 35mm 

ent focal length of 24mm, and a minimum focusing distance of 15cm, 

s is even more versatile. We recommend trying to capture environmental

s, or even getting close to your subject for a unique perspective.

2

type on the planet and a real bonus for any Fujifilm users 

who are into portraiture or shooting in low light conditions.  

GREAT  

FOR STYLISH 

PORTRAITS

GREAT  

FOR EPIC 

SCENICS

GREAT  

FOR  

AMAZING 

ASTRO
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Discover Fujjifilm X Series

Since 1962, Fujifilm has been creating lenses under the  

Fujinon name, starting with the aim to produce high-quality 

cine lenses for the film and television industries. While it has 

been making motion picture film since 1934, and still cameras 

since 1948, the lens revolution was a big part of Fujifilm, filled 

with innovation. This includes the first inner focus system in 

a zoom lens, for TV broadcasting in 1967, and adding fluorite  

as a coating to correct chromatic aberration. It even 

patented  revolutionary glass moulding process for aspherical 

lens elements in 1993. By taking a look back at such a storied 

and prestigious history (which includes two Emmy awards for 

innovative technology) we can understand what they bring to 

the table in the X-Mount glass. Each lens is meticulously 

crafted by hand, as well as passing through rigorous quality 

checks, so you know you can buy any lens with confidence. 

Whether it be the XF 14mm f/2.8 R all the way up to the XF 

100-400mm f/4.5-5.6 R LM OIR WR, quality is assured.

“THE XF100-400MM  
OFFERS 152-609MM 
EQUIVALENT LENGTH,  
A MASSIVE REACH”

A DV E R T I S I N G F E AT U R E

CRAFT & TRADITION 

HISTORY OF FUJINON LENSES

Sometimes, regardless of the 

length of your telephoto lens, you 

want just a tiny bit more, which is 

where teleconverters come into 

play. Fujifilm has two of these 

handy units, which sit between 

the lens and the camera mount, 

magnifying the effective length of 

your glass. The XF 1.4x TC WR 

and the XF 2x TC WR are both 

designed to work with your longer 

focal length zoom lenses to offer 

you the most from your shooting 

experience, allowing extra reach 

without having to shell out on 

a new lens. Both teleconverters 

also feature a tough and w 

eather-resistant design, 

which allows you to brave 

the usually inclement weather 

with confidence.

TECH SPEC TELECONVERTERS 

DOUBLE YOUR DISTANCE

5
a problem for Fujifilm. This 152-609mm (35mm

equivalent) glass gives a gigantic zoom range, making 

it a boon for wildlife photographers who need to keep 

their distance, or anybody shooting sports from the 

touchlines. Packing in a colossal 21 elements in 14 

groups, including 5 extra-low dispersion and 1 

super-extra-low dispersion elements, helps to combat 

any chromatic aberration found in these types of zoom 

lenses. It also features a weather- and dust-resistant 

design and fluorine coating on the lens, helping this 

camera withstand temperatures of -10ºC and lend 

itself to some serious photography! The lens also 

manages to incorporate an image stabilisation system, 

offering up to 5 stops of clarity, making this a serious 

contender when you need to shoot handheld in low 

light conditions. This XF100-400mm not only gives you 

an extra dimension of versatility, it also manages to 

weigh less than 1.4kg so it’s a very compact and highly 

efficient lens to have in your arsenal.

GREAT  

FOR SPORTS  

& WILDLIFE



54 PRACTICAL PHOTOGRAPHY

D
AVE KAI PIPER IS SOMETHING OF 

a rarity in this day and age, casting 

off the notion of consistency and 

pigeon-holing in favour of keeping his 

wandering passion for photography 

alive. He sees his kit as little more 

than a tool to achieve his vision, though it’s 

important that it keeps up with him as he mixes 

a wide range of stunning genres in his stride.

n You’ve been around for quite a while now, but 

what first got you interested in photography?

Looking back, that gets harder to work out but 

I remember when I first learned about photography. 

I was 12 and living in Cyprus when my mum 

bought me a blue Instamatic film camera and said, 

“You should take some photographs of things, 

in case you never see them again”, and that idea 

kind of stuck in my head and began to grow. 

At first, I used photographs to document places 

that I’d been to, but I slowly discovered that this was 

also a way to express the things I wanted to say. 

My work now is an extension of that simple idea. 

n What drew you to Fujifilm and how did 

you become an X-Photographer?

In the first instance, it was the design of the camera 

(the X-Pro1). Before I even knew the tech specs 

and the quality of the finished system, I just fell in 

love with the look. The process of becoming an 

X-Photographer was different back then – we knew 

the X Series was good and we knew that it would 

grow, but we couldn’t have estimated the size and 

rate of the growth. During the last six years, the 

cameras have become faster, more powerful and 

the lens range has grown, but what first attracted 

me to it is still very much present. The system 

works effectively, efficiently and in a smaller, 

lighter package than anything else in its class.

n You’re the original jack of all trades, so does 

the X Series complement your mix of genres?

In some ways, that’s the biggest negative to my 

work – it’s not always the best way to market 

yourself in today’s environment. Having a clear

style is the best way to create your brand and 

market it on social media, but I’m terrible at 

Dave 
Kai Piper
Passionate about 

photography since 

he was 12, Dave 

Kai Piper has built 

up a wide range of 

images over 

a diverse series of 

genres, both to 

express himself, 

and document 

his journey.

FUJIFILM X-PHOTOGRAPHER  
Q&A DAVE KAI PIPER  

A PROFESSIONAL PHOTOGRAPHER 
WITH AN ECLECTIC MIX OF SKILLS. 



following my own advice. That said, I always 

enjoy what I shoot and all aspects of my work. I 

set out to photograph things I enjoy and create 

images I want to. Of course, if I’m shooting for a 

client, then so long as they’re happy, I’m happy. 

Having a camera system that’s ready to go and 

shoot anything is key for me. One day I could be on 

a wet Welsh mountain then shooting high-end beauty 

the next, so size and reliability are important to me. 

This system is smaller than a 35mm setup, which 

is perfect for my ‘eclectic style’ (I’ve just ridden on 

my motorbike with the X-Pro2 and XF35mm lens 

tucked into my pocket, which I definitely couldn’t do 

with a DSLR). I have the reach and power with the 

advantage of a smaller size than I used to work with, 

plus I love the dual EVF of the X-Pro2. I can switch 

from the studio, where I use the optical viewfinder, 

to location, where I use the EVF, which lets me make 

sure I have the perfect exposure and white balance. 

The lens range is excellent for so many genres too 

– some days I only need the XF35mm and XF56mm 

lenses, but knowing I can use any focal length from 

10mm to 400mm means I can tackle anything.
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Opposite Dave 

finds inspiration 

from films and 

directors of 

photography, 

leading to his 

cinematic style.

“THE FUJIFILM X 

SERIES IS PERFECT 

FOR MY ECLECTIC 

SHOOTING STYLE”

Discover Fujifilm X Series
A DV E R T I S I N G F E AT U R E
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n We love your cinematic style and strong 

narrative – how can we achieve our own style?

Although I shoot a lot for clients, it’s my own 

personal shoots that shape my style, which I think

is the best way to approach it, since you can craft 

and refine your skills as a photographer. Over the 

years I’ve put thousands of hours in to learning 

who I am and finding my own style. It’s interesting 

you say cinematic, though, as I love films and find 

inspiration in DOPs (directors of photography). 

A lot of photographers I love also have that feel 

to their work, like my friend Tom Barnes, or 

American photographer Joey Lawrence. A lot 

of photographers will say that photography is a 

captured moment, but for me it’s more like a still 

taken from a constant film – I guess that’s where it 

comes from. As for the narrative, why be subtle? 

n We’ve heard a lot about the X-Trans 

sensor’s colour rendition – does this give 

a good starting point for your edits? 

That’s a complex question with a simple answer. 

I either shoot with a digital colour grading in 

Photoshop in mind, or I shoot for a finished image 

in-camera. It’s important to remember, though, 

that my photography isn’t a photocopy of life, 

but a means to tell a story from the world around 

me. Skin tones are usually the most important 

elements to get right in my images and, to be 

honest, the X-Trans sensor means I rarely have to 

worry about any odd colours getting in my way.

Above You can 

see a strong 

narrative in much 

of Dave’s work.

Below Seen from 

his motorbike, 

Dave didn’t even 

have time to take 

his helmet off.

“I’D PUT UP A FIGHT 
FOR THE FUJINON 
XF56MM F/1.2, THAT’S 
FOR SURE”



PRACTICALPHOTOGRAPHYCTICALPHOTOGRAPHY.COM  57

n What would you say is currently 

your favourite image – and why?

It changes moment to moment, but today I think 

it’s this image of a beach at sunset (bottom left) 

that I camped near on my last trip out on the 

bike to Wales. I turned a corner and saw this 

amazing view so I just stopped, grabbed my 

camera from the tank bag and took a shot. I didn’t 

even wait to get my helmet or gloves off.

n Do you ever use the Film Simulation modes 

to get an idea of what you’re shooting?

I would say that 99% of the time, my camera is 

set to ACROS mode (Fujifilm’s seminal black & 

white mode), even if I’m shooting in colour, as it 

lets me see the tonal range without the distraction 

of colours, which I control in post-production. 

I also use manual focus with blue peaking (a fuzzy 

overlay which tells you when you’re in focus).

n If someone took away your X Series and 

lenses tomorrow, what would you miss most?

Do you know something I don’t? I would put up a 

big fight for the XF56mm f/1.2, that’s for sure.

n We know you also shoot landscapes, music 

and weddings – do the lenses keep up with you?

Absolutely, the XF lenses are super-well made and 

work amazingly well. In fact, I’ve never had a lens go 

wrong or need a service. The XF35mm is the first lens 

I used on the X-Pro1 and it’s pretty worn and well 

loved, but it still works perfectly. The fe fact that 

Fujifilm keeps updating and supportting the whole

ens range is magic too. The XF35mm im is actually 

better today than when it was brand nd new, and 

the XF60mm f/2.4 is a real hidden gem om of a lens.

I consider the XF16-55mm f/2.8 and Xd XF50-140mm

f/2.8 to be the backbone of the systemm, with the 

XF35mm and XF56mm my creative go--tos.

n We’ve heard about the benefits of Ff Fujifilm

over DSLRs – do you notice these?

I always say a camera is just a tool, to me te the real 

benefit is that I enjoy using the camera on a dn a daily 

basis. It may sound cheesy or odd, but Fuujifilm gave 

the joy of photography back to me, everythhing as 

a package works and I can have fun while we working.

n You can see more of Dave’s amazing 

work at www.davekaipiper.com

Above Three 

examples of 

Dave’s ever-

changing 

subjects, which 

he attributes to 

keeping his 

passion for 

photography 

burning.

LEARN MORE ABOUT FUJIFILM

We hope you’ve enjoyed reading about the 

benefits of the amazing X Series camera 

range and Fujinon glass. If you’re thinking 

about trading to a more compact, creative 

and aesthetically stunning camera system, 

check out fujifilm-x.com for more details.

Discover Fujifilm X Series
A DV E R T I S I N G F E AT U R E
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The spark of new life brings a rush 

of infectious joy to any family, 

irrevocably changing the lives of the 

parents-to-be. This fleeting time is 

one they’ll cherish, so help them 

remember it by capturing each 

special moment with your camera. 

Follow their child’s unique journey 

into the world with stunning 

maternity portraits, breathtakingly 

beautiful images of their newborn 

baby and photos that capture the 

boisterous fun of the first birthday. 

COM PLETE GU IDE

MATERNITY 

AND BABY 

PHOTOGRAPHY

FIRST 
STEPS
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PROJECT 1

Capture the 
maternal glow

P60

PROJECT 2

Photograph a 
peaceful newborn

P62

PROJECT 3

Make a mess 
with your toddler

P64

Three heart-warming projects...



N
O MATTER 
whether it’s 
your subject’s 
first pregnancy 
or she’s had 
a child before, 

a maternity portrait is the 
perfect way to capture this 
incredible time in her life. As 
her photographer it’s your job 
to make her feel as at ease as 
possible, so take note of our 
top tips for shooting a 
beautiful pregnancy portrait.

Find your location
For a truly powerful image, 
why not venture into the great 
outdoors. Mirroring the life 
growing within your 
mum-to-be with the nature 
flourishing in our parks and 
woodlands is a fantastic way 

to add an editorial edge to 
your shots. While you may 
assume that the pretty flowers 
of spring is the best time to 
take advantage of nature, 
babies wait for no one. 
However, you can actually 
harness the power of this 
technique at any time of year. 
Even the dead of winter can 
be softened by introducing 
props such as soft knitted hats 
and scarves, paired with the 
muted tones of evergreen 
trees in the background. 

As with all photography, 
one of the most important 
things you need to keep in 
mind is light. While the UK’s 
weather can be optimistically 
described as ‘unpredictable’ at 
the best of times, the glow of 
golden hour is beautiful and 

flattering enough to chase. If 
the weather is looking dicey 
and your mum-to-be has 
a flexible schedule, then you 
may want to consider giving 
her a two-week window of 
when you’d like to shoot. All 
you need to do then is simply 
keep an eye on the weather 
each day and let her know as 
soon as you think it’s suitable. 
Use a golden hour app like 
PhotoPills (£9.99 on iTunes) 
to find out exactly when the 
sun starts setting. 

Ensure that both you and 
your subject are at your 
chosen location at least half 
an hour before golden hour 
begins. This will give you 
both plenty of opportunity to 
prepare yourselves for the 
shoot ahead.

Choose your settings
It’s vital to remember that this 
shoot is all about making your 
mum-to-be feel comfortable 
and beautiful in her newly 
changed body. A flattering 
focal length is essential, so 
step away from that 
wide-angle lens! While 
a 50mm would ordinarily be 
considered the go-to portrait 
lens, you may instead want to 
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Shoot a pregnancy portrait
TIP

USE A 

REFLECTOR

For the best results, 

photograph your subject in 

the shade with the sun 

behind her. Then use 

a reflector to bounce 

back light.  



go for something a bit 
narrower. A 70-200mm is not 
only perfect for compressing 
the curves of your subject, but 
it also means that you’ll have 
the opportunity to introduce 
some blurry foreground 
interest with grasses or 
meadow flowers. 

In terms of the camera 
settings, you’ll want to keep 
your aperture as open as 
possible. Make sure that you 
use a stop above the widest, as 
your very lowest aperture can 
be a little soft. Use aperture-
priority (A on Nikons and Av 
on Canons) to enable you to 
work efficiently and quickly 
and make the most of the light 
without having to worry 
about your exposure. 

If you think your images 

are coming out perhaps that 
little bit too light or dark, 
simply use exposure 
compensation to adjust your 
settings as you shoot. 

Use a studio

While natural outdoor 
portraits can produce 
amazing shots, if the weather 
simply isn’t playing ball and 
your mum-to-be’s schedule 
isn’t flexible, you can also 
create stunningly beautiful 
portraits in the studio. 

Try experimenting with 
minimalist low-key images to 
highlight the rounded curve 
of her pregnant belly. This 
deceptively simple technique 
can be implemented with just 
one light positioned to the 
back and side of your subject. 

Maternity & Baby
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  Ask the expert   

Heather Neilson  

Heather Neilson is a specialist family 

photographer based in West London, 

renowned for her naturally-lit portraiture. 

She’s passionate about creating beautiful 

images for future generations to enjoy. 

heatherneilson.com

How did you become a maternity and newborn 

photographer?

I think I’ve probably had a slightly unusual career path! I was 

a city lawyer for over a decade in London and the Cayman 

Islands. I’d always been creative and eventually I got to the 

stage where I decided to explore life outside the corporate 

world. I initially did an intensive photography course in the 

US, and then worked for a couple of different studios that 

specialised in family portraiture. In those sessions I was 

always drawn to photographing mothers and mums-to-be.

How would you describe your style, and how did it 

develop this way?

My style is full of soft, natural light, usually backlit. My 

signature look is outdoor portraits in nature, with light gently 

filtering through trees and golden grasses to give beautiful 

bokeh. I’m especially well-known for my use of sunlight. 

Although it’s more challenging than shooting on cloudy days, 

when light is more diffused, I much prefer the warmth and 

sparkling quality of sunshine. 

Why do you think so many women want

a maternity photoshoot?

I think women want to celebrate this 

momentous time in their lives. It’s both a 

record of their body changing shape 

and a beautiful way of marking a 

milestone in their life – their journey into 

motherhood. It freezes and captures a 

moment in time to be cherished in the 

years to come. 

What kit do you use?

My go-to lens is a 70-200mm 

f/2.8 on my Nikon D750. I love this lens 

for its compression and the way it 

flatters the curves of my pregnant 

clients. The D750 is amazing in low light 

and for finding focus, even in heavily backlit scenes. 

Above “Ask your 

subject to stand 

at a 45-degree 

angle with the 

hand nearest 

you placed 

under the belly 

for best results.”

Left Include 

siblings into 

your shots. 



A
FTER THE 
wonder of 
childbirth 
comes the 
time when 
new parents 

readjust to this new priority in 
their life. These first couple of 
weeks are a precious window 
of time in their child’s life that 
they’ll never get back, so it’s 
no wonder that newborn 
photography is such a popular 
and long-lasting genre.  

Select your props
If you flick through any baby 
photographer’s portfolio, 

you’re almost guaranteed to 
stumble across images of 
babies nestled in comfy, furry 
throws, or wrapped in cosy, 
knitted blankets. Not only 
does this have the advantage 
of helping the baby happily 
doze off during the shoot, but 
it also provides you with the 
perfect backdrop to capture 
your newborn portraits with. 

So what kind of props 
should you look for? As well as 
the standard blankets, throws 
and hats that are popular 
industry-wide, you can also 
experiment with more niche 
props, such as crowns, tutus 

or even wings. However, if 
you’re looking for something 
a little more unusual yet 
understated, why not invest in 
a couple of different vinyl 
‘hardwood’ floors, which are 
perfect for being able to 
quickly move around and 
easily clean. 

To find the perfect props 
for your needs, try visiting 
websites such as 
babypropshop.co.uk or 
beautifulphotoprops.com. 
Alternatively, you may want to 
scour ebay.co.uk or etsy.co.uk 
for independent businesses 
offering great deals.

Set up your camera
If you’re working with studio 
lights or flash, ensure that 
your shutter speed goes no 
higher than 1/125sec. If you go 
above this then you’ll risk the 
light banding across your shot 
from the flash. Make sure that 
you keep your ISO at 100 for 
maximum image quality. Use 
a wide aperture to gently blur 
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Capture newborn shots

Use textured materials 

with muted colours 

to draw attention to 

the newborn.

TIP

GET PARENTS 

INVOLVED

Don’t forget that these 

images will be treasured by 

the parents for years to 

come. Ask which props 

and backgrounds 

they’d prefer.



the background details and 
draw the viewer’s eyes 
towards the baby’s face. If you 
find your shot is too light or 
dark then just adjust the 
flash’s power.  

Go macro

Who hasn’t seen a newborn 
baby and marvelled at just 
how tiny their features are? 
Babies grow quickly. In fact, 
they develop so fast that the 
popular wisdom with 
newborn photography is that 
it should be done within two 
weeks of the delivery date. 
Before the parents know it, 

those adorable fingers and 
toes will be twice as big as 
they were when their bundle 
of joy was first born. To 
forever immortalise just how 
incredibly small those 
newborn features are, bring 
out a macro lens to capture 
the tiny details. Focus on their 
eyelashes, nose, lips, fingers, 
toes or belly button for 
beautiful close-ups. A macro 
lens will automatically give 
you a very shallow depth-of-
field, so make sure that you 
use any aperture narrower 
than around f/5.6 in order to 
capture the best results. 

Maternity & Baby
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  Ask the expert   

Sally Josko  

Sally Josko is an award-winning maternity, 

baby and child photographer. She 

specialises in capturing beautiful images 

of newborns, utilising her 14 years of 

experience as a qualified childcare worker.

sallyjosko.co.uk

How did you become a maternity 

and newborn photographer?

When I left school, photography was what I loved, and as 

a mum with two children to support it remained my weekend 

hobby. I undertook a career in childcare, working with babies 

and young children in a private nursery. After 13 years 

working in education and being fully qualified in childcare, 

I decided to do the two things I was passionate about, so 

I opened my studio specialising in newborn photography.

How do you arrange newborn shoots?

I ask my clients to book their session at around 20 

weeks of pregnancy and then provisionally arrange it on their 

due date. I only book in five newborns each month in order to 

ensure availability. As babies rarely stick to their due date, 

the session date is scheduled when they actually arrive. This 

is usually within 10 days of birth, as this allows me to create 

the natural curly, sleepy poses easier. However, sometimes 

the babies or mums need extra care after birth, in which case 

the session will take place when both are well enough. 

How do you handle the baby and 

the parents during the shoot?

A few weeks before the baby is due I send 

out a welcome guide to parents, helping 

to prepare them for what to expect at their 

shoot. When they arrive for the session the 

room is very warm and there’s a white noise 

machine playing. This helps to keep the baby 

sleepy and calm. The mum will feed the baby, as 

this will also help them settle into a deeper sleep. 

Baby safety is of utmost importance. I’m a first 

aider, fully insured and trained to safely handle 

newborns. Once I’ve soothed them to sleep, I 

start my session by posing them on a huge, 

custom made beanbag. I then gradually 

move the baby into different positions for 

variety. I always prefer to pose the baby in 

ways that they’d do themselves for safety. 

Above “If parents want photos with their newborn I’ll do this before 

the solo shots, as this gives them the chance to relax after.”  

Set up your lighting
For her newborn shoots, Sally uses Bowens Gemini lights 

paired with a 50-inch softbox. “I only use one light for my 

newborn sessions, which is placed to my left and 

feathered at a 90° angle so that the light falls down on the 

baby’s face. For my parent poses I use the same 

technique, as I like to incorporate shadow into my shot. 

For backlit photos I’ll usually place the parents and their 

newborn between the softbox and the camera.”

Flash and  

softbox 

at 90º

Photographer

Baby 

sleeping on 

beanbag



W
HILE 
each 
baby 
develops 
in their 
own 

unique way, by the time their 
first birthday rolls around, 
their own personalities are
really starting to blossom. The 
welcome development of their 
communication skills can be 
perfectly captured with 
a cake smash shoot.

Get a cake
Other than 
your subject, 
the most 
essential 
ingredient 
for this shoot 
will be your 
cake. While it’s 
more than possible 
to source one from a 
supermarket, pro cake smash 
photographer Roxy van 
Staden takes a different 
approach: “I have a very 

talented lady who bakes my 
clients’ cakes. Not only does 
this mean they complement 
the set, but freshly made 
cakes also create a lot more 
mess than supermarket-
bought ones.” 

No matter where you 
source the cake from, there 
are a couple of rules you 
should stick to. Firstly, ensure 
that you use buttercream 

rather than fondant icing. 
This is because 

buttercream is 
much softer and 

easier to 
manipulate, 
unlike 
fondant icing, 
which is not 

only harder for 
the baby to play 

with, but can also 
present a choking 

hazard. Secondly, try to 
steer clear of chocolate cakes 
or red icing, as these can start 
to look a bit unfortunate once 
all mashed up! Pick pastel 

yellows, pinks and blues for 
the best effect (but be aware 
that blue is particularly 
known for staining clothes).

Engage the baby
It’s fairly safe to say that if 
someone sat down a free cake 
on the table, most of us 

wouldn’t have any trouble 
digging in. However, if this is 
the baby’s first experience of 
cake, then you may need to 
give them encouragement. To 
avoid any tears, make sure you 
keep the shoot light and 
breezy so the baby doesn’t feel 
overwhelmed or stressed. 
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Above Make sure parents bring a spare change of clothes and arrive 

in something they don’t mind getting covered in cake. 

TIP

PREPARE 

BEFOREHAND

Babies have a limited 

attention span, so set 

everything up prior to 

their arrival to keep 

them happy.
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  Ask the expert   

Roxy van Staden  

Roxy van Staden is a newborn and child 

lifestyle photographer based in Gravesend, 

Kent. Her cake smash sessions have 

captured the delight of both parents 

and toddlers across the UK.  

roxieartphotography.co.uk

How did you hear about cake smash photography and 

why did you incorporate it into your business?

The first time I ever saw a cake smash image was on 

Facebook in 2011. I never dreamed that it would someday be 

a part of the business that I set up in 2013, but by early 2014 

I was busy photographing babies making a mess. It’s always 

a fun experience, from the creative process of setting up the 

shoot, to the complete destruction at the end. Babies love 

exploring and this lets them experiment with different tastes 

and textures at their own pace.

Why do you think parents book a cake smash shoot?

Parents love to see the glee on their children’s faces 

when they discover something amazing. A cake smash and 

splash session is a commemoration of their first year. It’s 

a lot of fun for parents too, but most importantly it’s literally 

a once in a lifetime occasion. One day, when the kids are 

older, they’ll have beautiful images to show just how 

memorable their first birthday was. 

How do you handle the child during the shoot?

My sessions are entirely baby-led, as happy babies are 

the most important aspect of the shoot. With the ones that 

come in after their first birthday they’ve most likely had 

cake already. However, for those that have not yet 

had their first bite, a big cake can be quite daunting 

and sometimes they don’t know what it is. With 

these cake novices, they may need a little extra 

encouragement, so we sometimes have to get the 

parents involved and get messy with them to 

show that it’s okay. 

What kit and lighting do you use?

I shoot with a Canon 5D Mk III and 

a 50mm lens, which gives me 

wonderfully sharp portraits. I have a big 

window that lets plenty of natural light 

into my home studio, so I usually steer 

clear of professional lights. 

Clean up afterwards
After the messy fun of the cake smash, Roxy offers an 

additional bubble bath shoot. “Baby wipes are great, but 

sometimes they just don’t do the job. With the splash 

shoot I offer, it’s nice for mum and dad to leave the studio 

with a fresh and clean-smelling baby that will most likely 

fall asleep in the car on the way home. The babies are 

encouraged to splash as much as they want, creating lots 

of smiles and funny expressions. This creates amazing 

images for the parents to share with family and friends.” 

Above Babies can get thirsty with the amount of sugar they’ll 

have licked off their fingers, so have some water to hand. 
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Learn exciting new editing techniques  
from the UK’s best digital experts...

68
Fake the HDR look
Use the power of RAW files to boost 

the dynamic range of images in Lightroom.

72 Add seasonal elements
Kirk Schwarz reveals how to create 

an autumnal wonderland using Layers.   

76
Banish blur in Photoshop
Make blur a thing of the past with our 

three ingeniously quick and easy tutorials.

80
Correct colour casts
Fix colours and exposure problems 

in the second part of our landscapes series. 

86
Make abstract light orbs
Carry on shooting after the sun has 

gone down with our light-painting project.

92
Photo fixer
PP’s pro image editor Dan Mold 

retouches a selection of reader pictures. 

96
Claim your free software!
Download and get started with your 

free copy of DxO’s OpticsPro 11 Essential.

98
Photoshop hacks
Three quick tips that’ll change 

the way you edit your shots forever.

82 CREATE STRIKING  
DOUBLE EXPOSURES
Merge multiple images for extra impact

NOW INCORPORATING

EASY PHOTOSHOP ADVICE 

THAT REALLY WORKS

PHOTOSHOP
GENIUS... PP’s Photoshop editor, 

Dan Mold, is an Adobe 

Certified Associate.

EXTRA PAGES  

OF THE BEST 

TUTORIALS FOR 

ALL LEVELS

32

WATCH OUR 
PHOTOSHOP 
TUTORIALS  

Every issue features 

additional multimedia 

content that includes 

Photoshop video lessons 

to complement our expert 

step-by-steps. When you 

see this icon on the page 

you’ll find extra content on 

your disc/download. See 

page 6 for full details. 
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Apply a gritty faux  
HDR effect to your 
portraits in Lightroom. 
Dan Mold reveals how 

you can achieve this effect with 
your RAW files. 

Y
OU’D BE HARD 
pushed to find a 
photographic genre 

as opinion-dividing as HDR. The 
acronym, standing for High 
Dynamic Range image, is the 
subject of much controversy – some 
photographers loathe it, while others 
simply can’t get enough. Many people 
associate HDR images with picture bracketing, where 
several exposures of an identical composition are merged 
together, often producing an over-processed, gaudy style. 
But there’s no clear line drawn in the sand that marks 
what a HDR is. In fact, just by boosting the shadows in 
Lightroom, you’re expanding the dynamic range of that 
image. Love it or loathe it, we’re going to show you how 
to fake the distinctive look in Lightroom with just a 
single RAW file. This is a great idea if you love the look 
but it’s physically impossible to shoot a bracket of a 
moving subject, making it ideal to try on portraits. 

More detail from RAW

RAW files contain extra exposure information, so there’s 
much more you can do to them when editing back at your 
computer. This RAW file is 30MB in size, while the JPEG 
from the same camera was just 10MB. So while the RAW 
takes up a bit more space on your memory card and hard 
drive, it’s well worth shooting in this format because this 
additional data lets you change shooting parameters,  
such as exposure, in post-processing, and this is how 
we’ll be creating the HDR look with a single RAW image.
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Above The portrait is perfectly sharp, and we used an 

aperture of f/16 to create a strong depth-of-field. Despite 

using flash to side-light the model, the RAW file still looks 

quite flat and lacks contrast. 

Left This male portrait is perfect for our fake HDR effect 

in Lightroom. There’s loads of details to work up, and we 

can make the lighting more dynamic, too.

WHAT 

YOU NEED

n Photoshop  

Lightroom 6 or CC

n A RAW you’d like to 

apply a gritty faux 

HDR look to

Give your

HDR look in
Lightroom

// LIGHTROOM // VIDEO TUTORIAL
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1
Import your image, apply a crop and fix lens distortion
Open up Lightroom and head over to the Library module. Click the Import 

button, or go to File>Import Photos and Video, then use the Source panel 

on the left to find the folder where your image is stored. Make sure the shot you want 

to import has a tick next to it and then hit Import to bring it into Lightroom. Now head 

over to the Develop module and click on the Lens Corrections panel on the right. 

Click the box that says Enable Profile Corrections to remove lens distortions such 

as vignetting. In the Basic panel, adjust the Exposure until the overall brightness 

of your shot looks good, and use the Crop Tool if you’d like to crop your shot.

The Lightroom workflow 

operates in an entirely 

different way to Photoshop 

so can seem daunting to 

get to grips with. But you’ll 

soon familiarise yourself 

with the layout when 

you’ve made a couple of 

RAW conversions. Here’s 

what you need to know 

about the Develop tab, 

which is where you make 

your edits...

Lightroom 
interface 
explained

 Modules 

The most useful modules 

are the Library, where 

you can import your 

pictures, and Develop, 

which lets you process 

your RAW files. The Print 

module is also handy if 

you want to print directly 

from Lightroom.

 Adjustments 

The Adjustments are all 

collapsible panels. Click on 

them to expand and they 

will reveal the sliders and 

controls within. These 

contain powerful editing 

options, from Exposure to 

Sharpening, and Noise 

Reduction to Split Toning.

 Toolbar 

For more precise adjustments, 

there’s a handful of tools found 

under the histogram. Here you 

can apply a crop, remove 

spots, correct red eye, add 

graduated and radial filters 

and adjust specific areas of 

your pictures using the 

Adjustment Brush Tool.

 Filmstrip 

The Filmstrip sits at the bottom of the 

interface and lists the images from 

your latest import. This makes it easy 

to flick through the images in your 

current import. You can star rate your 

shots with number keys 0-5, and 

using the Filter you can reduce the 

images shown in the Filmstrip to just 

the ones you want to work on.

Above One of the first things to do 

when you’ve imported your shot is 

to crop and fix any lens distortion.
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2
Expand your dynamic range
Head back over to the Basic panel. Here, increase the  

Contrast to +25 and Clarity to +90 to make the image 

instantly more gritty. Now expand the dynamic range of your 

shot by pushing the Shadows and Whites sliders to the right 

and pulling the Highlights and Blacks sliders to the left. 

To make sure you don’t burn out your tones, hold down the  

Alt key as you drag these sliders, and when you can see the 

clipping mask (blue for Shadows and Blacks, red for Highlights 

and Whites) you know that’s when to set the slider down and 

not push it any further.

3
Make your 
details pop
Head over to the 

Detail panel on the right and 

set the Sharpening slider to 

a high value of at least 50. 

Now hold the Alt key and 

drag the Masking slider until only the parts of the shot that you 

want to sharpen are shown in white. This means that you won’t 

be sharpening the background or digital noise in your shot. 

Then increase the Noise Reduction to 15, or higher for shots 

taken at really high ISO values. Now go to the Effects panel, 

push the Dehaze slider up to a value of +10 to add a little extra 

bite and, to make the shot even more gritty, push the Grain 

Amount up until you’re happy with the effect. We set this slider 

to a value of 30 for our portrait.

4
Take total control of your exposure
There may be some parts of your image that you’d like 

to be darker or brighter, but can’t achieve it without 

affecting the whole shot. Lightroom’s Adjustment Brush Tool is 

great for painting over the specific areas you want to tweak. 

Click it to make it active, then set the Color to a bright red so  

it’s easy to see the areas you’ve painted over and choose a 

Feather of 100 to make your adjustments look soft and natural. 

Brush over the area you want to darken or lighten and, with the 

area brushed over, set the Color back to white at the bottom  

of the Color Picker. Now you can make your adjustments by 

dragging the various sliders – note that these will only affect the 

area you’ve painted on. You can erase and add to your brushed 

area, or click on the New button to paint in a new area with 

completely different settings. 

5
Convert to mono and export your shot
Go mono by dragging the Saturation slider to -100 

in the Basic panel. Then tweak the White Balance 

and Tint sliders until the contrast looks good. Now go to 

File>Export, choose the location you want to save to, set the 

Image Quality to 100 and hit Export to save your shot. 

GENIUS Right-click on your Adjustment 
Brush pins to easily duplicate, delete or 

reset the adjustments you’ve made

// LIGHTROOM // VIDEO TUTORIAL
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WHAT  

YOU NEED

n Photoshop Elements

n A warm, autumnal 

portrait with plenty of 

space and central 

interest

72 PRACTICAL PHOTOGRAPHY

1
Import your leaves
With your image open, add your 

first leaf image using File>Open. 

After it’s opened in a new window, use 

the Magic Wand, with a Tolerance of 50 

and making sure the Contiguous box is 

unchecked (this means it will select anywhere 

on the image with the same colour, without 

having to click multiple times), and click on the white 

part of the image to select it (if you need to select 

more areas, hold Shift and click to add them to your 

selection). Once you see your marching ants, press 

Ctrl+Shift+I for the inverse selection and then right 

click and select Copy before closing this image. 

On your main image, right click and select Paste to 

add this leaf. Repeat this step with as many leaves 

as you need, adding different shapes and sizes.

A UTUMN IS PERHAPS THE 
most photogenic season for
many of us. The leaves are 

turning from deep greens to vibrant reds, 
and the tonal palette is natural, warm 
and welcoming. You only have to go out 
for a walk in the country to see the trees 
furiously shedding their summer coats 
for another year. Sadly, leaves rarely fall 
perfectly when you’re pointing a camera 
at them, which is why, this month, we’re 
taking a look at faking falling leaves, a 
really simple technique that will interject 
a magical sense of movement and add 
depth to any image. 

All you need is a shot with a strong 
subject, plenty of space and a few leaves, 
which you can grab from the floor (which 
you then need to shoot against a piece 
of white paper, making cutting them 
out in Photoshop a real cinch). Once 
you’ve mastered this technique, you can 
add falling leaves to any image taken 
at any time of year, meaning you don’t 
have to stop having autumnal fun just 
because the trees are bare. You can also 
apply this tutorial to any falling objects. 
Whether it’s blossom in the spring, or 
comedy grand pianos in the summer, 
this simple technique has you covered. 

Just add fallen 
autumnal leaves 

Above It’s a 

nice autumnal 

scene with 

warm tones,  

but there’s a lot 

of dead space.

Left We shot 

these autumn 

leaves against 

white paper, 

making them 

easy to cut out 

and paste.

Kirk Schwarz shows you how  
to add a sense of wonder and 
movement to your seasonal 
portraits in five easy steps.

BEFORE 1

BEFORE 2
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2
Shape as required
Now you have your leaves in place, twist 

them to make each one look different. 

Using Image>Transform>Free Transform (Ctrl+T) 

you can drag the box to change the size, or hold 

your icon just outside of the box to twist it – this 

allows you to make each leaf look different, 

even if they’re the same as others. Don’t forget 

to click on the tick when you’ve finished. If you 

look like you’re running short on leaves, you can 

Duplicate the leaf’s Layer with Ctrl+J, and use 

this technique to make as many leaves as you 

like and resize them individually. You want a good 

smattering, but don’t place them over the main 

area of interest. You can see I’ve left the model’s 

face unobstructed, which draws the viewer’s eye 

to the area you want to have the most impact.

// PHOTOSHOP & ELEMENTS // VIDEO ON THE DISC



Beautiful, contemporary frames to preserve your precious 

memories, with over 95 stylish frame colours and profiles, 

28 window mount colours and easy online ordering. Plus 

every framed print is guaranteed for 5 years!

WWW.ONEVISIONIMAGING.COM | 0845 862 0217

The Ultimate 
in online framing

A framed photo is not 

just for Christmas…

 Prices from 

£11

36
NEW Frame
Mouldings
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5
Add some background
You’ve just added a foreground and a midground, 

but you still need a subtle background to create the 

illusion of depth. Simply duplicate the Layer with our main leaves 

on (Ctrl+J), making sure you drag this Layer below your other 

leaf Layers, and shrink it with Edit>Transform>Free Transform, 

drag the corner until it’s about a quarter the size of our main 

leaves. Now you can move it into place, using the Eraser Tool 

(E) to delete any leaves that are over your model (they should 

appear as though they’re behind everything else). Once 

you’re happy with the placement, go to Filter>Blur>Gaussian 

Blur and set it to about 25px so they’re very blurred. Try Blur

lowering the Opacity to around 70% if they look too strong.

6
Paint in some autumn colour
Now you’re happy with your leaves, it’s time to add 

some rich colour to the image. Taking the Brush 

Tool (B), click on the Foreground Color icon and select a nice 

deep ochre or autumnal orange. Now, create a New Layer and, 

making sure the brush is large and soft, paint onto it over the 

foreground and wherever your leaves are. It may look a bit odd, 

but you’ll take care of that in a second, so don’t worry. Once 

you’re happy, go to the Blending Mode drop down-menu at the 

top of the Layers tab and select Soft Light. If the colour looks 

too rich, simply lower the Opacity to about 40%, or whatever 

suits your image – don’t forget you can create a Layer Mask 

and paint with a black Brush Tool if you need to hide an area. 

3
Create some depth
To make this natural, you 

want to give the illusion that 

some leaves are closer than others. 

Grab any leaf and duplicate its Layer 

(Ctrl+J), then make it large with 

Image>Transform>Free Transform.  

It doesn’t matter if the quality is poor. 

Now it’s large, you want to put it near 

the edge of the image, I’ve selected 

three corners – we’ve even cut half the leaves off with the image 

border to make it more natural. Once these are in place, you 

want to blur them to replicate the image’s depth-of-field. Select 

all foreground Layers (click them while holding Ctrl), right click 

and select Merge Layers. Now go to Filter>Blur>Gaussian 

Blur and select around 50px until you just lose the edges.Blur

4
Inject a sense motion
Our leaves are falling, so you want to inject a sense 

of movement. To do that, select all the remaining 

leaf Layers (click while holding Ctrl), right click and select 

Merge Layers – this will place the selected leaves onto one 

Layer. Now go to Filter>Blur>Motion Blur and set it to around  Blur

40px – just enough to give them a sense of movement, but 

not enough to give them blur trails. They’re only falling gently! 

Now use the circle with a line in it next to the Angle box and 

drag the line around until it’s pointing top to bottom – this 

tells Photoshop which way the leaf should be in motion. Now 

you should see a bit of movement, but don’t be afraid to add 

another motion blur to hammer home the effect if needed.

// PHOTOSHOP & ELEMENTS // VIDEO ON THE DISC



T
HERE’S NO DOUBTING 
the creative merits of blur. 
A shallow depth-of-field is 

a great way of using out-of-focus areas 
to draw the viewer’s eye towards 
a particular point in your image. But
finding out your image is covered in 
camera shake or, worse, completely 
out-of-focus back at your computer has 
to be one of the most disheartening 
moments that us photographers come up 
against. When shooting fast-paced action 
like wildlife, or weddings, it’s all too easy 
to take the shot without double-checking 
its sharpness. 

So this month 
we’ve come up with 
a trio of ingenious 
solutions to fix three types 
of blur – camera shake, the 
image-softening blur caused by tiny 
vibrations when shooting handheld 
with slow shutter speeds; motion blur 
in panning shots, where the subject is 
moving; and, kicking off with, a great 
fix for out-of-focus images. The model 
in our image is a little soft, but a high-
contrast black & white conversion is 
a fantastic way of  increasing apparent 
sharpness and saving it from the trash.

Follow Dan Mold’s tips to 
banish motion blur and camera 
shake, and inject sharpness 
into out-of-focus images.
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Ways to reduce 
blur in images3

Left This portrait 

was shot with 

a wide aperture of 

f/2.8 and the focus 

is slightly off, so 

the facial features 

look a little soft.

Right By adding 

contrast and 

converting to black 

& white we’ve 

created the illusion 

that the image is 

marginally sharper. 

1
Convert to black & white
Open up an image that is 

slightly out-of-focus (this 

technique can’t bring back a totally blurry 

one) and then hit Ctrl+Shift+U or go to 

Image>Adjustments>Desaturate to remove 

any colour from the shot. We do this because 

monochrome images can take a much 

higher level of contrast, and this will help 

create the illusion that the image is in sharp 

focus. We’ll add contrast in the next step.

BEFORE

1 Go mono to 
fix soft focus
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WHAT 

YOU NEED

n Photoshop CC

n An image with a small 

amount of blur that 

you’d like to subdue 

or remove
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BEFORE

2
Add contrast with an ‘S’ curve
There are many ways to increase contrast 

in Photoshop, but Curves is an easy 

way of giving your shot some real punch. To do 

this, go to your Layers panel (Window>Layers) 

and click on the Create new fill or adjustment 

layer icon, then choose Curves from the list that 

appears. In the Curves panel you need to create 

an ‘S’ shape (see right) by clicking and dragging 

the diagonal line in two points equally apart. The 

four horizontal bars show the tones in your picture 

going from shadows to highlights (left to right). By 

pushing the brighter tones up and pulling the darker 

tones down you’re increasing the contrast, giving 

the image a high-key look. When you’re done, 

go to Layer>Flatten Image and then File>Save 

As to save your shot under a new filename.

// PHOTOSHOP & ELEMENTS

AFTER
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1 Reduction

Open your shot  

into Photoshop CC and go  

to Filter>Sharpen>Shake 

Reduction. The Shake Reduction filter will automatically draw 

an Estimation Region around an area of your image which it 

deems to be blurry. Usually, it does a pretty good job of 

detecting the blur, but it’s best to refine this by dragging the 

box it creates over the specific area that you want to fix. This 

was the camera and the model’s face in this shot, so we 

resized the original box to cover the camera, and drew a new 

one over her eye. Make sure the Advanced panel is expanded 

and that each Estimation Region is ticked.

2 Use Shake 

Reduction to 

banish blur
A SLOW SHUTTER SPEED CAN PICK 
up tiny vibrations when you’re holding 
your camera, causing camera shake. 
This can be disheartening when 
you believe you’ve got a fantastic 
shot on your memory card, only to 
realise it’s blurry when you get back 
to your computer screen. Up until 
recently, you’d have to make do with 
the shot or convert to black & white, 
like on the previous page. But the 
relatively new Shake Reduction filter 
in Photoshop can be used to sharpen 
shots if camera shake is present.

2
Fine-tune 

the sliders 

Now it’s time to 

fine-tune the Blur Trace 

Settings sliders to make 

the shake reduction as 

good as possible. Blur 

Trace Bounds determines 

how large the boundary of the blur trace is, so setting it higher 

allows Photoshop to create a larger blur trace and potentially 

create a sharper image. Generally a value between 30-60px 

works well here. Make sure Artifact Suppression is ticked and 

set Source Noise to Auto. Now set the Smoothing and Artifact 

Suppression sliders to around 20-30% to blur some of the 

harsh, unnatural sharpening that this filter tends to apply. 

When you’re done, click OK and save your shot under a new 

filename with File>Save As.
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2
Refine the sharpening area
There might be parts of your image that you’d 

rather remained blurred, such as an out-of-focus 

background. To control which parts are sharpened go to the 

Layers panel and click on the Add Layer Mask icon. The 

original, blurred Background Layer is still intact at the bottom 

of the Layers stack. Hit Ctrl+I to invert the Layer Mask to black, 

revealing the Background Layer. Now use a soft Brush Tool 

with a white foreground colour to paint over the areas you want 

to sharpen. When you’re done, go to File>Save As and save 

your new, sharp shot under a new filename. 

3 Sharpen moving subjects
AS THE NAME SUGGESTS, SUBJECT MOVEMENT IS 
caused when a subject moves through your frame during the time 
your shutter is open. In this shot, there’s both subject movement 
and a little camera shake, as the pan was shot hand-held. But 
Photoshop’s Smart Sharpen filter lets you dial in the angle of the
blur to effectively reduce it in your shots. Here’s how...

1
Sharpen the smart way
Open your shot into Photoshop and hit Ctrl+J to 

duplicate your Background Layer, then head up to 

Filter>Sharpen>Smart Sharpen. This is a really useful method 

of reducing subject blur because you can set Remove to Motion 

Blur and then enter an 

angle of your choice to 

match the direction of 

the blur in your shot (-15° 

in our shot). Now push 

up Amount to 200% to 

see a noticeable 

difference, Radius of 7px 

and then set Reduce 

Noise to 20px. When 

you’re done, hit OK to 

apply your changes.
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NEW  

SERIES! 

LANDSCAPE 

SKILLS

PART 2/6
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OLOUR CAN MAKE OR 
break a landscape image. 
And no matter how fiery a 

sunset, or rich a blue sky, your image is 
sure to look odd if the white balance isn’t 
exactly spot-on. This trap is all too easy 
to fall into, though thankfully it’s an easy 
problem to rectify, and one that makes a 
huge difference. Exposure is another 
area you’ll want to take some time to 
finesse, particularly with sunset and 
sunrise landscapes. Here, you’ll want to 
underexpose these types of images to 
help the warm yellow and orange tones 
come through. But if you haven’t 
underexposed in-camera, fear not. It 
takes just a few clicks to get the same 
result using Photoshop or Elements. 
Finally, we’ll show you how to increase 
contrast to give your shots a little more 
punch. So get stuck in and watch the 
accompanying video.

Fix colour & exposure 
issues the easy way

Above & right The colour temperature in 

this shot is a little cool and it’s slightly 

overexposed. Bringing the exposure down, 

and fixing the white balance, helps the 

golden glow of the sunrise shine through.

Apply a professional look to your landscapes  
by fixing colour casts and exposure problems.  
Dan Mold shows you how in three easy steps.

BEFORE

AFTER

WHAT 

YOU NEED

n Photoshop or 

Elements

n An image that needs 

a white balance and 

exposure fix.



1
Correct the exposure
Open your shot into Photoshop or Elements and 

hit Ctrl+L to bring up the Levels panel. Under the 

Levels histogram there are three sliders – Blacks on the left, 

Whites on the right and Midtones in the middle. To adjust 

the exposure, simply drag the Midtones slider to the right to 

darken it, or to the left to make it brighter. This is great if your 

exposure is off by 1 or 2 stops, but won’t be able to bring 

back details if your exposure is off by too much. We dragged 

the midtones to 0.60 to darken the shot and restore details in 

the sky. When you’re done, hit OK to apply the adjustment.
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2
Warm up the white balance
If you shoot RAW, then the best way to correct 

the white balance is with the Temperature slider 

in Adobe Camera Raw or Lightroom. But if your image is a 

JPEG, like ours, you won’t be able to do this. Instead, to make 

your shot look cooler, or warmer, go to your Layers panel 

(Window>Layers) and click on the Create New Adjustment 

Layer icon. From the list that appears, choose Solid Color. If 

your shot is slightly too cool, set the colour to a bright orange 

such as R:255, G:200, B:0. If your shot is a touch too warm, 

set it to a blue like R:0, G:150, 

B:255. Hit OK when you’re 

done and then change the 

Blending Mode from Normal 

to Soft Light. If the effect is 

too strong, drop the Layer 

Opacity down a little until the 

white balance looks just right.

Converging lines are a crucial 

part of guiding the viewer’s 

eye through your landscape 

image. So next month we take 

a look at Photoshop’s powerful 

Perspective Warp feature, 

which is brilliant for correcting 

perspective distortion in your 

landscapes and architectural 

city shots. 

NEXT MONTH

CHANGE YOUR 

PERSPECTIVE
3

Add contrast
You now have two Layers, so 

before you continue, go to 

Layer>Flatten image to merge them together. 

Now go over to the Toolbox and grab the 

Dodge Tool. This tool can be used to specifically brighten the Shadows, Midtones or 

Highlights within your shot. The highlights look quite bright already in this image so we 

only set the Range to Shadows and Midtones. The Exposure was set to 3% to apply the

effect gradually, and the Brush was set to soft and round. Now paint over the dark parts 

of your shot, adjusting the Brush Size with the [ and ] keys. When you’ve brightened the

shadow and midtone areas, it’s time to darken the areas you want to. So grab the Burn 

Tool this time, again choosing a soft round Brush and an Exposure of 3%. Change the

Range to darken the tones you wish – this will help you work up the contrast in specifc 

areas. When you’re done, go to File>Save As to save your shot under a new filename.
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T HERE ARE FEW 
photographic genres as 
instantly recognisable 

as double exposures. These images, 
created by overlaying multiple 
scenes together, are extremely 
stylish and iconic, and are great fun 
to experiment with. Many digital 
cameras give you the option to 
shoot double exposures in-camera, 
just like you would with a film one, 
where the technique originated, 
but creating them this way doesn’t 
give any room for error if the two 
images don’t line up correctly, the 
exposure isn’t right, or you’d like to 
swap one of the images.

Instead, we recommend 
shooting your images separately 
and bringing them together in 
Photoshop. This takes a little more 
time to create the effect, but gives 
you the ultimate level of control 
over composition, choice of images, 
contrast and brightness. 

Portraits and landscapes work 
brilliantly in combination with 
each other, so we’ll show you how 
to cut out a portrait, blend in 
a landscape vista and tie the two 
together with a colour adjustment 
and some flying birds to finish it off. 
All that’s left is to read the tutorial 
below and get stuck in...

Above This portrait was shot with an aperture of f/8 

for a strong depth-of-field. Studio lighting was used, 

but could easily be recreated with window lighting.

Right We added a forest landscape and some birds to 

give the image a different feel and a dreamy narrative.
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Dan Mold explains how to merge 
two or more images together to 
make artistic double exposures.

Create surreal 
composite art

2
Create a colourful new backdrop
Colour is a crucial tool for making the composite look 

convincing and realistic, so we’ll start by adding a new 

colourful background of our choosing. Go to the Layers panel 

(Window>Layers) and click on the Background Layer. Now click 

on the Create new fill or adjustment layer icon and choose Solid 

Color from the list that appears. Here, you can drag the cursor in 

the Color Picker to set the luminance and saturation of the 

colour, then pull the slider to the right of the Color Picker to 

change its hue. We wanted to give our shot a warm, vintage 

yellow colour (R:255, G:255, R:220). When you’re happy with 

the colour you want to apply, hit OK to choose it.

1
Make a detailed selection
With your portrait in Photoshop, grab the Polygonal 

Lasso Tool from the Toolbox and then click all the 

way around the head and shoulders to select it. Hit Ctrl+Plus 

to zoom in if you can’t clearly see what you’re selecting and 

use the Hand Tool to move around the shot. When you’re done, 

you’ll see the marching ants displaying the selected area. Now 

go to Select>Select and Mask (Refine Edge in older versions of k

Photoshop). Here you can get a finer selection of the hair. Just 

set the Edge Detection Radius slider to 1px and tick Smart 

Radius, then click the Refine Edge Brush Tool and paint over 

the hair to add it to the selection. Finally, set Smooth to 7, 

Feather to 0.5px, Contrast to 15%, Shift Edge to -7% and set 

the Output To as New Layer with Layer Mask and hit OK.

BEFORE
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WHAT 

YOU NEED

n Photoshop CC 

or Elements

n A landscape, a 

portrait and some 

birds in flight

AFTER
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4
Work up the landscape Layer Mask
Click on the landscape Layer Mask, then choose 

a soft, round Brush Tool with the Flow set to 20%. 

Hit D followed by X for a black foreground colour and brush 

over the parts of the Layer that you don’t want to see. We 

painted over the face to reveal the portrait Layer below. You can 

also drop the Layer Opacity a little to reveal the Layer beneath 

it, or change the Blending Mode to get different results.

5
Add extra interest with flying birds
Open up a picture of a bird in flight then hit Ctrl+A to 

select it, Ctrl+C to copy it and Ctrl+V to paste it in. 

Change the Blending Mode of this Layer from Normal to Multiply. 

Now hit Ctrl+L to bring up the Levels panel and adjust the 

Blacks, Midtones and Highlights sliders until only the bird is

visible, and the sky can’t be seen. When you’re done, hit OK or 

the small cross to close down the Levels panel. You can resize 

the birds with Free Transform Mode (Ctrl+T) and reposition them, 

too – just hit Return when you’re done. You can repeat this step 

to add multiple birds like we did in our shot. At this point it can

be beneficial to go back to your portrait Layer Mask and paint 

over the top of the model’s head with a black Brush Tool to 

create space for the birds to fly into.

6
Apply the finishing touches
The last step is to add a final kick of colour and 

contrast. Click on the Color Fill Layer near the bottom 

of your Layers stack and hit Ctrl+J to duplicate it. Drag the 

new Color Fill Layer to the top of the Layers stack and change 

the Blending Mode to Soft Light to add a wash of your chosen 

colour. Now click the Create new fill or adjustment layer icon 

and choose Levels, then drag the Blacks and Whites sliders 

inwards a little to increase contrast, then move the Midtones 

slider until you like the general exposure of the shot. When 

you’re done, head up to File>Save As and save as a Photoshop 

PSD file to keep the Layers if you want to rework them at a later 

date. But if you’re happy with the result, save your shot as a 

JPEG to flatten the Layers and save space on your hard drive. 

3
Paste in your second image
Head up to File>Open and open the second shot 

you want to use in the double exposure effect – we 

used an autumnal landscape. You then need to hit Ctrl+A to 

select it, Ctrl+C to copy it and Ctrl+W to close it down. Now 

back in your portrait shot, hit Ctrl+V to paste it in and then drag 

it to the top of your Layers stack. Hit Ctrl+T to put it into Free 

Transform Mode then hold the Shift key and drag the corners 

of the bounding box out until your secondary image covers all 

of the portrait. Now, in the Layers panel, hold down the Shift 

key and drag the Layer Mask from your portrait Layer over to 

your new landscape Layer. This will copy the Layer Mask, so 

the shot only appears in the same part of the image as the 

portrait. Unlink the chain icon between the landscape Layer 

thumbnail and the Layer Mask. Now click on the Landscape 

Layer icon and resize or reposition with Free Transform Mode.

GENIUS Change the Blending Mode 
of your landscape Layer to instantly 

change the look of your image
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painterly eye and mastery of light, and Sergei Polunin’s astonishing  
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Create spectacular  
light paintings with  
just a torch, string  
and long exposure. 
 shows you how. 

8686 PRACTICAL PHOTOGRAPHYPRACTICAL PHOTOGRAPHY

Make light 
orbs shine 

Above This is a fantastic 

location, filled with gritty 

textures and powerful 

lead-in lines that take you 

through the frame.

Right We’ve brought the 

scene to life by stacking 

our light painting images 

together in Photoshop. 

This gives the shot a 

mysterious sci-fi feel.

T
HE EVENINGS HAVE WELL 
and truly drawn in, but don’t let the 
darkness or the colder weather stop 

your photographic pleasure. Now is the perfect 
time to get out and do some light painting pictures. 
Flashguns, torches, lamps and pretty much anything 
that emits a light or glows can be used to create amazing 
light painting images, just drag the light source through 
the frame to create ethereal streaks of light.

Light orbs follow this principle, but require a bit 
more preparation to achieve. A piece of string needs to 
be attached to your torch so that you can spin it around 
and create the spherical shape. They’re great fun to 
experiment with and not only will this technique expand 
your knowledge of low light shooting, by using your 
camera’s manual mode, you’ll get a cardio workout as 
you create your orbs, too. It’s sure to leave your friends 
mystified as to how you managed it, so read the tips 
over the page to see how you can get all of the shots 
in-camera and bring them together in Photoshop.

WHAT 

YOU NEED

n A DSLR or CSC

n A tripod, torch, flash 

gels and flashgun

n Photoshop or 

Elements

AFTER

BEFORE
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1 Light painting
Learn how to create eye-catching 

light orbs and use off-camera flash to add 

colour to your scene.  

2 Using long exposures
We show you how to master your 

camera’s manual mode to dial in custom 

shutter speeds for a long exposure.  

3 Merging images together
We explain every step taken to get 

this image, from getting all of the shots, to 

combining them in Photoshop to finish it.

3 skills you’ll learn
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Whether you want to shoot a lone light 
orb, or a whole mob of them, it’s best 
practice to create a single light painting per 
image. This makes it much cleaner and 
easier to merge your shots in Photoshop, 
which we’ll be doing over the page.

In addition to the standard creative 
camera and tripod you’ll need for any 
long exposure, you’re going to require 
a few inexpensive materials. The orb 
is produced by torchlight – to create 
it, tie some string to the end of a torch 
so that you can swing it around in 
a circular motion to create the light 

sphere. For the best light painting results 
it’s best to wear dark-coloured clothing. 
Wrap yourself up in a hat, scarf and gloves 
to make sure the torchlight doesn’t expose 
you when you’re taking the exposure.

An optional step is to use a flashgun 
with some coloured gels to lend an 
extra splash of colour and add to the 
eerie feel of the shot. You’ll be firing the 
flash manually off-camera so there’s 
no need for triggers. Just follow the 
step-by-step on the opposite page 
and turn over to see how you can 
bring it all together in Photoshop.

Shoot your light paintings

Above Powerful LED torches are affordable 

and ideal for this light orb technique.

 Dark clothing 

Your light painting will illuminate everything around the light 

source, including yourself. To prevent this from happening 

it’s best to dress like a ninja and wear black clothing.

 Torch 

Make sure your torch 

has a keyring loop at its 

base so that you can 

attach some string to it. 

This allows you to spin 

it around securely.

 Camera 

It’s essential to use 

a camera with a manual 

mode so you can dial 

in a long exposure and 

lock it off, so that it 

doesn’t change 

throughout your shots.

 Tripod 

To get sharp shots with long exposure photography, you’ll 

need to lock your camera off on a tripod to keep it rock-steady 

while your camera’s shutter is open.

Enlarge the light source
Make it easier for the camera to pick up 

the light from the torch by taping a ball 

of scrunched-up cling film to the end of 

it. To stop the plastic melting use an LED 

torch as these don’t get hot.

Spin around a central point
When you start spinning the torch to 

create an orb, spin it over the same 

point on the ground, such as a coin or 

stone, as you move your feet to direct 

the light in different circular motions.

Don’t block the light
Wear dark clothing so you don’t appear 

in shot and try not to stand between the 

torch and the camera as you spin – this 

will obstruct the light painting and leave 

parts of the orb incomplete.

Three top tips for better light orbs...

 Flashgun 

To add in an extra 

splash of colour, 

you can use 

a flashgun with 

a coloured gel 

over it to light up 

the surrounding 

location. If you 

don’t have any 

gels, coloured 

cellophane sweet 

wrappers will give 

you an almost 

identical effect.
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1
Set up your camera
Arrive at your location a little before

sunset and use a tripod to 

compose. This gives you time to focus 

and dial in the settings so that you 

can shoot in the blue hour (the hour 

just after sunset) for ethereal, magic 

lighting. Use a wide framing so that 

your light orb will be surrounded by 

the location and have some scale 

and context. Now put your camera into 

its manual mode, dial in an aperture of 

f/4, ISO of 100 and shutter speed of 30s

Lastly, set your camera to its 2sec self-timer mode.

2
Capture a ‘blank’ scene
Set your focus about a third of the way into the 

scene for a strong depth-of-field and switch to 

manual focus to lock it off. When the sun has set, press the 

shutter to take a test shot. If the scene is too bright, increase 

the aperture a little, or if it’s too dark, push the ISO up until the 

exposure looks well-balanced. Shooting in RAW, take a final 

‘blank’ image. This is what you’ll blend your ‘orb’ into later on.

4
Add extra orbs and light painting
To put extra light orbs in your scene you can press the 

shutter button again and repeat Step 3. Keep each 

exposure to just a single light orb to make it easier to merge the 

shots in Photoshop later on. To inject dynamic lighting and make 

the shot look even more eerie, you can start the exposure once 

more and manually fire a flashgun with a flash gel or coloured 

sweet wrapper over the front of it to add a wash of colour.

3
Shoot your first orb
Press the shutter again, this time walking into your 

scene and creating the orb where you want it to be 

(extend the self-timer if you need more time to get in position). 

When you hear the exposure start, spin the torch in a circular 

motion and move your feet so that each pass of the torch 

crosses the same point on the ground. When your exposure is 

done, check the image is sharp and well-exposed on the LCD.

n NON-SPHERICAL SHAPE  

Pick a point of reference on the floor 

that you will pass the torch over with 

each spin. This will help you create 

an orb with a spherical shape. 

n PARTIAL ORBS 

If you’re getting incomplete orbs it’s 

possible that as you moved around 

spinning the torch your body went in 

front of the camera, stopping the light from 

hitting the camera’s sensor. Your exposure might 

have also ended as you were in the middle of spinning 

the torch.

n EXPOSURE 

If the exposure is too bright, close the aperture a little, and 

if it’s too dark, increase the ISO. Be sure to shoot in the 

more forgiving RAW format so you have more exposure 

information to work with back at your computer.

 Pro advice How to fix  
 shooting problems 

// PHOTOSHOP & ELEMENTS // CREATIVE PROJECT
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2
Stack your images with Layers
On one of your light orb images hit Ctrl+A to 

select it, Ctrl+C to copy it and Ctrl+W to close it 

down, as you no longer need this picture open. Now go to 

your ‘blank’ image and hit Ctrl+V to paste the orb in. You 

then need to go to your Layers panel (Window>Layers) 

and change the Blending Mode from Normal to Lighten.

4
Make the orb more spherical
With the selection still active go to the Layers 

panel (Window>Layers) and click on the 

Add a mask icon. Now, grab the Brush Tool from the 

Toolbox, and choose a soft brush with a Hardness of 

0%. Hit D for a white foreground colour with an Opacity 

of 20%, then paint the light on the lit floor back in.

1
Batch process your RAWs
Find the ‘blank’ frame RAW image you shot in Step 

2 on the previous page, as well as any light orbs and 

flashlight painting you want to add in. Then open them into Adobe 

Camera Raw. Hit Ctrl+A to work on all of the RAWs at the same 

time and then apply your adjustments such as Exposure. When 

you’re done hit Open Images to bring them into Photoshop.

3
Select and mask the orb
On your orb Layer grab the Elliptical Marquee 

Tool from the Toolbox, then hold down Shift 

and draw a circular selection over the orb. To fine-tune 

the selection go to Select>Transform Selection, then 

drag the handles of the bounding box to get a neat 

selection around the orb. Hit Return when you’re done. 

Finish the effect
in Photoshop

Above Photoshop and Elements have all of the tools and functionality you 

need to batch process the RAW files and stack your Layers together.

Now that you’ve got all of the different 
parts of the light painting on your 
memory card you can breathe a sigh 
of relief. The hard work is over, and 
you can take your time to bring it all 
together using Photoshop or Elements. 
Below, we show you how to batch 
process the RAW files – this is key 
because the adjustments you make need 
to be consistent, so the end result looks 
convincing. Then you’ll find out how to stack the 
various exposures together using Layers and use 
Blending Modes to blend in the lightest parts of 
the light painting Layers. Here’s how...

TIP 

BLEND IN 

YOUR LAYERS

Change how your image 

looks by experimenting 

with the Layer Opacity 

and Blending Mode 

of each Layer.
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5
Add more orbs
At this point you’ll have a striking light orb in your 

scene that’s perfectly spherical. Now it’s time to build 

up the effect by adding in more orbs (optional). These should 

already be open in Photoshop, as you batch-processed the 

RAWs in Step 1. So use the same technique to copy and paste 

them into your shot and tidy each one up with a Layer Mask. 

6
Add in your dynamic flash lighting
Your flash image will already be open, so find it 

and hit Ctrl+A to select it, Ctrl+C to copy it and 

Ctrl+W to close it down. Back in your main shot hit Ctrl+V to 

paste it in and then click on the Add a mask icon. Hit Ctrl+I 

to invert the Layer Mask and then use a soft white Brush 

Tool to paint over the areas you want to add the lit area to.

8
Adjust the exposure to finish
When you’re happy with how the shot looks go 

to Layer>Flatten Image to merge them all into a 

single Layer. Finalise the exposure by hitting Ctrl+L to bring 

up the Levels panel and then drag the Midtones slider to get 

the overall exposure looking how you want it. Finally, go up 

to File>Save As and save the shot under a new filename.

7
Change up the colours
Hit Ctrl+U to bring up the Hue/Saturation panel, tick 

the Colorize box and drag the Hue slider to change 

the colour background Layer. Then click on a light orb Layer 

and do the same to add in some colour. Setting the background 

and orbs to complementary colours like blue and orange or 

red and green is a great way to give your shot extra contrast.

1 Images are blended seamlessly
You’ve used a tripod to make sure your 

separate exposures line up perfectly and batch-

processed the RAWs for a convincing, natural look.  

2 You’re not in the shot
Care has been taken to dress in dark clothing, 

as bright, reflective clothing will be illuminated by the 

torch as it spins, resulting in a blurry haze which pulls 

the eye away from the striking light painting.

3 Spherical shape
By spinning the torch around the same point 

on the ground, you’ve created a spherical light orb, 

which you’ve given a totally round shape using 

a Layer Mask in Photoshop. 

How to tell you’ve got the shot right...

2

1

3

// PHOTOSHOP & ELEMENTS // CREATIVE PROJECT
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Dan says: Tom’s 
determination to get 
this shot is nothing 
short of astounding 
– the image is 
truly breathtaking! 
Let’s start by 

looking at the composition – it’s been 
really well thought out, with the eye 
naturally falling towards the stone 
pagoda, and he’s positioned this a 
third of the way into the frame.

He’s nailed his camera settings, by 
shooting in manual mode to get the 
exposure exactly how he wanted it. The 
aperture of f/8 gives the scene a great 
level of sharpness and a strong depth-
of-field. By boosting the ISO to 320 he 
got a shutter speed of 1/200sec – fast 
enough to eliminate camera shake 
when shooting handheld at 18mm.

There’s a lot to like about this shot, 
and while Tom’s version is a cracker, 

he may want to consider some minimal 
tweaks to take it to the next level. He did 
the right thing by shooting in RAW, as 
these larger files contain extra exposure 
info. But we’d be tempted to give the 
exposure and white balance a slight
tweak to inject warmth (Photo Fix 1).

I’m in two minds about the mist at 
the top of the frame. It does do a great 
job of guiding the eye downwards 
towards the focal point. But after 
taking it away with the Dehaze slider 
in Photoshop (Photo Fix 2), more of 
the impressive vista is revealed in 
the image. I’m erring more towards 
the dehazed picture, as it helps the 
landscape take on a much warmer tone. 

Tom definitely has an eye for 
photography, and if he can shoot 
this at the age of just 19, we’re sure 
he’s going to go on to achieve great 
things. We look forward to hearing 
about his latest adventures soon.

Stone pagoda By Tom Smith

Stuck in an editing rut with your shots? Send them over  
to ppsubmissions@bauermedia.co.uk and our Photoshop 
experts will show you how to professionally retouch them.

Tom says: I’ve 

been shooting 

landscapes for 

six years and 

a recent trip to 

China provided 

me with some fantastic photo 

opportunities. To get the 

sunrise coming up behind the 

stone pagoda, two friends and 

I embarked on a physically 

draining, nine-hour hike to reach 

the East Peak of Mt Hua Shan. 

We started our ascent at 7pm, 

arriving at this viewpoint at 4am. 

A short nap was much needed! 

When we awoke, we were greeted 

with this stunning sunrise. 

In Lightroom, I applied some 

sharpening, and a graduated 

filter to darken the sky.

BEFORE

AFTER

PhotoFixer

Image white 

balance looks a 

little ‘cool’ for  

a sunrise.
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Nikon D7200 | 18mm | 1/200sec | f/8 | ISO 320

TIP 

SHOOT RAW

If you shoot in the RAW 

format, like Tom did with this 

shot, you have much more 

image data to play with in 

post-processing. In Lightroom 

or ACR you can tweak the 

exposure, white balance 

and much more.

Photo Fix Make your sunrise shots shinex

1
Lower your exposure
The warm golden tones of a  

sunset can easily be lost if your 

camera’s metering system overexposes 

the image. Luckily, if you shoot in the RAW 

format you can adjust the exposure to 

restore this lost detail. Just drag the 

Exposure or Highlights sliders to the left a 

little to stop details clipping to pure white.  

If the colour doesn’t look as warm as you 

remember it, drag the Temperature slider 

to the right to 

get the 

colours 

looking right. 

It’s worth 

increasing 

the Vibrance 

slider a little 

too, to make 

the colours 

stronger.

2
Cut through mist
Mist can wash out details in 

your shot. The Dehaze slider 

in ACR and Lightroom is really useful for 

not only removing haze and revealing 

details, but also to add it in. We dragged 

the Dehaze slider to a setting of +50 to 

reveal more of the detail in the amazing 

scenery surrounding the pagoda. 

  STANDARD EXPOSURE

  UNDER EXPOSED BY 1 STOP
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Frida
By Kenneth Caine

Kenneth says: I was shooting the 

opening of my friend Frida’s hair salon. 

I shot handheld, with an off-camera 

flash in my other hand. My wife 

bounced extra light in with a silver 

reflector. In Elements, I applied a slight 

crop, brightened Frida’s hair, and applied some cloning 

to the messy bottom left corner.

Dan says: Kenneth clearly 
knows what he’s doing when 
it comes to lighting – the
off-camera flash has given the 
shot a professional finish, 
beautifully accenting the 
model’s cheekbones and 
adding a sparkle to her lips.

There’s a lot going on 
in this image, and Frida’s 
hair is certainly stealing 
the show. Compositionally, 
it could be stronger if the 

subject’s face was larger in 
the frame with more active 
space in front of it – her head 
awkwardly butts up against 
the edge at the moment.

With the model larger in 
the frame, it’s worth cloning 
out the blue background in 
the bottom left corner (Photo 
Fix 2), and as we can see 
the skin in more detail, it’s 
worth smoothing the skin 
a little too (Photo Fix 1).

Pentax K-50 | 65mm | 1/125sec | f/22 | ISO 800

BEFORE

Photo Fix Clean-up and x
focus on the details 

1
Smooth out skin
Go to your Layers panel and hit Ctrl+J to 

duplicate your image. Now go up to 

Filter>Blur>Surface Blur, set the Radius to 3px and the 

Threshold to 15px then hit OK. Now click on the Add 

Layer Mask icon and hit Ctrl+I to invert it. Now, with a soft 

white Brush Tool, paint over the skin to smooth it out.

2
Clone out distractions
Open your shot and grab the Clone Stamp Tool 

from the Toolbox. Hold the Alt key and click on 

the area you 

want to 

sample. Now, 

set the Flow to 

20% to make it 

gradual and 

brush over the 

part you want 

to replace. 

More detailed 

information 

can be found 

on page 82.

AFTER

Model  

has no active 

space to look  

into.

The 

background  

is quite  

messy
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Photo Fix Increase appeal with just two editsx

1
Correct colours & exposure
Open your RAW file into Adobe Camera Raw 

and drag the Temperature slider until the 

image looks as cool or warm as you like it. We warmed 

this shot up a little to make it look more sunny, and lifted 

the Exposure slider too. This is a simple tweak that 

really brightens the image, making it more appealing.

2
Remove distractions
The rocks on the beach are a little distracting  

in this shot, so to turn it into a pristine shore, 

open up Photoshop and grab the Spot Healing Brush  

Tool from the Toolbox. Now hover your cursor over the 

distraction you want to remove and resize the brush with 

the [ and ] keys until the cursor is slightly bigger than the 

distraction. Now paint over it and Photoshop will remove 

it from the shot.

AFTER

Boracay 
boatman
By Wooi Lun Toh

Wooi says: I managed 

to snap this moment 

while on holiday in 

Boracay, Philippines. 

These folks start the 

day early, ferrying the 

tourists to go snorkelling and island 

hopping. This boatman provided a 

great photographic opportunity as he 

pushed the boat out.

Dan says: Wooi’s quick ‘snap’ hasn’t 
turned out bad at all. There’s a good 
sense of movement, it’s perfectly sharp 
and the sun is out in full force. That 
said, the colours in the image look 
a little dark and cool, and a simple 
adjustment to the Temperature and 
Exposure sliders in Adobe Camera Raw 
or Lightroom is an easy edit that would 
instantly add warmth (Photo Fix 1). 

Another quick edit you might want 
to consider is to remove the pebbles 
from the sand. This gives it a more 
pristine, picture-perfect, aesthetic and 
stops the viewer’s eye being pulled 
down to the bottom right corner. 

These two minor edits elevate Wooi’s 
good shot into a great one, and increase 
its appeal. We can see it happily sitting 
in the glossy pages of a travel brochure.

Nikon D3200 | 10mm | 1/640sec | f/8 | ISO 100

BEFORE

Colours are 

quite cool and 

exposure is  

a little dark

Rocks pull 

the eye away 

from the  

boat

AFTERBEFORE
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1
Get started with your free software
When you’ve installed DxO OpticsPro 11 Essential, open it 

and go into the Organize module then search through your 

hard drive using the panel on the left to find the image you want to 

work on – JPEG and RAW files are supported. DxO Noise Reduction 

is automatically applied to opened images, instantly giving your 

shots a cleaner aesthetic. The powerful Distortion and Chromatic 

Aberration corrections are also automatically applied, reducing barrel or 

pincushion distortion, and removing unsightly colourful fringes around 

areas of high contrast. The interface is customisable, and the panels 

can be moved. Each panel also adopts a fly-out menu that allows you 

to choose exactly which features you want to assign to the panels. 

In the filmstrip at the bottom you can change which image you want 

to work on by clicking the thumbnails, and to give your shot a new 

look instantly you can apply one of the many presets using the Apply 

Preset button in the top right corner or use the Preset Editor panel.

2
Add impact in a few clicks
Head over to the Customize module – this 

is where you can start to process your shot. 

The Move/Zoom panel is great for zooming in on 

details and the Exif panel is great for quickly checking 

the settings used to take the shot. To work up the 

shot, go over to the Essential Tools panel and click it 

to expand the options. We added a positive amount 

of +0.80 Exposure Compensation to brighten this 

landscape image, and set the White Balance to Cloudy 

for a slightly warmer tone. We increased the intensity 

of the DxO Smart Lighting to 80, which helps lift the 

shadow areas – its Spot Weighted mode can detect 

faces in the scene to make sure these are well exposed. 

Lastly, we set the Color Accentuation Vibrancy to 60 

and Saturation to 20 to really boost the colours.

W E’VE GOT A FANTASTIC 
offer for you this month, as 
we’ve teamed up with DxO 

to secure a free copy of its powerful 
DxO OpticsPro 11 Essential (worth £99) 
for every Practical Photography reader! hy
This comprehensive imaging software 
supports both JPEG and RAW file 
formats and makes it a breeze to improve 
the exposure, colours and sharpness of 
your images. Just open an image into 
DxO OpticsPro 11 and you’ll see an instant 
improvement, as it automatically dials in its powerful 
Noise Reduction and Distortion Correction, among other 
features, to instantly enhance your pictures.  

Below we cover how to get started using the OpticsPro 
interface, use presets to apply striking results in a single click, how 
to enhance colours using the Color Accentuation feature and correct 
the exposure with Exposure Compensation and DxO Smart Lighting. 
So download and start using your free software now!

Use your free DxO softwaree
Download a full version of 
DxO OpticsPro 11 Essential  
worth £99. Dan Mold runs 
through its key features.

WHAT  

YOU NEED

n A computer with the 

minimum required spec

n Internet access

n A RAW or JPEG 

photograph

n Microsoft Windows 

OS: Windows 7 Service 

Pack 1 and newer

Processor: Intel Core i5 

or higher

Graphics: 512MB

RAM: 2GB

Disc space: 4GB 

n Apple OS X

OS: 10.10 Yosemite 

and newer

Processor: Intel Core i5 

or higher

Graphics: 512MB

RAM: 2GB

Disc space: 4GB

System Requirements
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FREE SOFTWARE //  DxO OPTICSPRO 11 ESSENTIAL

HOW TO CLAIM

YOUR FREE DxO 

SOFTWARE

Above It’s a fantastic long exposure image from Glencoe, but 

the exposure is very dark and the colours look quite flat.

Above It takes just a few minutes to lift the exposure, expand the 

dynamic range and boost colours in DxO OpticsPro 11 Essential.

BEFORE AFTER

3
Expand your tonal range
Using the Selective Tone feature separates 

tones into four areas – Highlights, Midtones, 

Shadows and Blacks. You can use the sliders to control how 

bright these tones are, so dragging the Highlights slider to 

the left is great for reducing bright areas like clouds in our 

example shot. Boosting the Midtones and the Shadows, 

while pulling the Blacks to the left a little, is a great way to 

add contrast too. To give your shots even more punch go to 

Contrast, under the Light, panel and boost the Contrast – or 

push up Microcontrast to enhance finer details in textures. 

When you’re done, hit Export to disk to save your image and 

choose from a range of file formats (JPEG, TIFF, DNG etc).

CLAIM 
YOUR 

FREE DxO 
SOFTWARE 

WORTH 
£99!

Fill out the online form at:

www.dxo.com/

practicalphotography

before 22 November 2017 to 

receive your free download 

link and activation code for 

DxO OpticsPro 11 Essential. 

Visit dxo.com for full details of 

DxO’s extensive range of 

software, including FilmPack 

and ViewPoint. 
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The Graduated Filter Tool is really handy for applying broad 

adjustments to sections of your image. It’s most useful for 

editing the sky or foreground, and its hardness can be 

adjusted by dragging the lines around the adjustment pin 

when you’ve applied it. This helps you replicate the effect of a 

soft or hard filter. However, there are times when the filter may 

cover a part of the image you don’t want to affect – in this shot 

we just want to darken the sky, and not the horse’s head. 

Adobe recently changed the Graduated Filter Tool, meaning 

you can now remove or add to your graduated adjustment by 

clicking Brush. Here, you can click Erase and paint over any 

parts of your image that you don’t want to be affected.

One of the 

easiest ways to 

make a selection 

in Photoshop is 

to use a Quick 

Mask. Double-

click on the 

Quick Mask icon 

near the bottom 

of the Toolbox to 

bring up the 

Quick Mask 

Options. Change 

Color Indicates 

to Selected 

Areas and then 

change the 

Color to one that stands out against the colours in your shot. Hit 

OK then press D on the keyboard for a black foreground colour. 

You’re now in Quick Mask mode and you can use the Brush Tool 

to paint over any areas you want to select. When you’re happy 

with it, hit Q on the keyboard to turn it into a selection.

Get a finer level of control with 
the Graduated Filter Tool

Use clipping warnings to see 
where detail has been lost 

Make detailed selections quickly

A C R  /  L I G H T R O O M

Quick tips & keyboard shortcuts that’ll 
help you process your images faster!

Photoshop

A C R  /  L I G H T R O O M P H O T O S H O P

MORE  
EDITING 

VIDEOS ON 
YOUR FREE 

DISC!

At the top of your 

histogram in Lightroom 

or ACR, you’ll see two 

arrows. These are your 

Highlights and 

Shadows clipping 

warnings. Activating 

them displays any 

parts of the shot that 

have been ‘clipped’ to 

pure black, as a bright 

blue colour. Any 

clipped highlights are 

shown in bright red. 

So adjust your Tone 

sliders under the 

Basic panel until the 

warnings have gone, 

or are suitably 

subdued.

We hope you’ve enjoyed our 

Photoshop Genius section and 

would love to see how you’re 

getting on using our brand-

new editing techniques. So 

why not share your finished 

shots with us? Each month 

we’ll announce our favourite 

entry on our Facebook page, 

and the winner will receive a 

Manfrotto NX camera shoulder 

bag II. To be in with a chance to 

win, just follow the Photoshop 

techniques and  

then send your  

results to us  

at ppsubmissio

bauermedia.co.ukuk

with the subject heading 

Photoshop Genius. We look 

forward to seeing them soon. 

Share your shots with us & win!

TOP 
PRIZES
TO BE 
WON
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Know  Know
YouY Y rStuff

All your technique and gear questions answered by  
our team of experts knowyourstuff@bauermedia.co.uk

Tim Berry

PP’s deputy 

editor has a 

master’s degree 

in photography 

and has taught 

undergraduates.

Louise Carey 

PP’s features 

editor is an 

experienced  

fine art and 

documentary 

photographer.

Dan Mold

PP’s Photoshop 

editor is a former 

Digital Photo

staffer who has 

encyclopedic 

photo knowledge.

Tim says: For any kind of 
woodland photography, and in 
particular if you want misty 
atmospheric lighting, autumn is 
the perfect time of year to get out 
and shoot. Here are our five top 
tips for achieving the most 
impressive results...

Work early morning
Getting up and out early will 
give you the best chance of misty 
conditions. This is because 
‘temperature inversions’ are 
common at this time of day, where 
the air at ground level is colder 
than the air above it. They also 
sometimes occur around sunset, 
especially on or near low-lying 
land. You actually don’t need 
much mist for defined sunrays, 
so it’s always worth heading out 
even if the air seems clear.

Wait for the best colour
In the UK, the brightest autumn 
colours occur around the end of 
October depending on the type of 
tree, the weather, and where you 
live. The further north you go, the 
earlier in the year the leaves 
change. Keep your eye on the 
Forestry Commission’s autumn 

colours map (see below right), 
which gives up-to-date reports on 
leaf colour in your area. 

Use a narrow aperture
It may sound obvious, but 
sunrays require strong, direct 
sunlight, so be sure to work on 
a clear day. Shoot directly into 
the sun, stick to the morning and 
evening when the sun is low in 
the sky, and use your narrowest 
aperture to create an attractive 
sunburst effect.

Always work in RAW
With the sun in shot, you’ll have 
a very high-contrast scene. By 
working in RAW, you can expose 
for the brightest parts of the 
scene, then bring back detail from 
the shadows later in Photoshop. 

Shoot wide-angle
There’s no rule for what type of 
lens to use, but a wide-angle is 
likely to give you the best results, 
especially if you want both the 
forest floor and tree canopy in 
your frame – 20mm or wider is 
ideal on a full-frame camera, 
and 14mm or wider is ideal 
for APS-C.

I’ve always loved those images of misty forests where

rays of sunlight pierce through the leaf canopy and it’d

be great to shoot one of my own. Where do I start?

Carrie Michaels, Burton upon Trent

How do I capture 
sunrays in misty 
woodlands?
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For up-to-date information on the 

colour of the tree foliage in your 

location, visit forestry.gov.uk/autumn 

– its interactive forest map is based 

on day-to-day observations.
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A hill or mound from which you 

can look down on an area of 

woodland can be a very useful 

shooting angle. Early-morning 

mists tend to hug the ground, 

and may only be a few metres 

thick, which can leave the tree 

canopy poking through the top. 

Be in position just after sunrise 

and you may be rewarded with 

very long shadows and warm, 

golden light. As a general rule, 

you’ll need to work following 

a cold, clear night, and the 

windspeed must be lower than 

around 3mph. Radiation fog is 

more likely to form near water, 

such as a lake or river, so bear 

this in mind when selecting 

a location. This type of mist is 

known for dissipating quickly, 

so you need to work fast and 

get as many shots in the bag 

as you can. Unlike shooting 

within the forest itself, you 

may find that a telephoto 

lens is a better option than 

a wide-angle – a 70-200mm 

is ideal for most locations. 

This will allow you to focus on 

a smaller detail of your scene.

As morning mists are 

relatively uncommon, even in 

autumn, you may need to visit 

a location several times until 

you get the conditions you 

want. Don’t let this put you off 

though – in landscape 

photography, perseverance is 

the name of the game.

Above Looking down on an area of woodland from the top 

of a hill can make for stunning images, especially if the mist 

layer is thin enough so the treetops poke through.

Expert advice Shoot from an elevated position

TIP 

CREATE 

STRONGER RAYS

If your sunrays aren’t defined 

enough, you can use the 

Dodge Tool to enhance 

them. Choose a soft brush 

at 5% Opacity, and 

set to Midtones.
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I’m building a portfolio of 

images but find it extremely 

hard to judge my own work. 

Could you offer me advice on how to 

be a more effective self-critic?

Rosie Greenfield, Wiltshire 

Tim says: Whether you’re a seasoned pro 
or complete beginner, being objective when 
evaluating your own work is always 
incredibly tough. Some photographers are 
their own worst critic and berate 
themselves on every photographic 
imperfection. Others have a slightly 
over-inflated opinion of their work! 

Whichever category you fall into, 
chances are you won’t know which it is, 
because this is usually something only 
others can see. For this reason it’s good to 
have a friend with a photographic eye who 
can be completely honest with you about 
your images and your editing. Don’t take 
offence, as this is indispensable advice that 
will help you improve. 

When judging your work, try to see each 
shot for its technical and creative merits 
and remove any emotional connection you 
might have. If you find yourself saying, 
‘This is going into my portfolio because it’s 
my dad and he’s awesome’, or, ‘I’ll include 
this one because I walked six miles in the 
snow to capture it’, then alarm bells should 

be ringing because you could be choosing it 
for the wrong reasons. Your viewer won’t 
know or care about these things, they just 
see the shot for what it is. 

Take a screen break
If you’re struggling to decide, try going for 
a walk to clear your head, then look at your 
shots again. This often changes your 
opinion. You could also put a few shots up 
on Facebook or Instagram and ask for the 
views of your friends. Non-photographers 
tend to judge images very differently, so you 
might be surprised by the results. 

When you look at one of your shots, 
always consider it for both its technical and 
creative merit, and how you’ve edited it , 

picking out aspects that you like and the 
ones you aren’t so keen on. Don’t be afraid 
to compare yourself to the pros. This 
practice is good for picking up tips and sets 
a standard to work towards. Equally, don’t 
be disheartened if their work is superior. 
Remember that you’re only in competition 
with your last shot, so if you can see 
yourself improving you’re definitely on the 
right track. To the right we check out an 
image of a coastal sunset on the island of 
Ibiza, and break it down to decide whether 
or not it’s a keeper. Following a similar 
critical process for your own shots should 
help you see the merits and weaknesses of 
your shots and help you decide if they’re 
worthy of a place in your portfolio.

How should 
I critique 
my work?

If you’re creating a portfolio for 

submission to a magazine, you 

may choose a different set of 

shots to those that you’re, say, 

displaying in a gallery. Art 

editors will often want to 

overlay words on top of an 

image, especially if it’s being 

used across a spread, so try 

to choose minimal photos 

containing large areas of blank 

space (see left). Some pro 

photographers deliberately 

compose images with lots of 

editorial space, even if this 

means a slightly unbalanced 

or unusual composition. Also 

consider submitting sets of 

three of four images along the 

same theme, as editors often 

need more than one photo of 

a certain location or event, and 

always keep your shots 

mainstream (an artistic mono 

abstract with lots of film grain 

will be too niche to be of 

interest to most publications). 

Don’t add a watermark as 

this will damage the aesthetic 

quality of your shot, and never 

over-edit. Label up your 

images clearly with a proper 

description in the filename, 

and add all of your copyright 

and contact details to the 

metadata. Provide low res in 

the first instance, then send 

higher res files on request.

Above An image with plenty of editorial space is often 

required for use in magazines and other publications.

Above Photos of very well-known locations in your portfolio, like this shot of some moored 

gondolas in Venice, can make you look unimaginative and stop your work standing out.

Expert advice! Compose with editorial in mind
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Learn to critique 
your own work...

In your opinion are the 

days of the DSLR now 

numbered? 

Carl Richards, Newport 

Dan says: Tough question! Given 

that mirrorless cameras offer 

a significant size and weight 

advantage over DSLRs, the smart 

money would be on them becoming 

much more common, if not 

completely dominant, within the 

next ten years or so. At the moment 

they account for roughly 25% of 

the total interchangeable lens 

camera market, and about 10% 

of overall camera sales (not including 

smartphones), although the 

mirrorless market share isn’t 

currently growing at any great pace. 

The downside to CSCs is that they 

tend to have more fiddly controls, 

smaller, lower capacity batteries, 

limited lens ranges and electronic 

viewfinders, all of which can be a big 

problem for pro photographers. For 

this reason we’d expect any future 

changing of the guard from DSLRs to 

CSCs to have the least immediate 

effect at the pro end of the market. 

It’s interesting, and possibly quite 

telling, that of the three big DSLR 

camera manufacturers only Canon 

has really taken mirrorless seriously, 

and this has only happened in the 

past couple of years. You would think 

that if it were an absolute certainty 

that CSCs were the format of the 

future, every manufacturer would by 

now have flung themselves into the 

fray feet first. So perhaps the fate of 

DSLRs is still unwritten and we’ll just 

have to wait and see! Certainly, 

though, if you’re asking the question 

because you’re looking to buy 

a new camera, you can 

comfortably 

buy into 

either format 

without fear 

of it dying 

out any time 

soon.

Will CSCs ever 
supersede 
DSLRs?
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 Creative skills

PROS

Shot in a beautiful 

location at the best time of 

day, with a vivid sunset that 

creates an attractive colour 

palette. The image is alluring, 

and having the jetty in the 

foreground helps to lead the 

viewer into the scene. The 

rocks in the foreground help 

anchor the eye.

CONS

The horizon is 

positioned centrally in the 

frame, whereas it may have 

been better on the upper 

third. Also, the jetty doesn’t 

quite lead the eye towards 

the image’s main focal point. 

Could the shot have worked 

better with a person on the 

pier, maybe?

Technical skills

PROS

Image is in focus and 

the mid-range aperture of 

f/11 has ensured everything 

is sharp. The exposure is 

correct and the low ISO of 

100 means minimal digital 

noise. Shot at 17mm on 

a full-frame camera means 

a very wide angle-of-view, 

which works well.

CONS

The sun and its 

reflection on the water are 

burnt out, as the dynamic 

range of the scene exceeds 

that of the camera. A HDR 

would have given a more 

pro result. A speed longer 

than 2secs for more blur in 

the water might have 

worked better, too.

Editing skills

PROS

Applying a lens 

correction profile has 

ensured a straight horizon 

and no chromatic aberration 

or vignetting, which gives 

the image a polished look. 

The RAW file has been 

worked up to reveal detail in 

dark shadows in the bottom 

left corner of the frame.

CONS

The image may be 

over-edited, especially in 

terms of colour saturation. 

Perhaps it looks too blue? It 

might have been best to 

Photoshop in the missing 

plank in the jetty, as it 

distracts the viewer’s eye 

away from the focal point in 

the background .

Discover your photographic 

strengths and weaknesses with 

a few moments of reflection...
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I’ve seen a bridge camera 

at a good price that seems 

to have a decent spec. Are 

they any good? Nick Reeves, Bury 

Dan says: Most bridge cameras 

have a similar size and shape to 

DSLRs, including a deep handgrip 

and pronounced top-plate, but 

internally they’re actually quite 

different. Most notably, they don’t 

have interchangeable lens 

functionality, so the lens is fixed 

permanently to the camera, and 

they’re built with relatively small 

sensors. In simple terms, you’re 

buying a compact camera with 

DSLR handling. One important 

difference, though, between the 

features of a compact and a bridge 

is the fixed lens’ focal range. 

Bridges always come with 

a superzoom lens that typically 

offers a 60x optical zoom, equivalent 

to around 20mm-1200mm on 

a full-frame DSLR. This huge focal 

range makes them by far the 

cheapest option on the market for 

those who need long telephoto 

capability, making bridges popular 

with amateur wildlife photographers. 

Image quality is significantly 

inferior to DSLRs, and some models 

don’t even shoot RAW, so keep this 

in mind when making a decision.  

What is meant by the ‘blue hour’? 

What does it mean when 
a lens has ‘true macro’?

What is meant by the term 

‘blue hour’ and when does 

it take place? 

Steve McCracken, Hampshire

Dan says: Blue hour comes before 

golden hour in the morning (just 

before sunrise) and evening (just 

after sunset). It’s a stage of twilight 

where the light is particularly cold 

and blue. As with golden hour, blue 

hour doesn’t actually last a full hour  

in the UK – at this time of year it’s 

usually just 10-15 minutes long – but 

it can be equally effective at creating 

a sense of atmosphere in your shots. 

As light levels are relatively low 

during blue hour, shutter speeds tend 

to be quite long, even without an ND 

filter, allowing you to blur movement 

within the frame easily. It’s a popular 

shooting time for landscape 

photographers, especially in the 

winter months when it occurs at 

considerably more sociable hours 

than in the summer. 

Should I consider 
investing in a 
bridge camera?
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Brighten your model’s eyes in Photoshop

2
Add brightening 
Press Q to convert to a 

selection, then click the Create 

new fill or adjustment layer icon at the 

bottom of the Layers Panel. Choose 

Selective Color from the list. Select 

Neutrals from the drop-down box, then 

move the Black slider to the left. You 

should notice the irises brighten.

3
Repeat for the pupils 
Press Ctrl+D to deselect the 

irises, then repeat step 1 and 

2 to select the pupils. When you get to 

the Selective Color adjustment, choose 

Blacks and move the Black slider to the 

right, giving jet-black pupils, then choose 

Whites and move the Blacks slider to 

the left to brighten catchlights. 

1
Select the irises 
Double click on the Edit in 

Quick Mask mode icon at the on 

the Tools Panel. Choose Selected Areas, 

click OK, then press D on the keyboard. 

Choose the Brush Tool, change Hardness 

to 80%, and paint a red mask over your 

model’s irises. If you want to delete areas, 

press X, then X again to repaint.

How do photographers get 

a model’s eyes so bright and 

vivid? Whenever I try, the effect 

never seems natural. 

Ellie Stevens, North Yorkshire 

Tim says: When shooting a portrait, the 
eyes are probably the most important part 
of the face, so getting them looking as 
beautiful and captivating as possible is 
a vitally important skill. Many portrait 
photographers give the eyes a small tweak 
in post-processing, though subtlety is key as 
it’s easy to go too far and make them look 
unnatural. There are lots of different 
methods for eye brightening, and advice on 
which works best. My opinion is that the 
whites of the eyes should only ever be given 
the very lightest of tweaks, unless they’re 
unusually dull or yellowy. On my portraits 
I rarely touch them at all. 

However, the irises and pupils can almost 
always benefit from some heavier editing. 
To do this, you’ll first need to select the iris 
area only, ensuring the selection has a soft 
or ‘feathered’ edge so that any changes you 
make blend in seamlessly with the rest of 
the image. You can select the area in any 
way you prefer, but I like to use the Quick 
Mask tool, choosing a soft brush to create 
the feather. Once selected, you can brighten 
with Curves or Levels, or any other way 
you wish – the Selective Color tool is as 
good a way as any for a very natural result.  

Next, you’ll need to select the pupil in the 
same way, using Selective Color again to 
brighten any catchlights and darken the 
shadows. If you use Adjustment Layers you 
can easily turn these off at any time to see 
the changes you’ve made. Below I show you 
exactly how to subtly brighten eyes in 
Photoshop in just a couple of minutes.

Should I keep a 
filter on my lens?

Some of my friends tell 

me I should have a UV 

filter on my lens. Is this 

necessary? Irene Mason, Bath

Louise says: Many old school 

photographers like to keep a UV 

filter more or less permanently 

attached to their lens. This is 

because back in the days of film 

filtering out UV light would help 

reduce blueish haze on bright 

sunny days, and produce higher 

contrast results. Digital cameras, 

though, already have a UV filter 

fitted to the sensor, so a second 

isn’t necessary. Plus, extra glass 

on the end of your lens will to 

some extent increase vignetting 

and glare, reduce image quality 

and decrease the amount of light 

entering the lens. However, as  

a protective device, filters come  

in very handy – if you drop your 

camera, it will cushion the blow 

and possibly save the front 

element from getting damaged.  

If you’re concerned about image 

quality, though, you can use a lens 

hood instead.

How do 
I create 
brighter 
eyes?
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- Michael Clark, 
Adventure Photographer

1200Ws of Power

4000 Lumen 92 CRI Dimmable LED

Flash Duration up to 1/8850s* 

Hi-Sync up to 1/8000s

8.5 Stop Power Range

400Ü Full Power Flashes

Kit Weight 6.5kg

18x13cm Footprint

*    Action head at @172Ws

** HS head with HS transmitter and compatible camera

Ü  HD Battery Optioin.

ìThe new ELB 1200 is hands-down the most

advanced 1,200 Ws battery-powered strobe

kit on the market. They are ultra-dependable,

insanely durable, super easy to use and the Hi-

Sync functionality is unsurpassed by any other

strobe on the market.î

Introducing ELB 1200

See How  

This Image 

Was Made
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Armed only with a friendly 
smile and local knowledge, 

Jimmy McIntyre has travelled 
the world in search of ‘dark 

and moody’ landscapes. 

ADVENTURE
O F  A  L IF E T I M E

Jimmy McIntyre is a travel photographer, 

blogger and Photoshop tutor. He’s taught  

in four continents, in two languages, has 

been published in numerous magazines,  

and currently lives in South Korea.  

throughstrangelenses.com & shutterevolve.com

PRO SHOWCASE

FROM THE WORLD’S BEST 

PHOTOGRAPHERS
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T
HERE WAS NOWHERE TO GO BUT 
everywhere, so just keep on rolling 
under the stars. This evocative line 
from Jack Kerouac’s seminal On The 
Road novel could have been written 
for Jimmy McIntyre. Having spent 

the last seven years on the road, feeding each 
destination’s idiosyncrasies through his unique 
stylistic filter, Jimmy is every inch the free-spirited 
adventurer Kerouac imagined. He just happens 
to have a camera in his hands most of the time...

Travel photography is a broad church – 

how would you describe your style?

I’d say I’m a landscape and cityscape photographer 
mainly. Landscapes excite me the most, and I 
particularly enjoy astrophotography. I shoot almost 
exclusively at golden hour or night. My style changes 
depending on the scene I’m shooting, but overall, I’m 
drawn to dark and moody scenes. I love to exaggerate 

shadows and work with vibrant colours, and I often 
look to pull out some dramatic movement with the 
help of ND filters, to give my images more depth. 
For cityscapes, I go for dynamic scenes with long 
light trails, or vast panoramas shot from rooftops.

Your lens collection covers 14-70mm, which 

suggests you’re an up-close and personal 

photographer – would this be accurate? 

Absolutely. I used to carry much longer lenses, 
but rarely used them. I really enjoy getting in close 
to my foreground subjects, which I hope creates a 
more intimate mood. My tripod is rarely extended 
above waist-height, and for the vast majority of my 
images I use a 14-24mm lens. I want the details 
and textures in my foregrounds to be so close 
you could almost reach out and touch them.

What makes a great travel photograph? 

What are you trying to capture? 

I know it’s a cliché, but the only thing that comes to 
mind is mood. If I can get my viewers to immediately 
feel the mood in my frame, whatever that mood 
may be, then I’ve done my job. If I have to make 
viewers work hard to figure out what’s happening, 
or there isn’t an immediate sensation when they look 
at my shot, then I’ve probably missed the mark.

“I CAME FACE-TO-FACE WITH A 

MOUNTAIN LION. HE WAS NO 

MORE THAN 15 METRES AWAY...”
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What have been your defining photography 

moments so far and what do you hope 

they will be in 20 years’ time? 

I was robbed on an overnight train in Indonesia. 
They stole every ounce of equipment I had. It was 
at the very beginning of my career and I had no 
insurance. When I got off the train at Surabaya, I 
found the nearest camera shop, bought an upgrade 
to all of my gear, cringed at the cost, and just moved 
on. My equipment literally never leaves my side now.
Last year I was in the Kofa Mountains in the middle 
of the Arizona desert at 4am to shoot the Milky 
Way. I came face-to-face with a mountain lion. 
He was no more than 15 metres away, staring at 
me. Fortunately, I wasn’t far from my car, where 
I fled to safety. I was both terrified and thrilled.
As for future defining moments, I’m still desperate 
to get onto a tall building in Dubai and finally catch 
the fog that rolls in and covers the lower buildings.

Talk us through the practicalities 

of travel photography…

You often have to disarm people when you’re a 
foreigner with a camera. Smiling is the best way 
to do that. I have to bribe my way onto a lot of 
buildings in Asia and every negotiation starts with 
a smile. And when there isn’t a shared language, I 

smile, give the person with whom I’m negotiating 
my notepad and a pen, and they write down the 
asking price. Being aggressive or stern looking 
simply wouldn’t open the door to communication. 

How do you fund your travel? 

I’m very fortunate as I’m entirely self-funded. 
I paid myself out of debt in the UK years ago and 
started my photography business. I sell my own 
software, called Raya Pro, and downloadable courses 
that teach photographers how to shoot and process 
images. This is all done through my own site – 
shutterevolve.com – and through my YouTube 
channel. This funds everything and has sustained 
me for five years now. I don’t work for commercial 
clients, and I have a strict policy of not selling my 
images. My business is based solely on the hope 
that my images inspire photographers to buy 
my courses and software.

Talk us through your techniques – how 

do you compose, expose and focus?

My workflow is extremely simple. I start with 
the main subject, let’s say something large like a 
mountain. Next, I need to know where the light 
will fall, so is it a sunrise or sunset, and where 
will the light hit when it’s low? I use an app on my 

Above Dubai’s 

kinetic skyline 

as seen through 

a 6sec exposure. 

Welcome to the 

22nd century! 

Left Lake 

Wakatipu in the 

South Island of 

New Zealand, set 

against a Lord Of 

The Rings-esque 

backdrop.  
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phone called PhotoPills for that sort of planning.
Next, I look for an impactful foreground. In 
my mind, if I don’t have a foreground then I 
don’t have an image, unless the main subject 
is beyond spectacular. So, I need a foreground 
with lines, patterns, textures, movement, 
interesting things, or a combination of all five.
With a foreground that complements the mood I’m 
going for, I manually focus midway between the 
background and foreground. This is very general, 
of course, as it changes with every shoot. I use 
evaluative metering, for the most part, and usually 
shoot in aperture-priority mode, unless I’m using 
ND filters or shooting the Milky Way, which requires 
manual mode. With my lenses, I tend to shoot 
anywhere between f/5.6 and f/11 for optimal results, 
but this depends entirely on light, and depth-of-field.
I adjust white balance manually. Then I shoot a test 
shot to see if everything is sharp enough and well 
composed. When it comes to the proper shoot, I 
bracket. I exposure blend the vast majority of my 
images, as even the wonderful RAW files from the 
Nikon D800 still can’t capture the full range of 
light in most scenes without image degradation, 
so I like multiple exposures for the cleanest 
possible image. Then it’s time to go home.

Talk us through your mental and 

physical approach to shoots – how much 

preparation goes into a shoot? 

Physically it can be demanding, particularly if I’ve 
got some serious hiking to do. The mental aspect 
is much harder. I’m not a laid-back person when 
I’m shooting – I have a very specific image in 
mind and it’s all I think about when on location. 
Sometimes I’ll sit in the same spot for days, 

sometimes over a week, just to get that one image. 
With landscapes, you have no control over the 
conditions. If you really want the shot you just 
have to wait. I’ve gone weeks in the same location 
without capturing a single image. On these 
occasions, it takes discipline and blind hope to 
push yourself to the next location, hoping that 
Mother Nature might be generous with her light.

What cameras and lenses do you use and why? 

I only shoot with Nikon lenses and bodies at the 
moment, although I do own a Sony α7. I have a 
D800, which has been an absolute workhorse for 
me. For lenses, I have the 14-24mm f/2.8 and the 
24-70mm f/2.8. Despite being a gadget lover, camera 
equipment doesn’t excite me. Being out in the field, or 
in front of Photoshop, that’s what excites me. I don’t 
read camera reviews for fun, and certainly couldn’t 
name most of the cameras out there, or their specs. 

You mention in your blog that you travel 

with just 25kg worth of baggage – what’s 

the secret to travelling light? 

Realising that I can live happily with far less than 
I originally thought. My wife and I sold everything 
before leaving the UK. We had a bag each and that 
was that. I have a very light Sirui tripod and tiny 
Surface Pro 4 laptop. My camera takes up most of 
the weight. Recently I have a little bit more than 
25kg as I have sound recording equipment and 

Above left

Motukiekie 

Beach, New 

Zealand, is a 

magnet for 

landscape 

enthusiasts. 

Above Tall 

buildings and 

extreme views 

typify Jimmy’s 

cityscapes. 

Right A 14mm 

focal length 

provides an 

expansive view 

of Japan’s Osaka 

University Library.

Pro Showcase Jimmy McIntyre

“SOMETIMES I’LL SIT IN THE SAME 
SPOT FOR DAYS, SOMETIMES A 
WEEK, JUST TO GET ONE IMAGE” 
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Pro Showcase Jimmy McIntyre

an extra camera for behind-the-scenes videos 
I’ve been doing for my YouTube channel. 

You regularly share work on 500px and via blogs 

– what have you learned through being so open? 

I’ve learned that the more open you are about 
sharing your techniques and ideas, the more likely 
you are to connect with like-minded, appreciative 
photographers. These articles and blogs have opened 
the door to thousands of photographers who’ve since 
followed me on Facebook, YouTube and my blog. And 
hopefully this has led them to become customers. 

How much Photoshop work 

goes into your images? 

I spend on average about 20 minutes post-processing 
each image. This is all done in Photoshop and 
Adobe Camera RAW. My attitude is, do what you 
enjoy. If you don’t like post-processing, don’t do 
it. I don’t do composites or sky replacements, and 
I don’t add things into the frame which weren’t 
already there, but I’m happy to enhance colours, 
contrast, exposure blend, add light bleeding 
and a touch of the Orton Effect, where I like.

If you could pass on one nugget of advice to a new 

travel photographer, what would it be and why? 

Be absolutely clear on what you want before setting 
off on your journey. Travelling is expensive. If you 
hit the road with only a vague idea of what type of 
photography you enjoy, or how you want to monetise 
your journey, it may cost you a lot of time and 
money before you actually start moving in the right 
direction. So, ask yourself, what type of photography 
would motivate me enough to battle through some 
of the difficulties the road presents? And how could 
I make this a sustainable job? What are the many 
ways a photographer could earn from his trade? If 
you can at least partly answer these questions then 
you’ve potentially saved yourself a lot of money.

1
PLAN FOR EVERYTHING 

The easier it is to find the 

place without getting lost, 

the more time you can spend 

scouting out unique compositions. 

Use a free offline map, like  

Maps.Me for your smartphone,  

so you’ll never get lost. Some 

locations are closed at certain 

times of year or don’t allow tripods, 

so check before you make plans.

2
STAY SAFE

Buy a camera bag that 

comes with a rain cover 

that fits over the entire bag. Make 

sure the cover is over your bag 

wherever you suspect pickpockets 

may be around. That way, all of your 

zips and pockets will be covered, 

making you a less vulnerable target.

3
SEEK ADVICE 

Find forums or Facebook 

pages for photographers 

local to the area. Ask them for 

lesser-known places, or ask to see 

their compositions of the locations 

you’d like to shoot. The plan isn’t to 

copy, but to build up an image of a 

location before you get there.

4
THINK SEASONAL 

In Dubai, the fog rolls in 

around December to 

March. In the summer, we can get 

three light rays in the Antelope 

Canyons in Arizona. Around April, 

the Milky Way shoots right out the 

top of the Nugget Point lighthouse 

in New Zealand. So, find the best 

time of year to visit your location to 

get the most out of it.

  Pro advice Jimmy’s top 4 photography tips  

Above Hong 

Kong provides 

the futuristic 

backdrop to 

these stunning 

traffic trails. 

Left New 

Zealand’s 

iconic Nugget 

Point, taken 

with an epic 

180-second 

exposure.
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Affordable lighting tools for photographers

This portable range of FlashBender 2 lighting accessories allows photographers to direct and shape 

light, giving them greater control. The lightweight products are ideal for location photographers. They are 

strong, durable and can be flat packed for easy storage or transportation.

Flash Grids & Gels

Universal Designs Attach Quickly

Prices start from £26.99

Soft Boxes

Reflector and Diffusion Panel

Prices start from £39.95

Reflectors

Shapeable with Multiple Uses

Prices start from 28.95

F R E E  M A I N L A N D  U K  D E L I V E R Y  O N  O R D E R S  O V E R  £ 5 0 .  P R I C E S  I N C L .  VAT.



CAMERA
KN    WHOW

In our Camera Know-how 

series, we cast an expert eye 

over the ins and outs of your 

DSLR or CSC’s key features, 

revealing precisely what they do 

and how you can make the 

most of them to boost your photographic 

skills. In this month’s issue, Ben Davis takes 

a detailed look at shutter-priority and 

explains how you can adjust your camera’s 

exposure time to control one of the most 

powerful creative tools in photography...

A
moment in time that’s 
frozen forever. Whether 
it’s high octane action over 
in a fraction of a second, or 
a dusky landscape oozing 

with atmosphere, the amount of time 
required to capture the shot will vary 
considerably. This time element of an 
exposure is the shutter speed, and it’s best 
controlled with shutter-priority mode.

What is shutter-priority mode?
When you select shutter-priority (S or 
Tv on the mode dial) you are responsible 
for the shutter speed in your shot. This 
is the amount of time your sensor is 
exposed to the light. Inside your camera 
there’s a moveable ‘curtain’ which opens 
and closes over the sensor to let light
through for as long as you dictate. The

PART ONE  SHUTTER-PRIORITY
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shutter speed is set by 
your camera’s main 
command dial, and is 
displayed as a fraction 
of a second, like 1/125sec, 
or in entire seconds like 
10secs. When shooting in 
shutter-priority mode, your camera 
automatically selects the aperture 
setting to create a balanced exposure.  

Why is it useful? 
Shutter-priority is most useful when you 
want to concentrate on the time element 
of your exposure. By controlling the 
shutter speed you determine how motion 
appears in your images. A fast shutter 
speed will freeze any movement in a 
scene, whereas with a slow shutter speed 
anything moving in the frame would be 
rendered as a blur. The shutter speed 

you should choose 
varies depending 

on the speed of the 
subject. For example, 

an ambling pedestrian 
would be crisp with a 

shutter speed of 1/125sec, 
but a racing greyhound would be 

rather blurred with the same setting.     

When should I use it?
It’s best to use shutter-priority mode
when you want to concentrate on how 
movement appears in your images. 
Perhaps you’re shooting sporting action 
and want to make sure those crunching 
tackles are captured crisply, so use it to 
select a fast shutter speed like 1/2000sec. 
Or maybe you want to blur movement – 
such as the waves in a stormy seascape 
– so set a slower shutter speed like 5secs.

Camera Know-how Shutter-priority

LEARN THE LINGO

TECH TERMS MADE EASY

GEAR ADVICE USE A 

RELEASE CABLE

Don’t be baffled by technical jargon! We 

cut through some of the most common 

terms associated with shutter speed.  

n SHUTTER-PRIORITY

The shutter-priority mode lets you control 

how long your camera’s sensor is exposed 

to the light for, while the aperture is 

automatically set in-camera. 

n EXPOSURE TIME

The amount of time – measured in 

fractions, seconds or even minutes –  

your camera’s shutter speed is set to.

n CAMERA SHAKE

Camera shake occurs if your camera isn’t 

kept perfectly still during longer 

exposures, and results in an unwanted 

blurring of all detail in your image.

n 10-STOP ND FILTER

A 10-stop ND filter, or Big Stopper, is a 

darkened filter that heavily restricts the 

amount of light passing into your lens, 

allowing you to access longer shutter 

speeds than would otherwise be possible.

When you’re shooting 

with a slow shutter 

speed it’s essential 

your camera 

doesn’t move during the 

exposure. Even pressing the shutter button 

is enough to transfer blurring vibrations to 

your image. To get around this, either set  

a 2sec self-timer or use a shutter release 

cable to take your picture.

Above Set your camera’s mode dial to 

shutter-priority (S or Tv) to control the 

exposure time and get creative with motion.

TIP

STAY SHARP 

If you’re using a slower 

shutter speed – such as 

1/60sec or below – it’s best 

to use a tripod to avoid 

the unwanted blur of 

camera shake.
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S
LOWING DOWN YOUR 
shutter speed will transform 
moving subjects like flowing 
water into an artistic blur. 
Just how blurred the water 
becomes depends on the length 

of your exposure and the speed of the 
water. However, if you want to shoot with 
a really slow shutter speed to smooth 
out even more moving detail then you’ll 
need the assistance of a neutral density 
filter. They restrict the amount of light 
entering your lens, allowing you to select a 
longer exposure than would otherwise be 
possible without overexposing the image.  

Fast exposure 1/1000sec
With a rapid shutter speed of 

1/1000sec, the detail of the surface of 

the water is captured crisply without 

any detectable motion blur.

Slow exposure 1 second
By using a 10-stop ND filter you 

can slow the shutter speed down to 

1sec. The water has become a little 

blurred, but some detail remains. 

Very slow exposure 30 secs
With a much longer exposure of 

30secs, the sea has been captured as a 

much smoother blur. A 10-stop ND filter 

was required for this shutter speed.

REAL-WORLD SHOT SHUTTER SPEED & MOTION BLUR IN ACTION

SETTINGS HOW 

SHUTTER SPEED 

CONTROLS BLUR

SHUTTER SPEED
If you want to increase the 

amount of blur on your 

subject you need to select 

a longer shutter speed

APERTURE
In shutter-priority mode 

the camera selects the 

best aperture setting to 

capture a balanced shot

SENSITIVITY
The ISO controls how 

sensitive your camera is to 

light and can be adjusted 

in any shooting mode

GEAR ADVICE NEUTRAL DENSITY FILTERS FOR LONGER EXPOSURES

 Marumi 72mm ND64 £39 

This 6-stop filter lets just 

1/64th of the light pass 

through to the sensor. This 

is enough to transform a 

shutter speed of 1/30sec to 

2secs, allowing you to add a 

pleasing blur to images of 

moving water when fitted. 

marumi-filter.co.jp/en

 SRB ND1000 filter £33 

This 10-stop filter reduces the 

amount of light entering the 

camera by a factor of 1000! 

With this filter an exposure 

time of 1/30sec can be set to 

30secs, allowing you to 

capture lots of motion blur 

even in broad daylight. 

srb-photographic.co.uk

 Kenko ND1000 filter £90 

This more premium filter from 

Kenko also reduces the light 

by 10 stops, allowing you to 

shoot with much slower 

shutter speeds. It also 

features special coatings to 

improve image quality and 

reduce ghosting and flare.

kenkoglobal.com

TIP

KEEP YOUR 

ISO LOW

To shoot with slow shutter 

speeds in daylight you need 

to keep your ISO to its 

lowest setting to not 

overexpose the 

image
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Put your skills to the test with these three projects 
that rely on you taking control of the shutter speed 
for creative results. You don’t need any specialist 
equipment, although a tripod would be handy! 

THREE PROJECTS 

SHUTTER-PRIORITY MODE

NEXT ISSUE HOW TO USE APERTURE- 

PRIORITY TO CONTROL FOCUS BLUR
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1
SHOOT BLURRED 

PEDESTRIANS

2
RECORD THE 

RUSH HOUR

3
CAPTURE CRISP 

SPORTS ACTION

At busy locations, it can be difficult to 

capture a shot that isn’t cluttered with 

people. You can turn this to your 

artistic advantage by shooting with a 

slow shutter speed to creatively blur 

moving people into a figurative 

smudge. Not only will this lessen the 

distraction of lots of people, but it will 

also add a poetic element to the 

capture. To achieve this, all you need to 

do is shoot in shutter-priority mode and 

set your shutter speed to 1/2sec. To avoid 

the risk of overexposing, set your ISO to 100. 

You’ll need to keep your camera perfectly still or 

camera shake will blur the entire shot. Use a tripod if you have 

one, but if not you can rest your camera on something steady like 

a wall or bench. When you’ve composed, focus up on the scene 

and then set a 2sec self-timer before taking the shot.

When the sun starts to dip and 

the headlights start shining, 

head out with your camera and 

capture the light trails of passing 

traffic. With shutter-priority 

selected, dial in a shutter speed of 

30secs and set your ISO to 100. Fix your 

camera to a tripod or rest it somewhere secure and frame up on a 

busy road, setting the focus on the main subject in the shot. Set a 

2sec self-timer or use a shutter release cable to avoid transferring 

shake to your images. The lights from the moving traffic will be 

captured as colourful red and white streaks along the road. If you 

find your shot is a little on the dark or bright side then dial in either 

+1 or -1 stop of exposure compensation and take the shot again.

To capture fast moving action like 

sport or wildlife you need to select a 

really fast shutter speed if you want 

to record sharp detail without any 

motion blur. The easiest way to do 

this is to use shutter-priority and set 

the shutter speed to 1/1000sec or faster.  

If your aperture value starts to blink or 

reads ‘low’ then there isn’t enough light for a 

balanced exposure, so simply increase your ISO setting to make 

your camera more sensitive to light and then take the shot.
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As technology flourishes at an exponential rate, the 
science of tomorrow edges ever closer to the reality of 
today. Amelia Troubridge trains her lens on the women 

behind some of the UK’s most futuristic projects. 

MY PHOTO

P R O J E C T
PERSONAL WORK FROM 

UPCOMING TALENT

Factfile

Photographer:  

Amelia Troubridge

Full-time occupation:  

Editorial photographer

Aim of project: To celebrate 

the freedom and individuality 

of women at work, and to show 

them as the pioneers they are.

Location: I travelled all 

around the UK for this 

project, visiting the women at 

their workplaces.

Duration: It took two 

months of shooting.

Time spent: I worked on 

this project for six 

months altogether.

Images taken: There

were around 200 photos 

taken per shoot.

Website: ameliatroubridge.com
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F
ROM INVENTING A NEW 
sustainable fabric out of pineapple 
leaves to proposing a floating 
cycle path on the River Thames, 
it’s clear that the women in this 
project have an irrepressible 
desire to change the world for 

the better. This voracious drive is undoubtedly 
mirrored in the photographer behind the camera, 
Amelia Troubridge. Her arresting portraits show 
her desire to present us with the undeniable 
strength and skills of her trailblazing subjects. 

How did you first become interested 

in photography?

I always say that photography found me. My 
father gave me a camera when I was 16 for 
my A Level in Photography. The course didn’t 
actually inspire me much at the time. It wasn’t 
until two years later, a year after my father died, 
that I discovered my great love for photography 
through the process of grieving the loss of him. It 
gave me a huge sense of purpose and direction at a 
time when I was easily distracted by insanity and 
rebellion. I had a fearless, independent spirit and 
was insatiably curious about life and the world, 
so photography felt like a perfect match for me. 
When I was at university I had to write an essay 
on Roosevelt and the policies he instigated 
throughout the Depression era. I stumbled across the 
photographers who were commissioned by the Farm 
Security Administration (FSA) to record the lives 

of Americans in the ’30s. I was particularly struck 
by the images of Dorothea Lange, I think partly 
because when I was growing up we didn’t get to 
learn about women doing jobs like this. I think I was 
subconsciously finding a woman to identify with 
when role models were thin on the ground. When 
I left university I began writing letters, asking people 
to let me assist on their shoots. Only the wonderful 
John Stoddart gave me a chance, but I don’t think 
I was a very good assistant. I wanted to be behind 
the camera learning the secrets of the craft. I don’t 
think I was ready to learn about studio lighting at 
that point. I was too into working in challenging 
surroundings, being on the road, reportage, social 
documentary, going on tour with Motörhead and just 
generally pushing myself to go out and find the thing 
that inspired me. My first magazine and newspaper 
assignments came just a year after I left university, 
but I knew I was into this career for the long haul.

How and when did you begin this project?

The actual project came to me in January 2017, but 
the idea for the ‘women at work’ series had already 
formed a few years ago. In 2003 I’d completed a book 
project on men and the idea of a man’s world with 
the publisher Edward Booth-Clibborn. I felt like I’d 

Above Carolyn 

Pearson is the 

founder of 

maiden-voyage.

com, a 

networking 

website for 

professional 

women. 

Above right

Elena Dieckmann 

co-founded 

Aeropowder, 

which is 

developing 

materials from the 

poultry industry’s 

waste feathers. 

Previous page  

Anna Hill is the 

founding director 

of River Cycleway 

Consortium Ltd.

“PHOTOGRAPHY WAS A PERFECT 
MATCH FOR MY FEARLESS, 
INDEPENDENT SPIRIT...”
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delved into the world of men, but I now wanted to 
explore the world of women. Over ten years later, 
after overcoming many distractions, I produced the 
women project. My work sent me all over the UK, 
photographing women who had dreamed, worked 
hard, succeeded and pushed new boundaries. 
These women all fascinated me, and still do! There 
is and has been so much suffering for women, all 
over the world. I don’t like to tell that story, as 
I’m not very good at capturing the suffering. My 
strengths lie in the positive stories of empowerment 
and courage. Happily, there are more and more of 
them today, as both men and women help to create 
this new reality for millions across the world. 

How did you find the women in your images?

Through Innovate UK, a government agency 
committed to finding and driving science and 
technology innovations. Publishers Hill & Knowlton 
produced the shoots with Matt Somorjay from Getty 
Images. They chose the women who had won the 
Innovate UK £50,000 grant for their business. 

These women have excelled in a variety of different 

fields – did you notice any similarities in the way 

they approached their work? 

They actually have very similar personality 
traits. They all had incredible self-belief, despite 
all the obstacles they’d faced getting their 
businesses off the ground. They had a great 
energy and were able to trust me enough to let 
me do what I do to the very best of my ability. 

This is a lifelong personal 

project, which I’m in no rush to 

see completed. In the mid ’90s 

I became interested in the 

relationship between human 

and horse. When I shot my 

Dublin Urban Cowboys story on 

the notorious Ballymun estate, 

I found a group of children 

who’d discovered a purpose in 

tending to and riding their 

horses. The area was infamous 

for antisocial behaviour and the 

drugs epidemic of the ’80s. In 

what was a miserable place to 

grow up, I was able to capture 

a positive story. That project 

led to others, such as the 

gauchos in Patagonia, the 

women’s side-saddle race for 

Tatler magazine and the 

Appleby Fair for Vice.

Capturing horse culture
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Above Rebecca 

Street is a British 

designer whose 

pieces are sold by 

some of the UK’s 

leading retailers, 

such as Harrods 

and Liberty.

Opposite page  

Dr Carmen Hijosa 

(top left) is the 

creator of Piñatex 

and CEO of 

Ananas Anam. 

Dr Fiona Marston 

(top right) is the 

chief executive of 

Absynth Biologics.  

Dr Jenna Bowen 

(bottom) is 

a co-founder of 

Cotton Mouton 

Diagnostics. 

Did you find any of them particularly inspiring?

I don’t think any one woman inspired me more 
than the others. However, I did love the idea and 
work of Carmen Hijosa. She discovered that she 
could make a non-woven textile – a fabric bonded 
together without knitting or weaving – from 
the long fibres found in pineapple leaves. The 
culmination of her work resulted in the creation of 
Piñatex, a unique and sustainable textile that was 
a natural byproduct of the pineapple harvest. 

How did you decide on the locations?

The team and I felt that we needed to take this 
project on the road, capturing these women in 
environments that they either worked in or that 
had some reference to their business. I always took 
a grey handmade backdrop with me and shot the 
women against it, just to give us options with the 
edit. When I photographed Anna Hill (page 121) 
she had a lot of input on the shoot. She told me she’d 
worked for the European Space Agency, and I was 
really inspired by this. I found some white beach 
balls online and asked my friend if we could shoot 
in his gallery. I then called my designer friend Pam 
Hogg, and asked to borrow a catsuit. Finally, I found 
an image to project onto the space behind her. 
It’s always a hit-or-miss situation when you have 
these different ideas running through your head, 
but it all ended up working together really well.

What kit did you use?

I use Profoto lights with four heads, two softboxes, 

grids, a beauty dish and reflectors. I shoot with 
a Nikon D4S, a small Fuji camera that I love and 
a Pentax 6x7 medium-format film camera.

Were there any challenges?

There really wasn’t anything difficult with this 
project. Even if a location wasn’t working, I’d just 
take it outside and work with what I had. The image 
of Rebecca Street (above), a British designer, was 
shot out on the road. Our setup inside didn’t feel 
consistent with what she did, and what she was 
wearing, so I went outside and found a cream wall 
that had golden light hitting it. Her work is to do 
with gold leaf, so I thought that this subtle reference 
worked for her and her product. This is really 
where my 20 years of experience as an editorial 
photographer on location really kicks in! You get 
used to thinking fast and looking for alternative 
options if your original setup isn’t working. 

What was the purpose of this project?

I wanted to create a folio that prompted other 
women to recognise their most entrepreneurial 
and innovative facets and pursue their ambitions. 
A woman in innovation doesn’t have to look 
a certain way. She doesn’t have one background, 

“A WOMAN IN INNOVATION 

DOESN’T HAVE TO LOOK 

A CERTAIN WAY...”
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one education, one location, one demeanour, 
one approach, or one style. The intention is that 
by highlighting the many identities of female 
innovators, they can create a lasting legacy 
for the future generation of entrepreneurs. 

What’s next for you and this project?

I’d love to shoot something on women in music. 
I also have an ongoing collaboration with the 
charity Women for Women, so I’ll be doing 
more stuff with them as well. I’m off to Seattle 
next month for a music shoot out on the road 
near the Twin Peaks town, North Bend.

Why should readers start a personal project?

Do you want to know how to become a 
photographer? Always do your own project. Always 
have something on the boil, even if you’re not doing 
it right now. Keep something you’re passionate about 
simmering at the back of your mind. Something that 
springs you out of your comfort zone. Connect with 
who you’re capturing 
and tell their 
unique story. 
That’s how 
the magic 
happens. 

Above Fanzi 

Down is the 

commercial 

director at DPS 

Designs Ltd, 

a confectionary

design and mould 

manufacturer. 

1
BE PASSIONATE 

I instinctively know 

what I’d like to go and 

spend my time shooting on, 

so go with your gut and make 

sure you’re excited about your 

potential project. I like to 

spend time thinking about the 

work, so that I know I’ve 

thought it through as much as 

possible. Then simply find 

good contacts to help you tell 

the story as you want to tell it.

2
BE FLEXIBLE 

I think many people 

go into their shoots 

with a clear intention of what 

images they want to create. 

I’ve always worked differently 

with personal projects. I never 

go in knowing what I’m going 

to come away with at the end. 

I let the idea evolve 

organically as I’m shooting. 

I always like the element of 

surprise and chaos to breathe 

new life into the idea I’m 

working with.

3
STEP AWAY

Make sure you allow 

your vision to shine 

through. Your own style. Your 

own eye. Whatever works for 

you. If the story isn’t coming 

together then simply take 

some time away from it. 

There’s never any rush with 

personal projects. 

4
JUMP OFF THE CLIFF 

Make sure you take 

yourself out of your 

comfort zone – I call it jumping 

off the cliff. I still get nervous 

about doing shoots, but 

I really do believe that this is 

a good thing. Feel the fear, 

because it keeps you loving 

what you do. 

 Pro advice Amelia’s 4-step guide   
 to better personal projects 

GET 

INVOLVED

We want to see your best  

 photo projects! If you have  

a unique body of work you’d 

like to share with the world,  

then drop us a line at  

practical.photography@

bauermedia.co.uk
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www.parkcameras.com/prp
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AF-G 10.5mm f/2.8G ED DX £585.00

AF-D 14mm f/2.8D £1,369.00

AF-D 16mm f/2.8D Fisheye £566.00

AF-S 20mm f/1.8G ED £649.00

AF-D 20mm f/2.8 £477.00

AF-D 24mm f/2.8D  £379.00

AF-S Nikkor 24mm f/1.4G £1,530.00

AF-D 28mm f/2.8 £289.00

35mm f/2 AF Nikkor D £279.00

AF-S 35mm f/1.8G ED £439.00

AF-S 35mm f1.8G DX  £179.00

AF-S 40mm f/2.8G ED £229.00 

AF 50mm f/1.4D £259.00

AF-S 50mm f/1.4G £379.00

AF-D 50mm f/1.8 £119.00

AF-S 50mm f/1.8G  £189.00

AF-D 60mm f/2.8 Micro £409.00

AF-S 60mm f/2.8G Micro ED £479.00

AF-S 85mm f/3.5G DX  £449.00

AF-S 85mm f/1.8G  £429.00

AF-S 105mm f/2.8G VR  £729.00

AF-D 180mm f/2.8 IF ED £684.00

AF-D 200mm f/4D IF ED £1,269.00

AF-S 200mm f/2G ED VR II £4,473.00

AF-S 300mm f/2.8G ED VR II £4,699.00 

AF-S 300mm f/4 D IF-ED £1,099.00

AF-S 300mm f/4E PF VR £1,449.00 

AF-S 400mm f/2.8 FL ED VR £9,999.00

AF-S 500mm f/4E FL VR £8,449.00

AF-S 600mm f/4E FL VR £9,999.00

AF-S 800mm f/5.6E FL VR£14,999.00 

AF-S 10-24mm f/3.5-4.5G £729.00

AF-S 14-24mm f/2.8G ED £1,649.00

AF-S 16-80mm f/2.8-4E VR £859.00

AF-S 16-85mm f/3.5-5.6G £424.00

AF-S 17-35mm f/2.8 IF ED £1,549.00 

AF-S 17-55mm f/2.8G DX £1,315.00

AF-S 18-35mm f/3.5-4.5G £619.00 

AF-S 18-105mm VR  £219.00

AF-S 18-140mm ED VR DX £429.00

AF-S 18-200mm ED VR II  £534.00

AF-S 18-300mm f/3.5-6.3 VR  £629.00

AF-S 24-85mm VR £439.00

AF-S 28-300mm ED VR £799.00

AF-S 55-200mm f/4-5.6 VR II£239.00

AF-S 70-200mm f/2.8 VR II £1,998.00 

AF-S 70-300mm IF ED VR £499.00

AF-S 200-400mm VR II  £5,899.00

NIKON LENSES Prices updated DAILY! Visit us in store, online at 
parkcameras.com or call us on 01444 23 70 54

Nikon D500

20.9
MEGA

 PIXELS 10 FPS

Body only

£1,729.00

+ 16-80 VR

£2,479.00

Add a Nikon EN-EL15 spare 
battery for only £64!

This mechanism-free camera can deliver a-class-
above performance conventional mechanical SLRs above performance conventional mechanical SLRs
have only sought. A high-speed, vibration-free, 
silent Anti-Distortion shutter vastly extends the 
range of shooting situations.

3.0î 3.0î
24.2
MEGA

PIXELS
3.0î 3.0î IS 4K3.0”

20 fps

Sony RX100 V

20.1
MEGA

 PIXELS

In stock

£899.00

Spread the cost with 

our fi nance options!

Add a Sony NP-BX1 battery 
for only £38.00 

4K

Sony a7S II

12.2
MEGA

 PIXELS

£2,499.00

See website for 
low prices on 

lenses

See in store or online for a 
free 2 year warranty!

Sony a6500

24.2
MEGA

 PIXELS 11 FPS

Body only

£1,279.00

+16-70mm

£1,909.00

Add a Sony NP-FW50 battery 
for only £50.99 

Joining the Contemporary family of Sigma lenses, 
this compact lens utilises optical image stabilisation 
to assist in long-range photography - with its ob
applications of sports or wildlife photography being 
perfect benefi ciaries of this technology. In stock at £799.00

Sigma 100-400mm
f/5-6.3 DG OS HSM | C

LEE Autumn Tint Set 
100mm System100mm System

In stock at only 

£108.00

For even more LEE fi lters, see 
in store or on our website.

Tamrac Anvil Slim 11
Backpack

In stock at only 

£122.00

For even more bags, visit us 
in store or see our website

In stock at £1,999.00

Achieve new creative goals, with advanced 
performance and innovative features 
that will support your next steps in 
photography – wherever they might lead.

26.2
MEGA

PIXELS 6.5 fps
1080p3.0”

NEW!

Canon EOS M5

24.2
MEGA

 PIXELS 7 FPS

Body only

£864.00*

+ 15-45mm

£914.00*

*Prices after £85 cashback 
from Canon. 01.09.17 - 17.10.17

£85

cash
back

Canon EOS 77D

24.2
MEGA

 PIXELS 6 FPS

Body only

£714.00*

+ 18-55 IS STM

£834.00*

*Prices after £85 cashback 
from Canon. 01.09.17 - 17.10.17

£85

cash
back

Canon EOS 80D

24.2
MEGA

 PIXELS 7 FPS

Body only

£914.00

+ 18-55 IS STM

£944.00

*Prices after £85 cashback 
from Canon. 01.09.17 - 17.10.17

£85

cash
back

Canon EOS 7D Mark II

20.2
MEGA

 PIXELS 10 FPS

Body only

£1,169.00*

+ 100-400mm

See web
*Price after £130 cashback 

from Canon. 01.09.17 - 17.10.17

£130

cash
back

Canon EOS 5D Mark IV

30.4
MEGA

 PIXELS

4K

Body only

£3,349.00

24 months 0% 
fi nance available. 

See website

Add a Canon LP-E6N spare 
battery for only £68.00 

In stock from £4,499.00

Manfrotto 190 GO!
Carbon Fibre
Tripod

Available from

£249.00

See the range of tripods in 
store or on our website!

MT190GOC4TB

Tamron have introduced the world’s
ultra-telephoto all-in-one zoom lens t
achieve 400mm telephoto.

In stock at £649.00

Tamron 18-400mm
f/3.5-6.3 Di II VC HLD

Learn more at www.parkcameras.com
*Among interchangeable lenses for DSLR cameras

NEW!

Visit our Burgess Hill store on 28th October & get help & advice from an expert from Nikon! 
Learn more and see what other events are coming soon at www.parkcameras.com/events

Visit www.parkcameras.com/calendar-competition-2017
and enter our FREE photo competition to win some 
fantastic prizes! 

You pay Cashback After Cashback

24mm f/1.4L Mk II USM £1,499.00 £170 £1,329.00

35mm f/1.4L II USM £1,799.00 £215 £1,584.00

50mm f/1.2 L USM £1,272.00 £170 £1,102.00

85mm f/1.2L II USM £1,767.00 £215 £1,552.00

16-35mm f/2.8L III USM £2,099.00 £215 £1,884.00

24-70mm f/2.8L II USM £1,699.00 £215 £1,484.00

70-200mm f/2.8L IS II USM £1,899.00 £215 £1,684.00

Learn more at, visit www.parkcameras.com/canon-cashback

Body only £3,499.00

Welcome to full-frame FX splendour like 
you’ve never seen it before. From the
studio to the remotest locations on earth. 
See our website to learn more!

45.7
MEGA

PIXELS 7 fps
4K3.2”

NEW!

Nikon D5

20.8
MEGA

 PIXELS 12 FPS

XQD Type

£5,099.00

For the range of 
lenses available, 
see our website

Make the most of your D5 
and save 5% on accessories! 

Up to £215 cashback
on selected Canon lenses 
this Autumn!

A new rangefi nder style, ultra-compact 
mirrorless camera which boasts outstanding 
image quality and enhanced handling.

24.3
MEGA

PIXELS
4K3.0”

Learn more & place a pre-order to receive one of 
the fi rst available cameras at parkcameras.com

X-E3

from £849.00

Expected late September

NEW!
5 fps

3 year warranty available on Canon L-series lenses!
www.parkcameras.com/canon-l-series-lenses

Nikon D3400

24.2
MEGA

 PIXELS 5 FPS

Body only

£379.00

+ 18-55 VR

£449.00

Add a Nikon EN-EL14a spare 
battery for only £49!

Canon EOS 700D

18.0
MEGA

 PIXELS 5 FPS

Body only

See web

+ 18-55 IS STM

£449.00

Add the Canon EF 50mm 
f/1.8 STM for only £30!



R
AISED ON A STEADY 
diet of film and flash, 
Andrew’s dramatic style 
is a unique blend of old 
and new, conventional 
and rule breaking. And 

he’s more interested in character and 
quirk than technical perfection... 

How would you describe your style? 

I’d describe it as spontaneous and 
pictorial. I try to throw the rules into 
an experimental melting pot. Obviously, 
some clients require a more prosaic 
approach, in which case I start off 
technically and then try to push towards 
my own version as the shoot progresses. 
My style derives mainly from the 
oft-quoted reason of being rubbish at 
painting and drawing, but with an intense 
desire to visualise whatever’s in my mind. 
Photographers such as Paolo Roversi and 
Sarah Moon have been a major influence. 

What camera and lighting techniques 

do you employ to achieve this style? 

Over the years I’ve melded together 
more traditional flash/strobe techniques 
with continuous lighting, though now 
I use continuous light most of the time.
In terms of camera techniques, I find 
Olympus’ in-camera ‘pre-editing’ to 
be a huge aid. The ability to adjust 
Curves, colours and tones is invaluable, 
especially when attempting to show 
a client an idea of my final vision. Of 
course, these are only previews, but 
they’re a great starting/reference point 
when it comes to editing RAW files. 

Who and what inspires your work?  

Thanks to synaesthesia (a condition 
where a sensation in one of the senses, 
such as hearing, triggers a sensation in 
another, such as taste), I have a constant 
stimulus of abstract sensory experiences 
which, while seen as an aberration/
disability by some, is actually a huge 
benefit to me. Smells such as perfume 
and hairspray are hugely influential, as 
is music. In terms of visual inspiration, 
visits to art galleries are fantastic for new 
seeds, based on older representations. 

How important is it to get the image 

right in-camera before you edit? 

I try to get within 10% of my final image 
in-camera. I light people individually 
and build the final image, kind of like 
Terminator or Predator constantly 
scanning a scene. There are times when 
Photoshop is required, but Lightroom is 
where the majority of work is done. I try 
to use Photoshop only to ‘add’ to an image, 
rather than take away, literally as well as 
figuratively. The colouring is achieved 
by using Curves and presets and then 
often using textured overlays and blend
modes to achieve what I can only describe 
as ‘dimension’. I suppose it’s based on 
mimicking the organic feel of an oil 
painting – I collect textures and overlays 
and shoot my own as often as possible. 

What are your gear requirements? 

Cameras have to have an exposure 
compensation dial that sits near the 
shutter button – this allows me to easily 
dial in the appropriate amount and get 

Introducing  
Olympus Enthusiast
Andrew Farrington 

Biography: 

Andrew is a 

portrait & fashion 

photographer 

based in 

Manchester. 

Starting at a 

catalogue studio, 

where he specialised 

in loading film backs, he landed a  

job at the BBC, where his first day 

was spent photographing Charlton 

Heston. He still freelances for the 

BBC and recently shot the Dragons’ 

Den promos: “A particular favourite 

as I get to light and direct the shoot.” 

On being an Olympus 

enthusiast: “Our relationship 

began in the early ’80s when David 

Bailey appeared in Olympus’ TV ad 

campaigns. I didn’t actually own an 

Olympus camera – the iconic X-A 

– until many years later. By this time,  

I was working at Carlton Studios, 

where Nikons were used for most 

jobs, though I kept an Olympus 

Mju II in my pocket all the time. 

When digital arrived, I discovered the 

XZ-1, which fitted me like a glove. 

I embraced the Micro Four Thirds 

system like a long-lost sibling.” 

Olympus says: “Andrew has 

a unique portfolio of work that 

showcases the creative potential of 

Olympus’ cameras and lenses. He’s 

embraced mirrorless and has shown 

that it can hold its own in one of the 

industry’s most competitive arenas.” 

Andrew Farrington’s 
beguiling portraits  
blur the lines between 
photography and art.
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ANDREW FARRINGTON 

THE STYLE 
COUNSEL



1
Olympus OM-D E-M1 Mark II 

The bigger battery and dual memory card 

slots allow me to work for longer without 

having to worry about the spontaneity of a shoot 

being marred by a full card or a battery change. 

2
Olympus M.ZUIKO DIGITAL 

ED 25mm f/1.2 PRO

Unbelievable sharpness, even wide open,  

and with bokeh to die for. Super-quick AF, especially 

when coupled with Olympus’ E-M1 MkII, and really  

close minimum focusing distance. It sits perfectly  

with the E-M1 and PEN-F bodies with battery grips. 

3
Olympus M.ZUIKO DIGITAL 45mm f/1.8

Such a great portrait lens and another one  

that’s phenomenal when used wide open. It’s tiny 

compared to an 90mm full-frame equivalent and is subtly 

flattering in its rendering, though even at f/1.8 it can be too 

sharp for some types of portrait. It doesn’t take prisoners 

and should be used with caution on more sensitive subjects!

Andrew’s three Olympus essentials
constant feedback of the effect on the 
image. Lenses must have ‘character’ – 
many modern lenses are so technically 
precise they’re almost clinical in their 
reproduction. Olympus creates lenses 
that have a unique signature that fits 
my vision. Of course, they also make 
many optically perfect lenses too, 
and I mainly use these for product 
and architectural photos. It’s good 
to have a choice and that’s without 
even getting into the third-party and 
vintage optics that can be adapted…

Has switching to mirrorless changed 

the way you work? 

Mirrorless has given me confidence in my 
visual instincts. Having learned the hard 
way with film, it’s become an extension 
of my mind’s eye. Being able to see every 
change in real time is something that 
can’t be taken for granted. Clients know 
what they’re getting and that breeds 
further creative confidence and 100% 
more enjoyment of my job and hobby.
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7D Mark II Body £1349
£1219 inc. £130 Cashback*

D5600 �������PP £729
D5600 ��������PP £949

PEN-F  Body £949

PEN-F  ���PP £1149

OM-D E-M5 II Body £849

OM-D E-M5 II 

������PP�352 £1249

A7R Mk II Body £2499

A7S II Body £2499 

A7 II                        £1199

A7 £799

A7 �������PP £899

A7S Body £1609

A7R Body £999

NEW  77D Body £799
£714 inc. £85 Cashback*

NEW  77D �������PP £919
£834 inc. £85 Cashback*

NEW  77D ��������PP £1149
£1064 inc. £85 Cashback*

()���PP�I���/�,,�860 .......................£1499
£1329 Inc. £170 Cashback*

()�6���PP�I����0DFUR�,6�670 .........£399
()���PP�I����/�,,�860 ......................£1799
£1584 Inc. £215 Cashback*

()����PP�I����/�,6�860�0DFUR ........£799
()����PP�I��/�860 ..........................£859.97
()����PP�I����/�860�0DFUR ............£1229
()����PP�I����/�860�0.,, ...............£699
()����PP�I����/�,6�,,�860 ................£5799
()����PP�I����/�860 .......................£1111.50
()�����PP�I��/�860�)LVKH\H ...........£1119
()�6������PP�I���������,6�670 .........£199
()�6������PP��I��������860 .............£499
()������PP�I��/�860........................£2699
()������PP��I���/�,,,�860 .................£1899
£1684 Inc. £215 Cashback*

()������PP�I��/�,6�860 ...................£899
()�6������PP�I�����,6�860 ...............£718
()�6�������PP�I��������,6�860 .......£429
()������PP�I��/�,6�860 ...................£699
()������PP�I���/�,,�860 ..................£1699
£1484 Inc. £215 Cashback*

()�������PP�I��������/�,6�860 .......£2249
()�������PP�I����/�,6�,,�860 ...........£1899
£1684 Inc. £215 Cashback*

()�������PP�I��/�860 .....................£578
()�������PP�I������/�,6�860 ..........£1200
()��������PP�I��������/�,6�,,�860 ..£1789

NEW GX800
�������PP £379
GX8��������PP £799
GX80��������PP £530

D7200

D7200 Body £859
D7200 ��������PP £1099

5DS Body £2949
5DS R Body £3149

5D Mark IV Body £3349

   24.2���PS
6.0���ISV
1080p

77D       ��������)URP�£799

 EOS  7D Mark II EOS  77D

   20.2���PS
10.0���ISV
1080p

7D Mark II £1349

 5D Mark IV       £3349

   30.4���PS
7.0 ��ISV

Full Frame

 EOS 5D 
Mark IV

 EOS 5DS

50.6���PS
5.0���ISV

Full Frame

5DS Body            £2949

 D5600

   24.2���PS
5.0���ISV
1080p

D5600 )URP�£649

   24.2���PS
6.0���ISV
1080p

D7200 )URP�£859

D850

NEW D850 Body £3499

   45.7���PS
6.0���ISV
1080p

D850 £3499

X-T2

   24.3���PS
14���ISV

1080p

PEN-F

   20.3���PS
10.0���ISV
1080p

PEN-F 

Body  £949

A7R Mark II 
Black

42.0���PS
5.0���ISV

4K YLGHR

A7R Mark II )URP

£2499
A6500 Body £1279

A6500 �������PP £2199

A6300 Body £829

A6300 �������PP £999

A6500
Black or Silver

24.0���PS
11.0���ISV
1080p

A6500
)URP£1279

 GX800

16 ��PS
30���ISV

4K YLGHR

DMC-GX800

)URP�£379

á��2YHU��������3URGXFWV��á��)UHH�'HOLYHU\�RQ�Ö���RU�RYHU��á��:H�FDQ�GHOLYHU�RQ�6DWXUGD\�RU�6XQGD\π

Canon Lenses

NEW  6D Mark II Body £1999
NEW  6D Mark II
��������PP�,6�670 £2379

 EOS  6D Mark II

   26.2���PS
6.5���ISV

Full Frame

 6D Mark II )URP�£1999

1D X Mk II Body £4799

 EOS 1D X 
Mark II

   20.2���PS
16.0���ISV

Full Frame

1D X Mk II £4799

New

NEW OM-D E-M1 II 
Body £1849

NEW OM-D E-M1 II
������PP £2399

OM-D E-M1 II

20���PS
60���ISV

OM-D E-M1 II

)URP  £1849

New
New��PP�I��� .....................£369

��PP�I��� .....................£249

��PP�I����3UR...............£209

��PP�I����0DFUR ..........£365

��PP�I��� .....................£699

���PP�I��3UR................£2099

����PP�I����3UR ...........£999

�����PP�I����3UR .........£799

������PP�I��3UR ..........£1099

������PP�I����3UR .......£1125 

������PP�I������� ........£389

Olympus Lenses

GH5 Body £1699
GH5��������PP�I��������£1899
GH5��������PP�I������� £2199
G80 Body £629
G80��������PP £799
G7��������PP £499
G7��������PP £549

��PP�I��� .................£148

�����PP�I��� ............£699

�����PP�I������� ......£359

������PP�I��� ..........£799

������PP�I����� .......£179

������PP�I������� ....£349

�������PP�I����� .....£1299

�������PP�I����� .....£569

GH5

20.3 ��PS
12���ISV

4K YLGHR

DMC-GH5 )URP

£1699

Panasonic Lenses

��PP�I����*�$)�6�';�0LFUR ...........................£259
��PP�I����*�$)�6 ...........................................£429
���PP�I����*�$)�6�95�,)�('�0LFUR ...............£769
�����PP�I��������*�$)�6�';..........................£745
�����PP�I��*�$)�6�('�95 .............................£1029 
������PP�I��������*�$)�6�';�('�95�,, ........£649
������PP�I��������*�('�95�$)�6�'; ...........£629
�����PP�I����*�$)�6�(' ................................£1549
������PP�I��������*�$)�6�('�95 .................£829

Nikon Lenses

X-T2 Body £1399
X-T2 �������PP £1649
X-T20 �������PP£899

X-T2 )URP

£1399

X-Pro2

24.3���PS
8.0���ISV

Full Frame

X-Pro2 )URP

£1349
X-Pro2 Body £1349
X-Pro2 ��;)��PP £2149

��PP�I��� ....................£769

��PP�I��� ....................£748

��PP�I� .......................£399

��PP�I� .......................£349

��PP�I� .......................£449

��P�I��� .......................£768

��PP�I� .......................£749

��P���PP�I� ...............£759

�����PP�I��� ...............£848

������P�I������� ..........£599

������PP�I��� .............£1329

�������P�I������� ........£1499

)XML¿�OP�/HQVHV
��PP�I����266 ............£319

��PP�I��� .....................£279

��PP�I���� ....................£749

��PP�I��� .....................£889

�����PP�I� ...................£699

�����PP�I� ...................£1149

�����PP�I� ...................£779

������PP�I��* .............£469

������PP�I������� ........£579

�����PP�I��� ................£1899

�����PP�I� ...................£879

Sony E-Mount Lenses

For Fuji accessories visit wex.co.uk For Sony accessories visit wex.co.uk

For Olympus 

accessories visit 

wex.co.uk

For Panasonic 

accessories 

visit wex.co.uk

*Canon Cashback ends 17.10.17

CMOS

New

New



YLVLW�ZH[�FR�XN
�������������
Call us Mon-Fri 8am-7pm, Sat 9am-6pm, Sun 10am-4pm

Unit B, Frenbury Estate

Off Drayton High Road,

Norwich. NR6 5DP.

2SHQ�IURP���DP�GDLO\�

:H[�6KRZURRP

Lumix LX100 ........... £499

Lumix LX15 ............. £568

Lumix FZ1000 ......... £569

Lumix TZ70 ............. £249

Lumix FZ330 ........... £449

Lumix FZ82 ............. £329

Lumix TZ100 ........... £528

Lumix TZ80 ............. £329

$LU�/LJKWLQJ�
6WDQG�
£69

/XPLPXVH
/('�/LJKWV
)URP £44.95

�(]\ER[�6SHHG�
/LWH����

£49.95
 L308s
£189

3OXV�,,,�6HW
£229

�P�+HDY\�'XW\�
%DFNJURXQG�
6XSSRUW

£99

�'�/LWH�5;����
6RIWER[�6HW�

£725

8UEDQ�
&ROODSVLEOH�
%DFNJURXQG�

£165

PowerShot G9 X Mark II

£399

X100F £1249

PowerShot G5 X

£599

Coolpix P900 £479

GR II Digital £529

Theta S Digital 
Spherical 
Camera 

£299

Extreme Pro: 95MB/s 

SDHC

��*% ...............£29.99

��*%�6';&.....£44.99

SanDisk Extreme Pro: 

160MB/s UDMA 

CompactFlash

��*% ...............£39.99

G Series: 299MB/s SDHC

��*% ................... £99.99

��*% ................... £199

���*% ................. £379

M Series: 260MB/s SDHC

��*% ................... £59.99

��*% ................... £84.99

���*% ................. £139

G Series XQD: 440MB/s

��*% ................... £99.99

��*% ................... £199.99

���*% ................. £279

M Series XQD: 440MB/s

��*% ................... £74.99

��*% ................... £129

���*% ................. £199

��*% .............. £64.99

��*%  ............. £119

���*% ............ £199

SanDisk Ultra 98MB/s 

Micro SD Card plus 

adapters: 

��*% ...............£22.99

��*% ...............£40.99

MT055XPRO3 .......... £159
MK055XPRO3
��;�3UR���:D\�+HDG £259
MK055XPRO3
�����5&��%DOO�+HDG £169
MT055CXPRO3
&DUERQ�)LEUH ............ £329
MT055CXPRO4
&DUERQ�)LEUH ............ £345
MT190XPRO3 .......... £149
MT190XPRO4 .......... £159

Gitzo Systematic 

Tripod 

Series 5 6S G

á����FP

0D[�+HLJKW�

á���FP

0LQ�+HLJKW�

á���&DUERQ�)LEUH�

Systematic Tripods:

6HULHV����6�/ ...............£759
6HULHV����6�/ ................£819
6HULHV����6�* ...............£1099

 Hadley FRORXUV�DYDLODEOH�

 Canvas/Leather: 

Khaki/Tan, Black/Tan, Black/Black. 

FibreNyte/Leather: Khaki/Tan, 

Sage/Tan, Black/Black.

�'LJLWDO ..............................£119
6PDOO ...............................£149
/DUJH ...............................£154
��3UR�2ULJLQDO .....................£189
+DGOH\�2QH .....................£265

3L[PD�

3UR����6

 Gorillapod:
&RPSDFW ............£16.99
+\EULG ................£29
6/5�=RRP .........  £44.99
)RFXV�*3�� .......£89

Cyber-Shot WX500 ......£229 

Cyber-Shot RX100 III ...£579

Cyber-Shot RX100 IV ...£729

Cyber-Shot RX10 III ......£1399

Cyber-Shot RX1R II ......£2999

Cyber-Shot RX100 II .....£419

Cyber-Shot RX100 ........£349

PIXMA Pro 100S ...................£369

PIXMA Pro 10S .....................£504.99
imagePROGRAF PRO-1000 £999

IXUS 185 HS ............................£99

IXUS 285 HS ............................£159

PowerShot SX60 HS ..............£329

PowerShot SX730 HS ............£349

PowerShot G3 X .....................£649

£609 inc. £40 Cashback*

5HORDGHU��� .....................£299

3URIHVVLRQDO��� ...............£89

3URIHVVLRQDO��� ...............£159

3URIHVVLRQDO��� ...............£154

MT190CXPRO3
&DUERQ�)LEUH ............ £299
MT190CXPRO4
&DUERQ�)LEUH ............ £318
Manfrotto 190 GO
&DUERQ�)LEUH ............ £249

Manfrotto Heads:

494RC2 0LQL�%DOO ..... £49

324RC2 -R\VWLFN ...... £99

327RC2�-R\VWLFN ...... £169

PowerShot G7 X Mark II

£541

����(;�,,,�57
£239

SanDisk 
USB 3.0 
,PDJH0DWH�
5HDGHU�

£39.99

Coolpix W300 £389

Cyber-Shot HX90V £339

Coolpix B700 £399

Lumix FZ2000 £999

Pro Runner:

%3�����$:�,, .............. £139

%3�����$:�,, .............. £169

Photo Sport BP:

����$: ........................ £99

����$: ........................ £129

Anvil:

$QYLO�6OLP...................£122

$QYLO�6XSHU ................£134

$QYLO�3UR ....................£129

6%�����
£499

�������������������á�����'D\�5HWXUQV�3ROLF\Ü ��á��3DUW�([FKDQJH�$YDLODEOH��á��8VHG�LWHPV�FRPH�ZLWK�D����PRQWK�ZDUUDQW\ÜÜ

 Digital Compact Cameras 

   20.2���PS

4.2[�]RRP

1080p

   20.2���PS    20.1���PS

4.2[�]RRP 3[�]RRP

1080p 1080p

16.0���PS

5[�]RRP
4K YLGHR

   20.3���PS

60[�]RRP
4K YLGHR

   16.0���PS

83[�]RRP

12���PS

4[�]RRP
4K YLGHR

Stylus TG-5 £399 Ricoh WG-50 £249

16 PS

5[�]RRP
Z�SURRI

   24.3���PS

CMOS
1080p

20.9���PS
40[�]RRP

4K YLGHR

18.2���PS

30[�]RRP

1080p

 Memory Cards & Readers

G Series:

M Series:

 Photo Bags & Rucksacks

Photo Sport BP 

200AW�FDSDFLW\�

ï� '6/5

ï 2 lenses

ï� ��/WU�UHVHUYRLU�

� �QRW�LQFOXGHG��

ï� )ODVKJXQ�	

� DFFHVVRULHV

Anvil Slim 11

FDSDFLW\�

ï� &6&�6PDOO�

� '6/5

ï 2 lenses

ï� ��µ�/DSWRS

ï� )ODVKJXQ�	

� DFFHVVRULHV

Manfrotto Reloader 

55 Roller Bag

3UR�/LJKW�5LS�6WRS�

Q\ORQ�IDEULF�ZLWK�

ZDWHU�UHSHOOHQW�

FRDWLQJ�WR�SURYLGH�

VROLG�SURWHFWLRQ��

7KLV�FRPIRUWDEOH��

VW\OLVK�EDJ�LV�LGHDO�WR�

WUDYHO�ZLWK�

Manfrotto 
Professional 

Backpack 20

:DWHU�UHVLVWDQW�
ZLWK�H[WHUQDO�
VWUDSV�WR�DWWDFK�D�
WULSRG��&DSDEOH�RI�
¿�WWLQJ�D�3UR�'6/5��
DGGLWLRQDO�FDPHUD�
ERG\����OHQVHV�
DQG�PRUH�

 Tripods & Heads

MT190XPRO3

ï 0D[�+HLJKW�����FP

ï 0LQ�+HLJKW���FP

 Lighting & Accessories

327RC2

-R\VWLFN�+HDG

 Terms and Conditions $OO�SULFHV�LQFO��9$7�DW�
����3ULFHV�FRUUHFW�DW�WLPH�RI�JRLQJ�WR�SUHVV��
)UHH�'HOLYHU\�DYDLODEOH�RQ�RUGHUV�RYHU�Ö���
�EDVHG�RQ�D���GD\�GHOLYHU\�VHUYLFH���)RU�RUGHUV�
XQGHU�Ö���WKH�FKDUJH�LV�Ö������EDVHG�RQ�D�
��GD\�GHOLYHU\�VHUYLFH���)RU�1H[W�:RUNLQJ�'D\�
'HOLYHU\�RXU�FKDUJHV�DUH�Ö����� π6DWXUGD\�
GHOLYHULHV�DUH�FKDUJHG�DW�D�UDWH�RI�Ö������
π6XQGD\�GHOLYHULHV�DUH�FKDUJHG�DW�D�UDWH�

Ö������'HOLYHULHV�RI�YHU\�KHDY\�LWHPV��1�,���
UHPRWH�DUHDV�RI�6FRWODQG�	�&K��,VOHV�PD\�EH�
VXEMHFW�WR�H[WUD�FKDUJHV���(��	�2�(��3ULFHV�

VXEMHFW�WR�FKDQJH��*RRGV�VXEMHFW�WR�DYDLODELOLW\��
/LYH�&KDW�RSHUDWHV�EHWZHHQ�����DP��SP�
0RQ�)UL�DQG�PD\�QRW�EH�DYDLODEOH�GXULQJ�SHDN�
SHULRGV��Ü6XEMHFW�WR�JRRGV�EHLQJ�UHWXUQHG�DV�
QHZ�DQG�LQ�WKH�RULJLQDO�SDFNDJLQJ��:KHUH�
UHWXUQV�DUH�DFFHSWHG�LQ�RWKHU�LQVWDQFHV��WKH\�
PD\�EH�VXEMHFW�WR�D�UHVWRFNLQJ�FKDUJH��ÜÜ$SSOLHV�
WR�SURGXFWV�VROG�LQ�IXOO�ZRUNLQJ�FRQGLWLRQ��1RW�
DSSOLFDEOH�WR�LWHPV�VSHFL¿�FDOO\�GHVFULEHG�DV�
¥,1µ�RU�LQFRPSOHWH��LH��EHLQJ�VROG�IRU�VSDUHV�
RQO\���:H[�3KRWRJUDSKLF�LV�D�WUDGLQJ�QDPH�RI�
:DUHKRXVH�([SUHVV�/WG��UHJLVWHUHG�DV�FRPSDQ\�
QR������������9$7�QXPEHU���������������

ã:DUHKRXVH�([SUHVV�/WG�������

&$6+%$&.6�$UH�UHGHHPHG�YLD�SURGXFW�
UHJLVWUDWLRQ�ZLWK�WKH�PDQXIDFWXUHU��3OHDVH�UHIHU�

WR�RXU�ZHEVLWH�IRU�GHWDLOV�

Showroom:�RII�'UD\WRQ�+LJK�5RDG���RSSRVLWH�
$6'$��1RUZLFK��15���'3�
0RQ�	�:HG�6DW���DP��SP��

7XHV���DP��SP��6XQ���DP��SP

&RPSHWLWLYH�
SULFHV

)UHH�FROOHFWLRQ��
RI�\RXU�JHDU

)DVW�WXUQDURXQG
RI�\RXU�TXRWH�
DQG�FUHGLW

�������XVHG�SURGXFWV�LQ�VWRFN

Trade in,
to 

trade

More Camera
moneyfor your

up

wex.co.uk

wex.co.uk

16.2���PS

3.1[�]RRP

1080p

Pro Runner BP 350 

AW II�FDSDFLW\�

ï� 3UR�'6/5�ZLWK�OHQV

ï������DGGLWLRQDO�OHQVHV

ï��)ODVKJXQ��WULSRG�

� ODSWRS�	�DFFHVVRULHV

12���PS

8JE�PHP�

1080p

Coolpix A900 £329 Coolpix B500 £239

   16.0���PS

80[�]RRP

   20.3���PS

70[�]RRP

Accessories including spare 

batteries are available to buy on 

our website

Accessories including spare batteries are 

available to buy on our website

£564 inc. £35 Cashback* *Canon Cashback ends 17.10.17



Shop online at www.srb-photographic.co.uk

Call our experts (Mon-fri 9am-4.30pm) 01582 661878

visit srb-photographic.co.uk for more!

Infrared
Skylight
Black & White
Colour Grad
6WDU�(�HFW

from £19.95
from £9.95
from £7.50
from £14.95
from £12.95

More Filters...UV Filters

from £12.50

ND Fader Filters

from £29.95

Push-on Holder
Professional Kit
Upgrade Kit
Adaptor Rings from

ND Filters from

£115.00
£115.00
£75.00
£20.00
£78.00

Tripods & Monopods

Accessories

LEE Filters 100mm System

&LUFXODU�→OWHU�VL]HV�UDQJH�IURP���PP�WR����PP�GHSHQGLQJ�RQ�
WKH�→OWHU���9LVLW�srb-photographic.co.uk for more!

Award-winning SRB Photographic brand

100mm 
Starter Kit

from £139.95

*Exclusive*

Circular Polarisers

ìHighly Ratedî
- Practical Photography, June 2016

- NPhoto Magazine, August 2016 - Digital Photo, 2015

Neutral Density Filters

from £16.95 from £13.95

��� ���

��� ���

- Digital Camera, ND Group Test

5 stars in DCís ND 
Group Test 

ND1000 Filters
from £24.95

Best Value in Photoplus 
Big Stopper Group Test

Plastic Filter System

Adaptor Rings £4.95

P Size
£4.95

A Size
£8.95

��[�+ROGHU����[�$GDSWRU�ULQJ

Filter Kit
A Size  £44.95
P Size  £44.95

Starter Kit
A Size  £29.95
P Size  £24.95

��[�3�RU�$�6L]H�→OWHUV
SAVE upto £14!!

Full ND
Soft ND Grad
Hard ND Grad
Black & White
Landscape

£39.95
£39.95
£39.95
£39.95
£34.95

Square Filter Sets

Individual Square Filters

0.3 Full ND
0.6 Full ND
0.9 Full ND

£14.95
£14.95
£14.95

0.3 Soft ND
0.6 Soft ND
0.9 Soft ND

£14.95
£14.95
£14.95

0.3 Hard ND
0.6 Hard ND
0.9 Hard ND

£14.95
£14.95
£14.95

Sunset Grad
6WDU�(�HFW

P Size 6-Stop Filter

P Size ND1000

Pro Glass ND Filters

£14.95
£14.95
£29.95

£29.95

£22.95

$�6L]H�	�3�6L]H�UHVLQ�VTXDUH�→OWHUV

- Digital Photo, 2014

1   9   6   7   -   2   0   1   7

SRBPHOTOGRAPHIC
Celebrating 50 years of SRB

ìSRB are a company who are vital to the optical 
LQGXVWU\�DW�ODUJH��7KH\�DUH�WKH�JR�WR�→UP�①

3URIHVVLRQDO�ΖPDJHPDNHU�0DJD]LQH

FREE UK Delivery
*spend over £40

Get it next day!
*order before 3pm

Check out our huge 
range of Lens Adaptors

Digiscoping Kits from £34.95!
Step Rings, Macro accessories & 
much more at our online store!

www.srb-photographic.co.uk
6LJQ�XS�WR�RXU�PDLOLQJ�OLVW�IRU�WKH�ODWHVW�QHZV�DQG�R�HUV�

On-it Carbon Fibre
Monopod

��0D[��+������PP
��0LQ��+�����PP
��:HLJKW�����J
��0D[��/RDGLQJ����NJ
��&DUU\LQJ�&DVH

Monopod
Feet/Stand

£29.95
£14.95Colours: Black, Red

28mm On-it Carbon 
Fibre Tripod

Practical Photography, 2016

��0D[��+������PP
��0LQ��+�����PP
��:HLJKW�����NJ
��0D[��/RDGLQJ������NJ
��&DUU\LQJ�&DVH

only£149.95

25mm On-it Carbon 
Fibre Tripod

��0D[��+������PP
��:HLJKW�����NJ
��0D[��/RDGLQJ����NJ
��&DUU\LQJ�&DVH

only£119.95

LEE Filters

£17.50
£52.00
£64.95
£65.00
£68.00
£64.95
£190.00
£109.00
£460.00
£69.50

Adaptor Rings
ND Grads
ND Filters
Big Stopper
Little Stopper
Super Stopper
Polariser
Starter Kit
Deluxe Kit
Seven5 Hood

£89.95
£64.95
£95.00
£132.00
£132.00
£129.95
£180.00
£249.00
£18.00
£47.95

Mark II Adaptors
Screw-in Adaptors
ND Filters from

Big Stopper
Little Stopper
Super Stopper
Polariser
ND Filter Sets
Lightshield
Filter Pouch

Dust Blowers from

Rainsleeves from

Cleaning Kits from

Camera Wraps from

Cleaning Cloths from

Lens Pouch from

White Balance Caps from

£3.50
£5.95
£5.95
£8.95
£1.50
£8.50
£9.95

Lens Pockets from

Square Filter Wallet
Circular Filter Pouch
6HO→H�6WLFN�%XQGOH

Spirit Levels from

Bluetooth Remote
Lens Pen
Memory Card Case
Angled View Finder

£3.95
£9.95
£5.95
£9.95
£3.50
£3.95
£4.95
£9.95
£39.95

Lens Caps

Body Caps

Rear Lens Caps

Petal Hoods

Rubber Lens Hoods

£3.95

£3.50

£3.50

£10.95

£4.95
Auto Extension Tubes from

Manual Extension Tubes

£29.95

£17.50

OpTech Comfort

OpTech Wrist Strap 

OpTech Tripod Strap

£9.99

£9.99

£19.99 P Size Hood £34.95

Close up Lens Sets from £19.95

3KRWR�3OXV������
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Square Filters Circular Filters7KH�QHZ�3�6L]H Elite Filter System

♠:HOO�PDGH�	�GHVLJQHG�→OWHU�V\VWHP�
that lifts the semi-pro P system to a 
KLJKHU�OHYHO① I��&DPHUFUDIW�0DJD]LQH

TOP SELLER

Seven5 Holder
£59.50

LEE Filters 
Seven5 System

LEE Filters 
SW150 System

SW150 Mark II 
Holder
£150.00

ìYou could easily 
expect to pay that 
for the lightweight 
DOOR\�KHDG�DORQH①
I��&DPHUFUDIW�0DJD]LQH

Big Stopper
Little Stopper
Landscape Polariser
Filter Sets from

Digital Starter Kit

£99.95
£95.99
£173.99
£100.00
£219.95

Foundation Kit
£59.95

Super Stopper
£99.95

TOP SELLER

NEW

NEW

SAVE

SAVE

Elite Filter Holder
Elite Adaptor Rings
Elite Polariser
Elite ND1000
Elite 6 stop

£34.95
£5.95
£24.95
£29.95
£29.95NEW
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HUNDREDS OF PLACES WHERE YOU
CAN SELL YOUR PHOTOS FOR CASH!

OUT NOW! The latest edition of 
The Freelance Photographer’s
Market Handbook

Described as the photographer’s bible, this
208-page BFP Handbook has hundreds of
markets where you can sell your pictures for
£££s. It includes magazines, greetings card
and calendar publishers, picture libraries,
newspapers, book publishers etc.

The Freelance Photographer’s Market
Handbook gives full details of the type of
photos – subject matter etc – being sought,
fees paid, and exactly where to send your
pictures.

Price: £15.95 + £2.00 P&P

SPECIAL OFFER: Join the Bureau of
Freelance Photographers (BFP) and 
get 14 months membership for the 
price of 12!

For almost 50 years, the BFP has been helping
photographers like you to sell their photos. 

As well as getting the 208-page Freelance
Photographer’s Market Handbook with 
hundreds of markets for photos, you’ll also
receive our monthly Market Newsletter keeping
you up to date with current picture needs. 

You may also take advantage of our Advisory
Service offering personal help on any aspect of
selling photos.

All for just £54 per annum. Join now and get
14 months membership for the price of 12!

NEW! The BFP Freelance
Photography Course

While the BFP Handbook (above) will show
you WHERE to sell your photos, this lavishly
illustrated manual will show you HOW to
sell them.
It’s a practical course with 16 lessons 
covering everything you need to know to
sell your pictures to magazines, greetings
cards, calendars, newspapers, books etc. 
When ordered from the BFP, it comes with 
a set of tutorials to guide you through 

the lessons.

Price: £25.00 + £2.00 P&P

To join the BFP ■ To order BFP books 
Go to www.thebfp.com 

Phone 01707 651450 
Or send a cheque to: 

Bureau of Freelance Photographers
Freepost 

Vision House PO Box 474 
Hatfield AL10 1FY

www.frenchphotographicholidays.com
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Nikon D850
Is this feature-packed 

DSLR the camera to put 

Nikon back at the top of every 

photographer’s most-wanted list?
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Canon M100
Petite, portable 

and perfect for selfies. 

140
Best under £650
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2
Your RAW
You can choose a range 

of RAW sizes, L, M or S (45, 25 

and 11MP, respectively), which 

allow you to cater your file sizes 

to the job at hand, especially 

if you want to avoid hundreds 

of gigabytes of images. 

3
Weather proof
As with its predecessor, 

the D850 has extensive weather 

proofing, perfect for ensuring 

you have the confidence to get 

the shot in any condition.

1
Massive megapixels
The D850 packs a hefty 

45.7MP full-frame sensor, 

capable of capturing superb 

detail and amazing dynamic 

range in every shot.
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N
IKON HAS BEEN 
celebrating its 
100th anniversary 
in style, with 

a plethora of branded 
releases, a clothing line 
and the excellent D7500. 
Apart from this, however, 
things have seemed a bit 
quiet on the tech giant’s 
schedule. Which is why the 
announcement of the D850’s 
development sent the 
photography community 
into a bit of a frenzy. Skip 
forward a month and I was 
lucky enough to be at the 
press event where it was 

unveiled – and if I had to 
describe it in one word, 
it would be glorious. 

Main features
Stepping up against such 
recent 45+ MP releases, 
such as the Sony α7R II and 
the Canon 5DS, the D850 
has upgraded from the 
36.3MP sensor to a backside 
illuminated 45.7MP sensor. 
It also includes the new 
EXPEED 5 processor (as 
seen in the D5, D500 and 
D7500), which is put to good 
effect when recording the 
45MB+ RAW files or full 

4K UHD video. It boasts 
the world’s lowest DSLR 
or mirrorless native ISO of 
64 (expandable to 32), and 
also manages a native high 
of 25,600 and an expanded 
maximum of 102,400. 

Alongside the high 
resolution, Nikon has 
managed a speedy 7fps burst 
mode (6fps when using 
Live View, or 9fps with 
the optional battery grip 
and EN-EL 18b battery), 
with a buffer that can hold 
51 RAW images, although 
this will soon fill up if 
using the higher burst rate.

With a massive 45.7MP sensor, blistering 7fps,  
maximum ISO 25,600, full 4K UHD and a silent shooting 
mode, Kirk Schwarz asks, is this the new king of full-frame?
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NIKON D850

4
Intuitive ISO 
The ISO control 

has moved to a dedicated 

button, found just behind 

the shutter button – similar 

to the D500 and D5.

4

3

2

1

KIT PRICE

£3499

IMAGE RESOLUTION

45.7MP

VIDEO

4K UHD

A swift 
resolution
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The D850 offers silent 
shooting when using its 
2359k-dot 3.2in touchscreen, 
as well as letting you focus 
and capture by touch. 8K 
time-lapse is included, 
alongside in-built time 
stacking (up to a whopping 
300 images), using the 
interval timer. It uses the 
same autofocus system as 
the D5, meaning a mammoth 
153 points, including 99 
cross-type points, which is 
accurate down to -4EV in the 
centre and -3EV on the outer 
points (equal to moonlight).  

Handling & build
The appearance is very 
reminiscent of the D810 
and D800, with very little 
changing in the aesthetics. 
As you would expect, it 
features very robust weather 
proofing and the usual high 
quality construction, feeling 
pleasingly hefty in-hand. The 
sturdy design is backed up 
with a deep grip, familiar to 
anybody used to a full-frame 
Nikon, and an ISO button 
which has moved to the back 
of the shutter release button, 
in line with the newer design.

Performance
Off the bat, this is fast, 
accurate and packing 
exquisite detail in that 
45.7MP. The upgraded 
focus system is blistering, 
including all the tracking 
features which made the
D500 a big draw for wildlife, 
while also pleasing any pixel-
peepers, meaning it really 
is an all-in-one DSLR. The 
inclusion of a touchscreen 
brings one of the best touch-
to-capture experiences I’ve 
had (especially since this 
activates the silent shutter 
mode), with the lag being 
noticeably reduced from many 

other cameras. When you use 
it, the focus locks, allowing 
you to revert to the shutter 
button to carry on capturing 
your shot, without any lag. 
The ISO is a vast step-up 
from its predecessor, with 
files at 25,600 looking very 
fresh, retaining detail and 
being incredibly usable. Nikon
let us take away our sample 
images – though there’s no 
way to read RAW yet – and 
the JPEGs look impressively 
clean, with an insane amount 
of detail being captured and a 
phenomenal dynamic range. 
We didn’t manage to take 
any 4K video away, but from 
what we saw on screen it’s 
very crisp and full of detail. 
According to Nikon, the new 
EN-EL15a battery offers 1850 
shots from a single charge, 
and the optional MBD18 

grip and EN-15B battery 
will provide an unheard of 
5140 shots. I also loved the 
ability to shoot in three sizes 
of RAW file, meaning you 
don’t have to shoot in full 
resolution for every shot.

Verdict
The Nikon D850 is undeniably 
at the top of its game. It’s a 
fully updated, feature-rich 
DSLR, which has included 
more innovation than 
many recent releases from 
the competition. The high
resolution pairs well with
the fast burst rate, as well 
as including uncropped 4K 
UHD video. There’s no doubt 
that this will put Nikon 
back at the top of the want 
list for every type of serious 
photographer. Catch our 
full review next month.
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Nikon’s full-frame offerings are renowned 

for high amounts of dynamic range and 

exceptional detail, especially after the 

D800E abandoned the optical low-pass 

filter, and the D850 continues this tradition 

well. The 45.7MP sensor means that the 

finest details are captured, and the 

dynamic range, from what we’ve seen, is at 

least on a par with the D810 – around the 

14-stop mark. The colour rendition and 

white balance are brilliant, having shot  

in mixed lighting with zero issues. I was 

especially amazed at the speed of the 

silent mode in Live View shooting, 

perfect for weddings, or anywhere  

you need discretion. Simply selecting 

your point by touch will lock the focus, 

allowing you to shoot up to 6fps using the 

shutter release button without a sound. 

High resolution, 
exceptional detail

IMAGE 
QUALITY

Technically it’s not new, featuring on the 

flagship Nikon D5 and D500, though it is a 

vast step up in autofocusing power from  

the D810’s 51-point AF (which included  

15 cross-type points), which is something 

that deterred wildlife and sports shooters. 

This highly capable system also brings a 

massive 99 cross-type points, as well as 3D 

tracking and an extremely impressive group 

AF, all of which create an accurate focusing 

experience, as well as using the additional 

battery grip to capture a blistering 9fps. 

  New tech Amazing 153-Point AF 

“IF I HAD TO DESCRIBE  
IT IN ONE WORD, IT  
WOULD BE GLORIOUS...”
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T
past year. As well as offering
the best selling DSLR on the
market, the EOS M10 is also
the best-selling mirrorless
camera – though it’s been
showing its age in recentshowing its age in recent
times. The Japanese techtimes. The Japanese tech
giant has also revampedgiant has also revamped
almost all of its enthusiastalmost all of its enthusiast
range in the last six months,range in the last six months,
with releases such as thewith releases such as the
800D, 77D, M6 and full-frame800D, 77D, M6 and full-frame
successor to the wildly

– and they’re showing no
signs of stopping. At a recent
press event, they revealed
the new Canon M100, a
step-up entry-level mirrorless
camera to replace the M10.
This latest addition has been
designed to bridge the gap for
anybody who’s stepping up
from smartphones or compact
cameras, offering an intuitive
design, all while allowing for
full manual control and RAW
shooting. This means that
as your photographic skills
grow, the M100 will keep up.

Main featuresMain features
Packing in the hugely
successful 80D sensor gives

of 100-25,600 and a full
selection of preset Scene

Handheld Night Scene
and Close-up. It features
a pop-up flash, tilting 3in
1040k-dot touchscreen
(which flips 180º) and
top-mounted control wheel

Featuring the perfect level of control and simplicity, the  
M100 packs Canon’s uber successful 80D sensor, Digic 7 
processor and 3in touchscreen into an ultra portable body.

GetIntoGear

your selfie

CANON M100

2
Tilting touchscreen
You can flip the 

1040k-dot touchscreen 180° 

to face yourself, perfect for 

anybody who wants to film their 

adventures or just shoot selfies 

with some exotic backdrops.

3
The control scheme of 

the M100 is very welcoming 

to newcomers, with two 

top-mounted dials and a basic 

control pad on the rear – if 

you’ve ever used a compact 

you’ll feel at home here.  

1
The M100 has the same 

APS-C sensor as the 80D, 

meaning you get brilliant 

enthusiast-level results from 

a mirrorless point-and-shoot 

without the price tag.

1

Tilting touchscreen

2

KIT PRICE

VIDEO

1080p Full HD

IMAGE RESOLUTION

24.2MP

4
Flash of genius
If you plan on taking 

photos when the light is 

disappearing, the M100 

features a well hidden 

pop-up flash to help 

illuminate your scene.

4

3
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to change your settings on 
the fly. It also comes in a 
range of three colours – black, 
white and silver – as well as 
supporting a range of different 
coloured face jackets, in case 
you want to jazz up your look.

Handling & build
Canon has listened 
to feedback about the 
construction quality of the 
M10, opting to include a 
textured plastic on the M100, 
giving it a more rugged feel 
– although it still doesn’t 
shout premium. Canon is also 
offering optional ‘face jackets’, 
in case you want your camera 
to be as fashionable as your 
wardrobe. The lightweight 
nature (302g, versus the 
M10’s 301g) allows you to 
carry it around without 
causing backache, which is a 
great selling point for those 
who like to travel light. The 
button layout and control 
placement will feel instantly 
familiar if you’re stepping 
up from a compact camera. 

Performance
Canon has been pushing 
its small-form camera 
game lately, with the 200D 

(the smallest DSLR on the 
market) and the M6 both 
being highly portable and 
accessible, though this 
newest entry brings the 
mirrorless beginner-friendly 
range into line, giving it the 
Digic 7 processor and 80D 
24.2MP APS-C sensor found 
in Canon’s recent APS-C 
revamps. It also features 
Canon’s Dual Pixel AF system, 
incorporating up to 49 focus 
points, which means that 80% 
of the frame is an active focus 
point, as well as including a 
384-zone evaluative metering 
system, perfect for accurate 
results when using the 
automated modes (making it 

very accessible for anybody 
who is still building up their 
technical knowledge), which 
all work as well as some of 
Canon’s more comprehensive 
entries. The ISO is comparable 
to the more advanced 77D, 
being relatively noise free at 
ISO 1600, but succumbing 
to noticeable grain from 
ISO 3200 and beyond (very 
respectable for this level 
of camera). It also includes 
dedicated selfie modes (see 
panel below). You can also 
use the Creative Filters to 
give your images a distinctive 
look, such as Grainy, Fish-eye 
and Miniature, though we’re 
not sure how much value 
this will add to your images. 
The M100 includes the usual 
Canon wireless modes – 
Wi-Fi, NFC and Bluetooth 
– so you can transfer your 
images as you take them, 

perfect for getting your shots 
straight onto social media.

Verdict
The M100, much like the 
M10, isn’t designed to be a 
professional workhorse, but 
rather a constant companion. 
The small form and light 
design, along with the 
compact nature of the EF 
lenses, all lend themselves to 
wanderlust. It’s been designed
as a step-up for anybody who 
likes the idea of photography, 
but isn’t ready to invest in a 
DSLR – selling much of its 
appeal on smartphone-like 
touch control, as evident 
in the flipping touchscreen 
and selfie modes – which 
will target compact camera 
fans and Instagrammers, 
while offering a higher 
image quality and more 
comprehensive controls.
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As we’ve come to expect from the current 

line-up of Canon APS-C sensor bodies, the 

M100 includes the same sensor found in the 

80D, which means it produces identical 

quality as you’d find in cameras such as the 

77D, 800D, 200D and M6. If you’re looking for 

a beginner body, but don’t want anything too 

large or imposing, this is a good place to 

start. The rear touchscreen offers Live View 

and touch operation, and the automatic 

modes and Scene Modes allow you to 

compose your shot and get great exposure 

straight out of the box. The colour rendition 

is vibrant and the ISO performance is solid 

up to ISO 1600, though it does start dropping 

beyond that point. The dynamic range is also 

a good step up from anybody currently using 

a smartphone or point-and-shoot compact. 

That same great 
Canon qualityIMAGE 

QUALITY

Selfies, love them or loathe them, are an 

integral part of society – entire social media 

sites are littered with amusing mug shots. 

While many of us with wrinkles and hard 

earned life-scars may shy away, Canon has 

kindly thought of us. Using the 1040k-dot 

3in touchscreen when tilted 180¼ allows you 

to take advantage of the Portrait Scene 

modes, such as skin smoothing, adding a 

healthy tan or blurring the background, 

faking a shallow depth-of-field – great if 

you’re an active Instagram user.

  New tech Become one with your selfie 

“THE M100 IS AN INSANELY 
PORTABLE CAMERA  
FOR EVERYDAY USE”
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BEST 
VALUE 

CAMERAS

UNDER £650
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We all love the art of photography, 

but sometimes the act of choosing 

a camera can get pretty confusing 

and very expensive. With so many 

different varieties now on the market, 

such as DSLRs, mirrorless and action 

cameras, it’s no longer as simple as

walking into your local high street 

retailer and handing over a wad of 

cash. In celebration of such variety 

in the photographic market, Kirk 

Schwarz has compiled a selection of 

some of his favourite cameras over 

four very specific groups, to help give 

you an idea of what may work best for 

your specific needs – and best of all, 

everything is under £650.

DJI Spark .........................................................£519 ...... P142

Nikon KeyMission 360 ..................................£419....... P143

GoPro Hero 5 Black .......................................£399...... P143

Canon Powershot G9X MkII ........................£399...... P144

Nikon Coolpix A900 .......................................£299 ...... P145

Panasonic TZ90 .............................................£374....... P145

Panasonic Lumix G7 .....................................£499 ...... P146

Olympus OM-D E-M10 MkII .........................£569 ...... P147

Fujifilm X-A3 ...................................................£479 ...... P147

Canon 750D ....................................................£599 ...... P148

Nikon D5300 ...................................................£529 ...... P149

Canon 200D ....................................................£649...... P149

IN THE TEST

IMAGE QUALITY 

First and foremost, we 

wanted to ensure these 

cameras could take a good 

photo. So we relied on  

our test charts for the 

traditional cameras, and 

used ‘real-world’ results  

for the action cams.

FUNCTIONALITY AND USE

We also wanted to see how they operated, with each 

camera gaining points for being easy and intuitive to use.  

In the case of the action cams, we put them into situations 

where they would normally be used and judged the results 

based on all of the above.

HOW WE TESTED 
THE CAMERAS

BEST CAMERAS UNDER £650
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Maybe a controversial entry, the 

DJI Spark isn’t a traditional action 

camera, but its ability to create 

unique perspectives is beyond 

question. It’s a technological 

marvel, gaining 5 stars in our 

last issue, and featuring a 

12MP 1/2.3in sensor, alongside 

face and hand recognition, 

allowing for controller-free 

commands. The benefits of having 

a drone are numerous, letting you 

use your smartphone (or optional 

controller, for greater distance 

and speed) to pilot up to 100m 

away, capturing stills or 1080p 

Full HD video, or even setting it to 

follow you down a mountain... so 

long as you manage it in under 16 

minutes (which is the maximum 

battery capacity). If all of this wasn’t 

enough, it also comes in a tiny 

package, includes sophisticated 

object avoidance systems and the 

ability to perform complex cinematic 

manoeuvres at the touch of a button 

(using the DJI Go4 app). We can’t 

deny how much this little drone 

amazed us, and have no problems 

recommending it highly. dji.com

PROS

It’s a flying 

camera

Tiny size

Robust 

construction 

CONS 

Restrictive laws 

may prohibit flight 

Battery life

RATING

Above The camera uses a 2-axis 

gimbal to stabilise your shots.

SPEC

Weight: 300g

WxHxD: 

143x143x55mm

Battery: 

16 minutes flight

Card type: Micro SD

Max speed: 31mph

Max distance: 1.2mi

DJI

SPARK £519

Above Its small 

size hides a very 

impressive level of 

technology in a 

portable package.
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1
SMALL SIZE

Action cameras 

are designed to  

be small, robust and tough. 

They are purpose-built to 

be ready at the drop of a 

hat to capture your wildest 

adventures and have a 

construction philosophy  

to match. Many are also 

waterproof and shock 

resistant, to a degree, 

allowing you the freedom  

to go places that other 

cameras can’t follow.

2
UNIQUE 

PERSPECTIVE

They’re usually 

intended to give you a 

unique view, which 

traditional cameras can’t 

quite manage. This includes 

the lens design, which is 

usually very wide-angle to 

allow you to capture every 

last detail of your outings.

3
HANDS-FREE 

OPERATION

While not always 

the case, a lot of action 

cameras allow you to 

mount them to clothing, 

suction cups, tripods and 

even helmets – or, in the 

case of the DJI Spark, will 

lock on to you and follow 

you for as long as there is 

battery left. All of this offers 

freedom you don’t get in 

other cameras.

D
O YOU SAVOUR THE RUSH OF WIND 
through your hair? Maybe you want to feel 
the full force of the ocean against your face or 
possibly you just want to take photos and video 
that traditional cameras just don’t cater for. If so, 

it’s likely you’re in need of an action camera. While this is an 
umbrella term with a very wide catchment, including some 
wildly different styles and types of camera, we’re taking a look 
at three of the best offerings, each with a unique strength. 

These thrill-seekers have come on in leaps and bounds 
since the first GoPro hit the shelves all those years ago, 
even capable of keeping up with most premium compact 
cameras. Whether it’s the ability to capture your adrenaline 
seeking in full, glorious 360º, filming your descent down a 
mountain strapped to a pair of flimsy skis with your camera 
clipped to your helmet, or just a little feat such as flying 
over the sea to take photos of you climbing a sheer rock 
face, we have something that is absolutely perfect for you. 

Why buy an action camera?

DREAM IT, DO IT, 
SHOOT IT

ACTION 

CAMERAS
HIGHLY 

RATED
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PROS

360º view

4K UHD video

Interactive 

photos

CONS 

Limited uses

Battery life

Snapbridge is 

temperamental

One can argue that ultra 

wide-angle lenses offer the most 

unique perspective going, so 

when you put two wide-angle 

lenses on one camera and 

allow it to capture a 360º 

image, you’ve got something 

truly intriguing. The KeyMission 

360’s 1/2.3in CMOS sensor 

lets you capture stills and video 

at 21.1MP and 4K UHD at 24fps 

resolution respectively, and using 

the SnapBridge 360/170 app will 

allow you to navigate your results 

by dragging your finger across 

the screen. The lenses are 1.6mm 

(8.2mm in 35mm equivalent) with 

a fixed aperture of f/2 and focus of 

30cm-infinity to get the most from 

your images. The unit itself is very 

robust, able to withstand going 

underwater up to a 20m depth 

(with the protective lens cases 

attached). While the image quality 

isn’t what you’d get from a DSLR, 

the novelty of uploading a 360º 

image to Facebook for anybody to 

navigate at will is a brilliant concept 

– just make sure you have a scene 

worth capturing. nikon.co.uk

RATING

Above Control is simple, with a button 

for video and one for photos.

SPEC

Weight: 198g

WxHxD: 

66x61x61mm

Battery: 230 shots

Card type: Micro SD

Focus: Fixed, 30cm 

to infinity

Aperture: Fixed f/2

NIKON

KEYMISSION 360 £419

Above The two 

lenses capture 

individual images, 

which are then 

stitched together.

GoPro is synonymous with action 

cameras, having been in the 

business for over a decade. Many 

things have changed since the 

first GoPro found its way to 

the market, but it still has one 

core principle – letting you 

capture action as it happens. 

It has spawned a wide range of 

accessories, allowing you to clip 

this tiny unit to almost anything that 

moves for intimate action shots. 

Functionality is as simple as ever, 

with the single button responsible 

for controlling everything, though it 

now also supports voice activation 

– a great inclusion. The lens covers 

a wide field-of-view (14-28mm), 

which means the 4K 30fps video, or 

12MP stills, will capture a colossal 

amount of the environment (this can 

be changed in the menu). This latest 

addition also includes a 2in rear 

touchscreen, which lets you change 

your settings or review footage as 

you shoot – a welcome and often 

requested upgrade to the series. It 

also has the ability to go to depths 

of 10m underwater without the need 

for an external case. gopro.com

PROS

Very wide-angle

Voice 

commands

4K video

CONS 

Battery life

Requires sense 

of adventure

Limited uses

RATING

Above The rear screen is a great 

inclusion to frame your shots.

SPEC

Weight: 120g

WxHxD: 30x60mm

Battery: 90 minutes 

4K video

Card type: Micro SD

Field-of-view: 

14-28mm

Underwater: 10m 

GOPRO

HERO 5 BLACK £399

Above The new 

design means you 

don’t need a case to 

submerge to 10m 

underwater.

BEST CAMERAS UNDER £650

HIGHLY 

RATED
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Part of Canon’s newest line-up 

of compact cameras, the G9X 

MkII boasts a very compact 

build, packing in a 1in sensor 

capable of capturing 20.1MP 

stills or 1080p 60fps Full HD 

video. The lens only offers a 

3x optical zoom (considerably 

less than the two opposite), with 

a 35mm equivalent length of 

28-84mm, making it suitable for 

shots of landscapes or people, while 

the f/2-4.9 aperture allows for some 

great low-light shooting. The ISO 

runs from 125-12,800, with images 

at ISO 3200 still looking respectably 

clean. You can also set your camera 

to shoot RAW files, or you can stick 

with JPEGs. The in-built pop-up 

flash supports X-sync, meaning 

you can shoot at up to 1/2000sec, 

though it isn’t powerful enough 

to make a big difference at higher 

shutter speeds. We also love the 

bright 1040k-dot touchscreen 

and the Wi-Fi, Bluetooth and NFC 

options let you transfer your images 

to your smart device. canon.co.uk

PROS

Good ISO 

performance

Wi-Fi

Lightweight

CONS 

No viewfinder

No tilting screen

Short zoom 

range

RATING

Above The ISO performance is 

impressive thanks to the 1in sensor.

SPEC

Weight: 206g

WxHxD: 

98x58x31mm

Battery: 235

Card type: SD, 

SDXC, SDHC

AF: 31-point / 90% 

of Live View area

CA NON

POWERSHOT G9X 

MKII £399

Above The X-sync 

compatible flash 

allows you to shoot 

at shutter speeds of 

up to 1/2000sec.

GetIntoGear

1 Compact cameras 

come with a single, 

fixed lens which usually 

packs a massive zoom 

range. Many of them  

boast 35mm equivalent 

lengths of approximately 

20-600mm, which gives you 

scope to shoot almost 

everything without having 

the burden of carrying 

around extra lenses.

2 As the name 

suggests, compact 

cameras are, well, compact 

– this means a camera 

which can accompany you 

around the globe without 

ever leaving your person. 

Though the sensor size isn’t 

quite as large as others in 

test, the image quality has 

come on leaps and bounds 

in modern times, making 

compacts a great choice 

for travellers or simple 

everyday use.

3
INCONSPICUOUS

For safety 

conscious 

shooters, big name brand 

cameras can often be a 

target for thieves. The 

benefit of blending in 

means compacts often get 

overlooked, giving you a 

great sense of security on 

your travels. 

W
E KNOW WHAT IT’S LIKE WHEN 
you’re starting out in photography – not 
everybody wants to go straight into the 
£3500, top-of-the-line DSLR, and rightly 
so. If you haven’t managed to navigate 

your way round the exposure triangle yet, and don’t know 
your rear-sync flash from your ISO, a DSLR can be daunting. 
The good news is, compact cameras offer a brilliant stepping 
stone into the world of photography, but without the 
intimidation of a thousand buttons and 20-page menus. 

Newer compact cameras, such as these, also allow 
you to take matters into your own hands and control the 
settings manually, with many even allowing you to shoot 
RAW, meaning it will grow alongside your technical 
ability for as long as you need it to. Of course, you may 
never wish to progress beyond a compact, with many 
people loving the small sizes, lightweight construction
and portable nature – and we’re fine with that.

Why buy a compact?

THE LAND OF 
SUPERZOOMS

COMPACT 

CAMERAS
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This premium compact superzoom 

from Nikon is the perfect camera for 

casual photography enthusiasts. 

Featuring a monstrous 35x 

optical zoom lens, it gives a 

35mm equivalent focal length 

of 24-840mm. The 1/2.3in 

sensor is capable of producing 

20MP JPEG images (sadly, it 

doesn’t support RAW), as well 

as giving you full manual control 

and a blistering 10fps continuous 

shooting speed to get the most 

from your scenes. The 3in 921k-dot 

(non-touch) screen looks great, 

displaying vibrant colours and a 

great tonal range, as well as tilting 

to 180º. The native ISO is 80-1600, 

but expands to 3200, though 

the quality does drop from ISO 

1600. Even so, this is more than 

enough to keep shooting into dusk, 

especially with the 5-Stop VR image 

stabilisation and in-built flash. It 

also includes 1080p Full HD video 

an Wi-Fi and Bluetooth to allow 

you to connect to Snapbridge, in 

case you feel the need to instantly 

share your shots to social media 

or jealous friends. nikon.co.uk

PROS

20MP sensor

Long zoom 

range

Wi-Fi 

connectivity

CONS 

No touchscreen

No RAW mode

Battery life

RATING

Above 24-840mm focal length lets 

you capture a whole range of shots.

SPEC

Weight: 298g

WxHxD: 

113x67x40mm

Battery: 270

Card type: SD, 

SDXC, SDHC

AF: 99-point 

contrast detection

NIKON 

COOLPIX A900 £299

Above 5-stop image 

stabilisation allows 

for handhel shooting 

at slower shutter 

speeds. 

The Lumix TZ90 is a well-specced 

premium compact, with a fixed 

f/3.3-6.4 lens capable of 30x 

optical zoom from 24-720mm, 

giving you a colossal focus 

range. It also features 4K 

video, as well as Panasonic’s 

4K Photo modes, such as Post 

Focus (stitching together several 

shots in-camera, allowing you to 

select your focus point after you’ve 

taken the shot), and 4K Burst, which 

takes a short 4K video clip, and lets 

you extract a still as an 8MP image. 

There’s a 3in 1040k-dot 180º tilting 

touchscreen (and LVF, similar to 

an EVF, though this is incredibly 

small) and 10fps burst rate. The 

1/2.3in High Sensitivity MOS sensor 

belts out 20.3MP images, aided 

by the high quality Leica lens. 

It also boasts Panasonic’s DFD 

(Depth from Defocus) autofocus 

technology. Likewise, the O.I.S 

image stabilisation goes hand in 

hand with the 80-6400 ISO (3200 

maximum in video modes), though 

the quality does start to deteriorate 

quickly beyond ISO 1600, which is 

still respectable. panasonic.com/uk

PROS

4K video

Long zoom 

range

4K Photo 

modes 

CONS 

Battery life 

Small 1/2.3in 

sensor size

RATING

Above The 180º tilting touchscreen 

allows for easy selfies or vlogging.

SPEC

Weight: 322g

WxHxD: 

112x67x41mm

Battery: 380

Card type: SD, 

SDXC, SDHC

AF: 49-point 

contrast detection

PA NASONIC

TZ90 £374

Above 4K photo 

modes open up a 

whole new world of 

possiblities for your 

photography.

BEST CAMERAS UNDER £650

HIGHLY 

RATED
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The G7 is a bit aged now, though 

that doesn’t detract from its 

ability. Featuring 16MP Micro 

Four-Thirds sensor, 4K video 

and Photo modes (a Lumix 

staple allowing you to change 

the focus point after taking 

your shot or save an 8MP 

still from a 4K video file) and 

phenomenal ISO range of 

100-25,600, it can cope with most 

challenges you throw at it. The body 

itself is very lightweight, at 410g, 

though does suffer from a cheap 

feeling construction. However, this is 

far from a deal breaker. The included 

14-42mm f/3.5-5.6 ASPH Mega 

O.I.S lens gives a great focal range 

of 28-84mm (35mm equivalent), as 

well as featuring image stabilisation, 

perfect for shooting hand-held in 

darker conditions. The 2360k-dot 

EVF is very smooth, though does 

lag a tiny bit, and the 1040k-dot 

3in touchscreen allows full control 

of focus, menus and the shutter, 

even flipping out 180º for vloggers. 

The DFD (Depth From Defocus) 

AF system is also impressive. A 

budget gem. panasonic.com/uk

PROS

4K Video and 

Photo modes

High ISO range 

6fps shooting 

speed

CONS 

Older model 

Feels plasticy

Battery life

RATING

Above The G7 features 4K video, the 

highest offering amongst our CSCs.

SPEC

Weight: 410g

WxHxD: 

125x86x77mm

Battery: 360

Card type: SD, 

SDXC, SDHC

AF: 49-point DFD 

contrast detection

PA NASONIC

LUMIX G7 £499

Above The 

2360k-dot EVF lets 

you preview your 

settings before you 

take the shot.

GetIntoGear

1
SEE IT AS YOU 

SHOOT IT

Mirrorless 

cameras have one large, 

obvious strength over their 

DSLR counterparts – an 

Electronic Viewfinder 

(EVF). This simply means 

that your viewfinder is a 

small screen which 

projects the image the 

sensor is seeing into the 

viewfinder, meaning you 

can see your exposure as 

the camera does, before 

you take your shot.

2
HIGHLY 

PORTABLE

The lack of a 

focusing mirror found in 

DSLRs has the advantage 

of making CSCs 

considerably smaller than 

their more advanced 

relatives, meaning they’re 

perfect for walkabouts or 

longer adventures, fitting 

into your hand luggage 

almost unnoticed. 

3
STEALTH

Thanks to the 

small, non-

intimidating size, CSCs  

are becoming very popular 

for street and wedding 

photography, allowing you 

to shoot silently and blend 

into the crowd in a way 

which attention-grabbing 

DSLRs just won’t allow.

H
AVE YOU CONSIDERED SWITCHING FROM 
your compact camera to a DSLR, only to 
be put off by the size difference? Well, 
fear not, the mirrorless revolution is your 
friend. Lacking a focusing mirror found in 

regular DSLRs, CSCs (Compact Camera Systems) are 
just as capable as their counterparts, but are generally 
smaller. You can still switch lenses like a DSLR, allowing 
you to build up a collection for every occasion. 

In the case of the Fujifilm, it even uses the same APS-C 
sized sensor found in many DSLRs, whereas the Olympus
and Panasonic are Micro Four Thirds sensors, which are 
slightly smaller, though this does mean that your lens’ 
effective length is 100% longer than its 35mm equivalent
rating (so a 50mm would give an effective length of 100mm), 
making it easier than ever to get great telephoto shots. With 
such a high level of functionality in such a compact package, 
the mirrorless revolution is well worth checking out.

Why buy a CSC?

SMALL FORM 
BUT BIG POWER

CSC 

CAMERAS

HIGHLY 

RATED
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With the imminent release of the 

OM-D E-M10 MkIII, we’re taking 

a look at its current predecessor, 

the MkII. A highly capable 

16MP Micro Four Thirds 

camera with a huge range of 

dedicated lenses to choose 

from (with all Micro Four Third 

mount lenses working, including 

Panasonic). The in-built 5-axis 

image stabilisation is exceptionally 

handy, allowing up to 4 stops of 

stabilisation, for getting the best 

out of your handheld shots or 

1080p Full HD video clips in low 

light. The tilting 1037k-dot screen 

allows you a degree of freedom, as 

you can compose shots from high 

or low angles, though it doesn’t 

have touch functionality. Thanks 

to including a total of 81 AF points, 

you can be assured of getting the 

perfect focus every time, and the 

highly respectable maximum 8.5fps 

burst mode will serve you well 

for capturing fast-moving action 

shots. The EVF offers a 2.36m-dot 

resolution and a 100% magnification 

to give you a very authentic 

experience. olympus.co.uk

PROS

Image 

stabilisation

Tilting screen

Fast burst 

mode

CONS 

No 4K video 

No touchscreen

Battery life

RATING

Above A massive 81-point AF system 

gives you confidence when focusing.

SPEC

Weight: 390g

WxHxD: 

120x83x47mm

Battery: 320

Card type: SD, 

SDXC, SDHC

AF: 81-point AF 

contrast detection

OLY MPUS

OM-D E-M10 MKII £569

Above In-built image 

stabilisation offers 

up to 5 stops of 

control, perfect for 

handheld shots.

Fujifilm is one of the leading 

CSC manufacturers, tempting 

many professionals to ditch 

their DSLRs. Its millenial-

orientated X-A3 uses the latest 

generation 24.2MP APS-C 

sensor and features a 180º 

tilting 3in touchscreen (using 

this activates the Eye Detection 

AF, making it perfect for selfies 

and vlogging, especially when 

using the Portrait Enhanced mode, 

allowing you to lighten skin tones), 

and has an ISO range of 200-6400 

(extendible to 100-25,600). It 

manages a very respectable 

410 shots from a full charge, 

easily enough for a casual day of 

photography or movie clips (using 

the 1080p Full HD video). The Super 

Intelligent Flash provides the ideal 

amount of light depending on your 

scene settings, which will lessen the 

risk of overexposing your shots. The 

X-A3 includes Fujifilm’s iconic Film 

Simulation modes, meaning you 

can apply beautiful filmic tones to 

your shots, and the Wi-Fi mode lets 

you transfer them to your phone for 

on-the-spot editing. fujifilm.eu/uk

PROS

Very portable

Same sensor as 

X-T2 and X-Pro2 

Battery life

Simple to use

CONS 

No viewfinder

Doesn’t feel 

premium 

RATING

Above The screen has been designed 

with vlogging and selfies in mind.

SPEC

Weight: 331g

WxHxD: 

117x67x40mm

Battery: 410

Card type: SD, 

SDXC, SDHC

AF: 49-point 

contrast detection

FUJIFILM

X-A3 £479

BEST CAMERAS UNDER £650

Above The Super 

Intelligent Flash 

works out the best 

power for your shot.
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Canon’s first of two entries into the 

DSLR category, the 750D has a 

couple of years experience. This 

24.2MP beginner-friendly DSLR 

has a simple-to-use control 

setup, perfect for anybody 

looking to move on from 

compacts to a more advanced 

system. The 3in 1040k-dot 

vari-angle touchscreen tilts out 

to 180º to allow you to compose 

selfies, as well as allowing you to use 

touch to select your focus points. 

Due to its age, it doesn’t feature 

Canon’s brilliant Dual Pixel AF, so 

you’re limited to a 19-point autofocus 

system, though they are all cross type 

for superior accuracy. The maximum 

5fps continuous shooting speed 

is also very pleasing for this level 

of camera, letting you capture fast 

moving subjects and select the best 

shot. For budding videographers, it 

features 1080p Full HD quality video 

at 30fps, as well as a microphone 

input. Its ISO ranges from 100-12,800, 

deteriorating at ISO 3200, though 

the pop-up flash will help to capture 

those moments when the light 

is dwindling fast. canon.co.uk

PROS

Image quality

Touchscreen

5fps burst 

mode 

CONS 

Small monitor 

No touchscreen

Low-res 

monitor

RATING

Above The 750D manages a 

respectable 5fps shooting speed.

SPEC

Weight: 555g

WxHxD: 

132x101x78mm

Battery: 440

Card type: SD, 

SDXC, SDHC

AF: 19 points,  

all cross-type

CA NON 

EOS 750D £599

GetIntoGear

1
MORE POWER

Without exception, 

DSLRs are the 

kings of battery life. While 

the other cameras on test 

will leave you changing 

batteries regularly, a DSLR 

can give you 100% more 

shots per charge. This is 

largely thanks to not 

requiring an EVF, which 

may come in handy but 

does come at the rather 

drastic cost of reduced 

battery life.

2
ALL THE LENSES

While action and 

compact cameras 

have fixed lenses, and the 

mirrorless CSCs have a 

respectable range of glass, 

it’s DSLRs that have the 

widest range of optics on 

offer. With a lens for every 

occasion, you can’t beat 

DSLRs for versatility.

3
PROGRESSION

Although every 

camera fulfils its 

purpose well, and CSCs 

will manage every job you 

need, it’s usually DSLRs 

that offer full-frame 

sensors. This means you 

can get access to a large 

sensor, greater ISO 

handling and better 

resolution images, which is 

the biggest draw of all for 

serious photographers.

T
HE CURRENT KING OF IMAGING AND 
arguably the most coveted type of camera, the 
humble DSLR is what many people think when 
you say ‘professional photographer’. Boasting 
the iconic, chunky construction, pleasingly 

robust hand grip and enough knobs and dials to drive you to 
distraction, it’s a design which serves to give you ultimate 
creative freedom. However, the more you are looking to 
get from your camera, the higher the prices can go, with 
Canon and Nikon’s top units costing upwards of £5000. 

Luckily, you can still get top-notch results without 
breaking the bank, as we have demonstrated here. Each of 
these cropped APS-C sensor models allow you to capture 
striking images, switch between a wide and varied lens range 
and put your vision into practice. They also have the bonus of 
being lighter than professional bodies and, though not as light 
as CSCs, generally have the best build quality of the bunch.

Why buy a DSLR?

WELCOME TO 
THE BIG LEAGUE

DSLR 

CAMERAS

Above The 1040k-dot 

touchscreen lets 

you frame your 

shots and review 

them with ease.
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Although not the newest model in 

Nikon’s D5000 series, the D5300 

is a great option for anybody 

wanting to take their first steps 

into DSLRs without spending 

over the odds. Boasting a 

24.2MP sensor, it still gives 

you a cracking resolution, and 

the tilting screen (which isn’t 

touch compatible) allows you to 

capture some unique compositions, 

whether close to the ground or 

turned 180º to get yourself in the 

picture. The ISO ranges from 

100-12,800 (expandable to ISO 

25,600) and does a great job, with 

images at ISO 3200 looking very 

respectable – great in low-light. The 

inclusion of 39 AF points means 

it beats both of the Canon entries 

in test and gives you a greater 

scope to focus your shots. 1080p 

Full HD should interest anybody 

who wants to capture the odd 

video clip, and Wi-Fi allows you to 

transfer your images straight to your 

smartphone. The 600-shot battery 

life should keep you shooting for a 

while. The price makes this a very 

worthy consideration. nikon.co.uk

PROS

Sharp, high 

quality images

Good ISO 

performance

1080p video 

CONS 

No touchscreen

Getting on a bit

Poor video AF

RATING

Above The ISO performs admirably, 

with ISO looking respectably clean.

SPEC

Weight: 530g

WxHxD: 

125x98x76mm

Battery: 600

Card type: SD, 

SDXC, SDHC

AF: 39 points / 9 

cross-type points

NIKON

D5300 £529

Above The 3in tilting 

screen lets you 

compose your shot 

from different angles 

for creative freedom.

The 200D may be Canon’s lightest 

entry-level DSLR, but it packs a 

big punch, thanks to using the 

same 24.2MP sensor as the 

enthusiast-aimed 80D. It 

also features a wide ISO 

range of 100-12,500, which 

produces clean images up 

to ISO 1600, as well as a very 

simple, but intuitive design – 

perfect if you’re stepping up from 

a compact camera. The 1040k-dot 

rear touchscreen offers a 49-point 

AF (better than the viewfinder’s 

9 points), while a tilt mechanism 

allows you to rotate it to 180º 

to allow you to take those all-

important selfies, or use the 1080p 

Full HD video to vlog your wildest 

adventures. The 200D can also 

shoot at 5fps, which isn’t ground-

breaking, but is very respectable 

for entry-level. You can also use 

one of the many Scene Modes to 

add instant flair to your shots, such 

as Landscape, Portrait or HDR. 

The 200D’s USP is that it weighs 

just 453g, making it the smallest 

current DSLR on the market. 

Great for travellers. canon.co.uk

PROS

Very lightweight

Easy to control

80D sensor

CONS 

Only 9 

viewfinder AF 

points 

Feels more like 

a compact

RATING

Above The Dual Pixel AF offers 

49 points when using Live View.

SPEC

Weight: 453-456g

WxHxD: 

122x93x70mm

Battery: 650

Card type: SD, 

SDXC, SDHC

AF: 9-point/ 

49-point Dual Pixel

CA NON

EOS 200D £649

Above The lightest 

current DSLR, 

Canon’s black 

version weighs in 

at only 453g.

BEST CAMERAS UNDER £650

HIGHLY 

RATED



ND filters can inject 
an extra dimension 
of creativity & drama 
into your work.

L
ANDSCAPE 
photography is a 
beautiful art, capable 
of showing our 
environment at its 
best. However, our 

vistas could sometimes use a little 
extra oomph, and that’s where 
ND filters come into play. The 
ability to expose your shutter for 
tens of seconds means you can 
get extremely creative. Whether 
capturing dramatic skies full 
of cloud movement, or turning 
tempestuous waters into a serene 
stillness, an ND filter will change 
the way you see. Kirk Schwarz 
goes out on location to test five 
of the best 10-stop ND filters.
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SRB may be the cheapest option in this 

test, but it still manages to deliver on its 

10-stop promise. Featuring a slimmer 

profile than the others here, this ND1000 

screws onto the front of your lens and 

comes in sizes to fit 46-82mm diameters. 

From its outward appearance it has a 

very neutral colour to the glass, appearing 

as a solid black with white reflections, 

but it’s what colour cast it produces in 

the field that counts. We found that the 

optical quality remained consistently high 

throughout shooting. There was a slightly 

cool, magenta colour cast on our images 

straight out of camera, though this was 

easy to fix in Photoshop with a slight 

adjustment. Considering the extremely low 

price of this filter and its very reasonable 

colour control and image quality, we’d 

suggest this is a great starter for anybody 

looking to get into long exposures.

srb-photographic.co.uk

This has a pleasingly chunky feel to it, 

and a greenish tint to the glass. It comes 

in a range of diameter sizes to fit lenses 

from 46-95mm, and is constructed with 

a one-piece aluminium ring to ensure the 

optical glass is held securely and directly 

parallel to the sensor. Each Pro ND filter 

uses an ACCU-ND coating to minimise 

any colour shifts or casts on your 

finished images, and preserve the optical 

quality of the glass. When we used this 

in the field we were impressed with the 

performance. The colour cast was very 

minimal, producing a slight warm tone, 

which we actually found very pleasing 

when shooting golden hour scenes. 

Beyond this, the quality is extremely 

high and the image didn’t suffer from the 

addition of this filter. The chunky design 

also makes it very easy to screw on and 

off, meaning you won’t be having to force 

it from your lens thread. hoyafilter.com

SPEC Sizes: 46-82mm  Density: 10 stops

Fit type: Screw on  Filter type: Circular

SPEC Sizes: 46-95mm  Density: 10 stops

Fit type: Screw on  Filter type: Circular

 SRB ND1000  

£25-£40 

 Hoya Pro ND 1000  

£55-£140 

NO FILTER TEST SHOT TEST SHOT

of the 
best Big 
Stopper
filters

HIGHLY 

RATED
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Stalwart filter company Cokin has been 

responsible for the introduction of 

generations of photographers to long 

exposure photography, so we had to 

include them on our list. The Nuances 

ND 1024 is a 10-stop square filter, which 

requires a holder, with a blue/green tint 

to the glass. It’s available in M, L and XL 

sizes (84, 100 and 130mm), and works 

with the Cokin range of filter holders 

which fit all major lens sizes. For extra 

quality, it uses Schott Glass B270 which 

is renowned for high transmittance and 

low reflection. It’s also coated with a 

nano metallic alloy to ensure premium 

quality results. Equally, the colour cast 

appeared to be extremely well controlled, 

appearing quite neutral, and we were 

impressed by the high image quality 

while using it. Not the cheapest, but very 

impressive and well worth checking out.   

cokin-filters.com

Kenko’s offering, which is exclusive to 

Wex Photographic, is robust feeling 

and solid, fitting lens diameters of 

49-82mm. It shows a green/yellow tint, 

which is the anti-reflection multi coating, 

designed to reduce ghosting and flare 

from reflections, as well as incorporating 

a black almite frame, which further 

reduces its own reflections so the frame 

won’t interfere with your shot if the light 

catches it head on. It also includes 

anti-stain coating, which is dust and 

oil repellent, a nice touch if you want to 

avoid leaving fingerprints from screwing 

on and off constantly. When shooting, 

we liked the image quality, with almost 

no noticeable deterioration, though 

there is a slightly warmer tone cast. This 

is negligible, however, and a very easy 

Photoshop fix. In some cases it also 

enhances the overall feel of the image.

kenkoglobal.com

SPEC Sizes: One size  Density: 10 stops

Fit type: Filter holder  Filter type: Square

SPEC Sizes: 49-82mm  Density: 10 stops

Fit type: Screw on  Filter type: Circular

 Cokin P Nuances  

 ND 1024 £89 

 Kenko Real Pro ND 1000  

 £40-£174 

TEST SHOT TEST SHOT TEST SHOT

most well-regarded neutral density 

stoppers on the market. The Stopper 

range includes a 6-stop Little Stopper 

and massive 15-stop Super Stopper, 

but we’re looking at 10 stops this month, 

and its Big Stopper is a worthy addition 

to the list. The filter is an untinted black 

and includes a foam insert to prevent 

light leaks through the holder kit – a nice 

touch. When using the Big Stopper, we 

found it to be a very capable filter with 

virtually no added colour cast or image 

imperfections. Our images looked sharp, 

clean and practically colour neutral. 

Being a square filter, you will need to 

purchase a filter holder, which Lee can 

supply as part of a kit. The Big Stopper 

may not be cheapest in this hard-fought 

test, but the results speak for themselves 

and we feel it just eeked past the Cokin.

leefilters.com

SPEC Sizes: One size  Density: 10 stops

Fit type: Filter Holder  Filter type: Square 

 Lee Filters Big  

 Stopper 

BEST  

IN  

TEST



LIGHTING

Minitests

l The duration time
of the flash is up
to 1/900sec at full

uk-interfitphotographic.com 

Small accessories that could make a huge difference

Above

Honey Badger
£259

24cm softbox as standard.

Build quality
While not award-winning,
due to feeling plasticy and
being bright yellow, we can’t
fault the Honey Badger for

recycle time gives you a lot
of shooting possibilities. We
also liked the inclusion of the
umbrella slot, which allows
you to put a shoot-through
brolly (max shaft size 8mm)
in the body itself. Overall,

24cm softbox as standard.

and won’t retain its shape
well over time. However, the
output and temperature of
the light are great and the fast
recycle time gives you a lot

Above 



l Luxury British camera bag 

manufacturer Billingham 

has just released its latest 

eye candy, the Hadley 

One messenger bag.  

It comes in a range of 

colours – khaki, sage 

(both with chocolate trim) 

or black with a black leather 

trim. The bag has an air of 

authentic old Britain to it, 

which should appease any 

style-conscious shooters. It 

features a pull-out padded 

insert, which attaches securely 

thanks to poppers, and feels 

pleasingly sturdy and flexible enough 

to hold your gear in transit (there is 

scope for a second insert, though this 

is an additional extra). It can easily fit 

one DSLR with a medium sized lens, as 

well as an additional lens, 13in laptop 

and accessories. The FibreNyte 

material is water resistant and feels 

tough, and Billingham are soon to 

release additional external pockets.  

billingham.co.uk

Billingham H £265

BAGS

APP

l With so many people finding a passion for 

photography thanks to smartphones, we’re taking 

a look at the latest phone app by Enlight. It’s a 

surprisingly feature-rich suite, with a host of filters 

(one-touch presets) that produce very pleasing 

results. The basic package provides a large 

number of these filters, each of which creates a 

different exposure and colour palette, allowing 

you to get that fashionable, washed-out look – or 

warm, contrasting tones – in a single click. You 

can even fine-tune the strength of the effects. 

Beyond the myriad of filters, you have a fairly 

comprehensive editing setup, which incorporates 

an air of simplicity into its bold and striking UI. 

We especially like the crop options, letting you 

control vertical and horizontal perspectives, which 

is very welcomed. We have to mention the ability 

to batch edit, letting you apply the same presets 

to multiple images in one go – perfect if you find 

a favourite style and want to process all of your 

images to get a consistent look. Overall this is 

an excellent free app, though Pro subscriptions 

are available at cost. Quickshot is available now 

for IOS from the Apple app store. enlight.com
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Quickshot Free
Novo Expl
MP20 £125
This carbon fibre N

monopod repres

a solid investmen

anybody wanting t

light, but add a to

extra stability. Th

sections, which e

from 57-182cm, a

place by sturdy t

making it easy to e

It can take a pay

20kg, as well as h

a detachable top

allowing you to a

ball head if requi

were also impres

the lightness, we

at a respectable 4

www.novo-photo.com

Samsung Pro 
Plus MicroSD 
32GB £30
Samsung’s memory solutions

are some of the best on the 

market, and the Pro Plus 

MicroSD is no exception. 

Although it’s only USH-1, with 

read speeds up to 100mb/s and 

write speeds topping 90mb/s, 

this card managed every 

challenge we set it, with both 

traditional and action cameras.

t comes with an SD card 

adapter, which allows you to 

slide the MicroSD into the frame 

and your reader will accept it like 

any other SD card – which is a 

real draw. The Pro Plus is also 

available in 64GB, though we 

recommend checking the card 

capacity of your device before 

purchasing the latter option.

samsung.com

Above

images in quick succession 

and stitches them into one.

HIGHLY 

RATED

insert, which attaches securely

Above 

Below Additional inserts are 



Finance example: 12mths, 0% APR: Cash Price £1475, 10% Deposit £147.50, Monthly Payment £110.62, Total Amount Payable £1475. • 24mths, 9.9% APR: Cash Price £1475, 10% Deposit £147.50, Monthly Payment £60.93, Total Amount Payable £1608.82
36mths, 19.5% APR: Cash Price £1475, 10% Deposit £147.50, Monthly Payment £47.95, Total Amount Payable £1873.70 See website for details: www.uttings.co.uk/Information/Finance. Finance is subject to status, terms & conditions apply.*

*Consumer credit service provided by DEKO in association with Close Brothers Retail Finance. DEKO is licensed by the Financial Conduct Authority (Consumer Credit Licence: 0616240) Finance provided by Close Brothers Retail Finance is a trading name of Close Brothers Limited10 Crown Place, London EC2A 4FT.
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See website for Remotes, Batteries &   Chargers

See website for more lenses

See our website for full details & specifications



  Upgrading - we want your old cameras and photographic equipment!

• EXPERIENCED KNOWLEDGEABLE STAFF  

 • TOP PRICES PAID  • FILM OR DIGITAL EQUIPMENT CONSIDERED 

• QUALITY EQUIPMENT BOUGHT OUTRIGHT!
Ask us today and see how much your old equipment is worth - it may be worth more than you think!

PART EXCHANGE WELCOME

VISIT YOUR LOCAL LCE FOR                                 THE LA

londoncameraexchange

NIKON D3400
& 18-55MM F/3.5-5.6 VR AF-P

Superior image quality 
thanks to image sensor 
featuring 24.2 effective 
megapixels and EXPEED 4 
image-processing engine.

£449.99 

NIKON D7500
BODY ONLY

Powerful, nimble, and fully 
connected D7500. Catch the 
beauty you find with flagship 
DX image quality inherited 
from Nikon’s D500.

£1299.99 

NIKON D500
BODY ONLY

As the smaller sibling to 
the D5, Nikon’s FX-format 
flagship, the D500 offers 
phenomenal power and 
precision.

£1729.99 

NIKON
BODY ONLY

NEW
NIKON D850

£3499.99 

The D850’s fast, ultra-high-resolution 
FX-format sensor uses 45.7 megapix-
els of effective resolution to deliver 
richly detailed 45.4 MP files. Print 
ultra-high-resolution images in ultra-
large formats. Shoot true full-frame 
movies at 4K. The back-illuminated 
CMOS sensor has no optical low-
pass filter and incorporates gapless 
on-chip micro-lenses as well as an 
anti-reflective coating. Incoming light 
reaches the photodiodes more ef-
ficiently so you get exceptional detail 
and incredible dynamic range. And 
the 153-point AF system, inherited 
from the D5, assures you of the pin-
sharp focus and wide coverage you 
need for ultra-high-resolution full-
frame images.

The amazing!

Body Only

£85
TRADE-IN
BONUS
‘till 31.10.17



UK MAIL ORDER Next day delivery available from all LCE branches. Postage & Insurance £4.99 for most items. 
E. & O. E. Prices quoted include VAT @ 20%.  Prices subject to change. Goods subject to availability. BRANCHES NATIONWIDE

BATH

01225 462234

BRISTOL (BALDWIN ST)

0117 929 1935

BRISTOL (BROADMEAD)

0117 927 6185

CHELTENHAM

01242 519 851

CHICHESTER

01243 531536

CHESTER

01244 326531

COLCHESTER 

01206 573444

DERBY  

01332 348644

EXETER

01392 279024

GLOUCESTER

01452 304513

GUILDFORD

01483 504040

HEREFORD 

01432 272655

LEAMINGTON

01926 886166

LINCOLN (HIGH ST)

01522 528577

LINCOLN (SILVER ST)

01522 514131

LONDON (STRAND)

0207 3790200

MANCHESTER 

0161 834 7500

NEWCASTLE  

0191 213 0060

NORWICH  

01603 612537

NOTTINGHAM

0115 941 7486

PLYMOUTH  

01752 664894

PORTSMOUTH

023 9283 9933

READING  

0118 9592149

SALISBURY  

01722 335436

SOUTHAMPTON (CIVIC CTR)

023 8033 1720

SOUTHAMPTON (HIGH ST)

023 8022 1597

TAUNTON

01823 259955

WINCHESTER 

01962 866203

WORCESTER

01905 22314

OPENING TIMES:

Monday—Saturday  
9am —5:30pm

SEARCH OUR USED EQUIPMENT AT:

OR                                 THE LATEST CAMERA OFFERS  

www.LCEgroup.co.uk

SONY A9
BODY ONLY

True potential can only soar 
when free
A dream meets technology, 
and a new camera is born
Now the future is yours

£4499.99  

SONY A7R MKII
BODY ONLY

Introducing the full-frame, 
palm-sized  A7R II, revolution 
in resolution with higher 
sensitivity, response and 
refinement.

£2499.99 

FUJIFILM X-T2
BODY ONLY

Unparalleled image quality 
and outstanding 4K movie 
recording, made possible 
by the latest sensor and 

processing engine.

£1399.99 

FUJIFILM X-PRO2
BODY ONLY

The FUJIFILM X-Pro2 offers 
the world’s only Hybrid Multi 

Viewfinder and features a 
brand new 24MP X-Trans III 

sensor.

£1349.99 

£500
TRADE-IN
BONUS
on selected
pro bodies

OLYMPUS PEN-F
BODY ONLY

The new OLYMPUS PEN-F is 
far more than just beautiful. 
It is the result of 80 years of 
camera history and technical 
innovations.

£949.00 

OLYMPUS OMD EM1 II
& 12-40MM MKII

An advanced system of 
innovative technology 
and features designed to 
forever change the power of 
photography. 

£2399.99 

An advanced system of
innovative technology
and features designed to
forever change the power of

FREE
25MM f1.8

LENS!
ASK

0%
12 MONTHS

available-
ask



Walking dramatically cuts your risk of diabetes, heart attack,  
obesity, stroke and depression. It feels so good and it’s free. Find out 

why Country Walking is one of the fastest-growing magazines in 
the UK, with free delivery: greatmagazines.co.uk/cwissues

So I joined this new gym.
It’s draughty and the temperature’s all over  

the place. It can be hours before anyone speaks  
to me, the showers are cold and the other day  

there was sheepsh** on the floor. 

I love it.



lMore intuitive interface 
makes viewing even easier 

l Extra images and videos  
to inspire your photography 

l Retina-optimised display  
for incredible detail & clarity

New iPad 
edition!
The best digital 
photo magazine 
just got better...

Enjoy over 70 minutes of Enjoy over 70 minutes of
expert advice every issue 

and get more free gifts

See the world’s most amazing See the world’s most amazing
photographs as they were 

meant to be displayed

Navigate around the Navigate around the
magazine quickly and easily 

with its slick new design

 Bring pictures to life  
 with pan & zoom detail

 Take a fresh look at  
 your favourite features 

 Watch the best camera  
 and editing videos 

Packed 
with over 
70 minutes  
of video 
lessons!

Subscribe or buy a single issue now
www.greatmagazines.co.uk/pp



Car insurance as individual as you are

*This off er is to beat your cheapest online car, van or motorbike insurance quote. The guarantee only applies to annual policies and to the basic policy price only. This off er 

excludes telephone quotati ons and only applies to permanent residents in the UK, excluding the Channel Islands. We reserve the right to request proof of, and validate, 

alternate quotes as well as proof of the informati on you provided to obtain the quotes (e.g. copy of driving licence or uti lity bill) before our guarantee is honoured.

mustard.co.uk is a trading name of Bauer Consumer Media Limited who are an appointed representati ve of Vast Visibility Limited who are authorised and regulated by the 

Financial Conduct Authority under fi rm reference number 566973.

cheaper car insurance,
and yes to our Cheapest Price Guarantee*

Compare car insurance quotes today and

see if you can get covered for less 

Say yes to...

mustard.co.uk or call 0330 022 7406



HOLIDAYS AND COURSES

ACCESSORIES
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Photographic Backgrounds
Hard wearing l low crease l Washable

01457 764140
for a FREE colour brochure or visit...

www.colourscape.co.uk

SPECIAL OFFER: 8 x 12 CLOUDEDS 
2 FOR £80 OR 3 FOR £115

PLAIN
8’ x 8’ .....£15 plus P&P

8’ x 12’ ...£24 plus P&P

8’ x 16’ ...£29 plus P&P

CLOUDED
8’ x 8’ ......  £27 plus P&P

8’ x 12’ .... £44 plus P&P

10 COLOURS INC 
BLACK, WHITE 
& CHROMA 
COLOURS

20 COLOURS

WILDLIFE PHOTO HIDES
WORKSHOPS AND HIRE

with Sussex Wildlife Trust
Photographer

David Plummer

Access to kingfi sher, owl, raptor, woodland bird, 
deer hides

www.davidplummerimages.co.uk

Austrian Alps  •  Italian Dolomites  •  Picos de Europa  •  Pyrenees

WALKING HOLIDAYS & MORE

in Europe's most majestic mountains
• Arrive and depart any day - stay as long as you wish.

• Self guide or join daily walks - or do a mix of both. 

• �otel� �halet or self �atering a��ommoda�on in beau�ful lo�a�ons. 

www.colletts.co.uk

The Walking Holiday Specialists ABTA No.W6883
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Delving 
into nature

Jasmine Pope graduated from The Norton Knatchbull 

school with an A* in A Level Photography in 2017.

instagram.com/jazz_ramona 

lMY EARLIEST PHOTOGRAPHIC INSPIRATION WAS 
nature. Both my grandad and father became interested 
in capturing their local environment when I was about
12. Walking around woodlands with my dad and his 
camera definitely inspired the way that I photograph 
my subjects today. I’m constantly driven to find new 
ways of presenting nature through photography. 

The main focus of my recent work has been to capture 
the connection between natural and manufactured 
environments by digitally manipulating my subject matter. 
For my photography A Level coursework, one of the areas 
I explored was how I could show the progress of change in 
landscapes by creating composite images. I believe that a 
single image of a vista can’t possibly show the full beauty of 
a scene, as the world around us is constantly changing and 
evolving. However, by taking several hundred images of one 
landscape and combining them together in post-production, 
I’m able to manipulate the perception of landscapes as being 
more complex than just one frame would lead us to believe. 
I find sunsets and sunrises particularly fascinating, as these 
are when the most vivid colours and patterns are present. By 
using timestacking I can capture all of this in a single image. 

After studying an astronomy GCSE, I also developed an 
interest in astrophotography, captured from various dark 
sky locations, including Iceland. Despite the bitter mornings,
cold nights and sleeping in a tent, I was able to take some 
of my best shots to date. I feel very fortunate that I was 
able to witness and photograph the breathtakingly vivid 
aurora and the mountainous landscapes, illuminated only 
by the stars. While night photography can be challenging, I 
found it very rewarding to capture vistas in unseen light.

My teachers’ support was what allowed me to step outside 
my comfort zone. I recently gained an A* in Photography, and I 
am now currently taking a gap year to expand my portfolio and 
refine the skills I’ve learned from the past two years. Beyond 
that, I’m currently considering various options to further my 
experience, including visiting several universities to find the 
best course for me and planning another trip to Iceland. 

Jasmine Pope captures 
her passion for the sheer 
beauty of nature in her 
exquisite portfolio.

STUDENT SHOWCASE



Your photographs under acrylic glass, framed, or in large formats. 

Made by the lab with 100 awards & recommendations. 

Upload and set your custom format – even from your smartphone.

Your most breathtaking memories in large 

formats. Made in gallery-quality by WhiteWall.

your photo 

under acrylic glass

from������

‘ Best Photo Lab Worldwide ’
Awarded by the Editors of 28 International Photography Magazines

Repeat Winner of the TIPA Award

WhiteWall.co.uk



I DESERVE

BETTER

#ITSNOTYOUITSME

itsnotyouitsme.co.uk

The E-M1 Mark II is a true powerhouse of technology. Wrapped in the compact camera is a new 

20M Live MOS sensor and the latest TruePic VIII image processor, made with renowned OLYMPUS 

engineering. These are rounded out with features for cinema-like, clear stills and videos alike.

Find out why so many are making the switch at: 

TIME TO BREAK-UP WITH YOUR OLD DSLR?

Photographer: John Nassari johnnassari.co.uk,      johnnassari


